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Documentation and Additional Resources

Learn about JMP documentation, such as book conventions, descriptions of each JMP
document, the Help system, and where to find additional support.
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Formatting Conventions in JMP Documentation

These conventions help you relate written material to information that you see on your screen:

Sample data table names, column names, pathnames, filenames, file extensions, and
folders appear in Helvetica (or sans-serif online) font.

Code appears in Lucida Sans Typewriter (or monospace online) font.

Code output appears in Lucida Sans Typewriter italic (or monospace italic online) font
and is indented farther than the preceding code.

Helvetica bold formatting (or bold sans-serif online) indicates items that you select to
complete a task:

— buttons

— check boxes

— commands

— list names that are selectable

- menus

— options

— tab names

— text boxes

The following items appear in italics:
— words or phrases that are important or have definitions specific to JMP
— book titles

— variables

Features that are for JMP Pro only are noted with the JMP Pro icon i’NII!PO . For an overview
of JMP Pro features, visit https://www.jmp.com/software/pro.

Note: Special information and limitations appear within a Note.

Tip: Helpful information appears within a Tip.


https://www.jmp.com/software/pro
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JMP Help

JMP Help in the Help menu enables you to search for information about JMP features,
statistical methods, and the JMP Scripting Language (or JSL). You can open JMP Help in
several ways:

e Search and view JMP Help on Windows by selecting Help > JMP Help.
* On Windows, press the F1 key to open the Help system in the default browser.

* Get help on a specific part of a data table or report window. Select the Help tool % from
the Tools menu and then click anywhere in a data table or report window to see the Help
for that area.

¢ Within a JMP window, click the Help button.

Note: The J]MP Help is available for users with Internet connections. Users without an Internet
connection can search all books in a PDF file by selecting Help > JMP Documentation Library.
See “JMP Documentation Library” for more information.

JMP Documentation Library

The Help system content is also available in one PDF file called JMP Documentation Library.
Select Help > JMP Documentation Library to open the file. You can also download the
Documentation PDF Files add-in if you prefer searching individual PDF files of each
document in the JMP library. Download the available add-ins from
https://community.jmp.com.

The following table describes the purpose and content of each document in the JMP library.

Document Title Document Purpose Document Content

Discovering JMP If you are not familiar ~ Introduces you to JMP and gets you
with JMP, start here. started creating and analyzing data. Also

learn how to share your results.

Using IMP Learn about JMP data  Covers general JMP concepts and
tables and how to features that span across all of JMP,
perform basic including importing data, modifying
operations. columns properties, sorting data, and

connecting to SAS.


https://jmp.com/doc-addin
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Document Title

Basic Analysis

Essential Graphing

Profilers

Document Purpose

Perform basic analysis
using this document.

Find the ideal graph
for your data.

Learn how to use
interactive profiling
tools, which enable you
to view cross-sections
of any response
surface.

Learn about JMP
JMP Documentation Library

Document Content
Describes these Analyze menu platforms:

¢ Distribution
e FitYbyX

e Tabulate

* Text Explorer

Covers how to perform bivariate,
one-way ANOVA, and contingency
analyses through Analyze > Fit Y by X.
How to approximate sampling
distributions using bootstrapping and
how to perform parametric resampling
with the Simulate platform are also
included.

Describes these Graph menu platforms:
® Graph Builder

¢ Scatterplot 3D

¢ Contour Plot

e Bubble Plot

e Parallel Plot

e Cell Plot

® Scatterplot Matrix
¢ Ternary Plot

¢ Treemap

e Chart

e Overlay Plot

The book also covers how to create
background and custom maps.

Covers all profilers listed in the Graph
menu. Analyzing noise factors is

included along with running simulations
using random inputs.
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Document Title Document Purpose Document Content
Design of Learn how to design Covers all topics in the DOE menu.
Experiments Guide experiments and

determine appropriate
sample sizes.

Fitting Linear Models Learn about Fit Model =~ Describes these personalities, all
platform and many of  available within the Analyze menu Fit
its personalities. Model platform:

e Standard Least Squares
* Stepwise

* Generalized Regression
* Mixed Model

¢ MANOVA

¢ Loglinear Variance

¢ Nominal Logistic

* Ordinal Logistic

e Generalized Linear Model



Chapter 1
Scripting Guide
Document Title

Predictive and
Specialized Modeling

Document Purpose

Learn about additional
modeling techniques.

Learn about JMP
JMP Documentation Library

Document Content

Describes these Analyze > Predictive
Modeling menu platforms:

* Neural

e Partition

¢ Bootstrap Forest

* DBoosted Tree

* K Nearest Neighbors

¢ Naive Bayes

* Support Vector Machines
* Model Comparison

* Model Screening

* Make Validation Column

e Formula Depot

Describes these Analyze > Specialized
Modeling menu platforms:

e Fit Curve

¢ Nonlinear

¢ Functional Data Explorer
¢ Gaussian Process

e Time Series

e  Matched Pairs

Describes these Analyze > Screening
menu platforms:

* Modeling Utilities

* Response Screening
® Process Screening

¢ Predictor Screening
* Association Analysis

® Process History Explorer

29
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Document Title Document Purpose

Multivariate Read about techniques

Methods for analyzing several
variables
simultaneously.

Quality and Process ~ Read about tools for
Methods evaluating and
improving processes.

Chapter 1
Scripting Guide

Document Content

Describes these Analyze > Multivariate
Methods menu platforms:

e Multivariate

® Principal Components

¢ Discriminant

e Partial Least Squares

* Multiple Correspondence Analysis
* Structural Equation Models

¢ Factor Analysis

* Multidimensional Scaling

e Item Analysis

Describes these Analyze > Clustering
menu platforms:

e Hierarchical Cluster
¢ K Means Cluster

¢ Normal Mixtures

e Latent Class Analysis
e (luster Variables

Describes these Analyze > Quality and
Process menu platforms:

e Control Chart Builder and individual
control charts

¢ Measurement Systems Analysis
* Variability / Attribute Gauge Charts
* Process Capability

e Model Driven Multivariate Control
Chart

* Legacy Control Charts
¢ Pareto Plot

¢ Diagram

* Manage Spec Limits

e OCCurves
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Document Title

Reliability and
Survival Methods

Consumer Research

Scripting Guide

JSL Syntax Reference

Document Purpose

Learn to evaluate and
improve reliability in a
product or system and
analyze survival data
for people and
products.

Learn about methods
for studying consumer
preferences and using
that insight to create
better products and
services.

Learn about taking
advantage of the
powerful JMP
Scripting Language
(JSL).

Read about many JSL
functions on functions
and their arguments,
and messages that you
send to objects and
display boxes.

Learn about JMP 31
JMP Documentation Library

Document Content

Describes these Analyze > Reliability and
Survival menu platforms:

Life Distribution
e FitLifeby X
¢ Cumulative Damage
® Recurrence Analysis
* Degradation
® Destructive Degradation
* Reliability Forecast
* Reliability Growth
* Reliability Block Diagram
* Repairable Systems Simulation
* Survival
e Fit Parametric Survival

¢ Fit Proportional Hazards

Describes these Analyze > Consumer
Research menu platforms:

e Categorical

e Choice
e  MaxDiff
e Uplift

* Multiple Factor Analysis

Covers a variety of topics, such as writing
and debugging scripts, manipulating
data tables, constructing display boxes,
and creating JMP applications.

Includes syntax, examples, and notes for
JSL commands.
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Additional Resources for Learning JMP

In addition to reading JMP help, you can also learn about JMP using the following resources:

e “JMP Tutorials”

e “Sample Data Tables”

e “Learn about Statistical and JSL Terms”
e “Learn JMP Tips and Tricks”

e “JMP Tooltips”

e “JMP User Community”

* “Free Online Statistical Thinking Course”
e  “JMP New User Welcome Kit”

* “Statistics Knowledge Portal”

e “JMP Training”

e “JMP Books by Users”

e “The JMP Starter Window”

JMP Tutorials

You can access JMP tutorials by selecting Help > Tutorials. The first item on the Tutorials menu
is Tutorials Directory. This opens a new window with all the tutorials grouped by category.

If you are not familiar with JMP, start with the Beginners Tutorial. It steps you through the
JMP interface and explains the basics of using JMP.

The rest of the tutorials help you with specific aspects of JMP, such as designing an experiment
and comparing a sample mean to a constant.

Sample Data Tables

All of the examples in the JMP documentation suite use sample data. Select Help > Sample
Data Library to open the sample data directory.

To view an alphabetized list of sample data tables or view sample data within categories,
select Help > Sample Data.

Sample data tables are installed in the following directory:

On Windows: C:\Program Files\SAS\UMP\16\Samples\Data
On macQOS: \Library\Application Support\dJMP\16\Samples\Data
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In JMP Pro, sample data is installed in the JMPPRO (rather than JMP) directory.

To view examples using sample data, select Help > Sample Data and navigate to the Teaching
Resources section. To learn more about the teaching resources, visit https://jmp.com/tools.

Learn about Statistical and JSL Terms

For help with statistical terms, select Help > Statistics Index. For help with JSL scripting and
examples, select Help > Scripting Index.

Statistics Index Provides definitions of statistical terms.

Scripting Index Lets you search for information about JSL functions, objects, and display
boxes. You can also edit and run sample scripts from the Scripting Index and get help on
the commands.

Learn JMP Tips and Tricks

When you first start JMP, you see the Tip of the Day window. This window provides tips for
using JMP.

To turn off the Tip of the Day, clear the Show tips at startup check box. To view it again, select
Help > Tip of the Day. Or, you can turn it off using the Preferences window.

JMP Tooltips

JMP provides descriptive tooltips (or hover labels) when you hover over items, such as the
following:

® Menu or toolbar options

* Labels in graphs

* Text results in the report window (move your cursor in a circle to reveal)
¢ Files or windows in the Home Window

* Code in the Script Editor

Tip: On Windows, you can hide tooltips in the JMP Preferences. Select File > Preferences >
General and then deselect Show menu tips. This option is not available on macOS.


https://jmp.com/tools
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JMP User Community

The JMP User Community provides a range of options to help you learn more about J]MP and
connect with other JMP users. The learning library of one-page guides, tutorials, and demos is
a good place to start. And you can continue your education by registering for a variety of JMP
training courses.

Other resources include a discussion forum, sample data and script file exchange, webcasts,
and social networking groups.

To access JMP resources on the website, select Help > JMP User Community or visit
https://community.jmp.com.

Free Online Statistical Thinking Course

Learn practical statistical skills in this free online course on topics such as exploratory data
analysis, quality methods, and correlation and regression. The course consists of short videos,
demonstrations, exercises, and more. Visit https://www jmp.com/statisticalthinking.

JMP New User Welcome Kit

The JMP New User Welcome Kit is designed to help you quickly get comfortable with the
basics of JMP. You'll complete its thirty short demo videos and activities, build your
confidence in using the software, and connect with the largest online community of JMP users
in the world. Visit https://www.jmp.com/welcome.

Statistics Knowledge Portal

The Statistics Knowledge Portal combines concise statistical explanations with illuminating
examples and graphics to help visitors establish a firm foundation upon which to build
statistical skills. Visit https://www.jmp.com/skp.

JMP Training

SAS offers training on a variety of topics led by a seasoned team of JMP experts. Public
courses, live web courses, and on-site courses are available. You might also choose the online
e-learning subscription to learn at your convenience. Visit https://www.jmp.com/training.


https://community.jmp.com
https://www.jmp.com/statisticalthinking
https://www.jmp.com/welcome
https://www.jmp.com/skp
https://www.jmp.com/training
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JMP Books by Users

Additional books about using JMP that are written by JMP users are available on the JMP
website. Visit https://www.jmp.com/books.

The JMP Starter Window

The JMP Starter window is a good place to begin if you are not familiar with JMP or data
analysis. Options are categorized and described, and you launch them by clicking a button.
The JMP Starter window covers many of the options found in the Analyze, Graph, Tables, and
File menus. The window also lists JMP Pro features and platforms.

* To open the JMP Starter window, select View (Window on macOS) > JMP Starter.

e To display the JMP Starter automatically when you open JMP on Windows, select File >
Preferences > General, and then select JMP Starter from the Initial JMP Window list. On
macQOS, select JMP > Preferences > Initial JMP Starter Window.

JMP Technical Support

JMP technical support is provided by statisticians and engineers educated in SAS and JMP,
many of whom have graduate degrees in statistics or other technical disciplines.

Many technical support options are provided at https://www.jmp.com/support, including the
technical support phone number.


https://www.jmp.com/books
https://www.jmp.com/support
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Introduction
Welcome to the JMP Scripting Language

The JMP Scripting Language, or SL, lets you write scripts to re-create results in JMP. Power
users often develop scripts to extend JMP’s functionality and automate a regularly scheduled

analysis in production settings. If you do not want to learn JSL, JMP can write the scripts for
you.

JSL is used to perform many actions:
* implements column formulas

¢ launches platforms

¢ interactively modifies platforms

® creates graphics



38 Introduction Chapter 2

Scripting Guide
Contents

What JSL Can Do fOr YOU. . ..ottt et e 39

Help with Learning JSL . . ... ..o o 39

The Scripting Guide . ... ... 39

The Scripting Index. . ... 40

Let JMP Teach You JSL . . ..ot e et et e et e e e 42
Terminology . . ...t 43

Basic JSL Syntax. . ... ..o 46

BOOK ConVeNtioNS . . . ..ottt e e e e e 47



Chapter 2 Introduction 39
Scripting Guide What JSL Can Do for You

What JSL Can Do for You

JMP can automatically save scripts to reproduce any data table or analysis in its current state.
You can pause anytime in your analysis to save a script to a script window (or script editor), in
a data table, or in an analysis report. You can then modify the script as needed for future
projects. When you are finished with your work, you can then save a script to reproduce your
final results.

Here are some examples where JSL scripts can be helpful:

* Suppose you need to describe an analysis process in detail, from beginning to end. An
example is to create an audit trail for a governing agency, or for peers reviewing your
journal article.

* Suppose you have a set of analysis steps that should be followed routinely by your lab
technicians.

* Suppose you fit the same model to new data every day, and the steps are always the same.

You can use JMP interactively as usual, save scripts to reproduce your work, and in the future
run those scripts to reproduce your results.

There are a few things that JSL is not designed to do:

¢ JMP cannot record scripts while you are working. Though script-recording is a useful
feature in some other scripting languages, it is less important for software like J]MP, where
the results are what matter. You cannot use script-recording to observe how a sequence of
interactive steps is performed.

¢ JSLis not an alternative command-line interface for using the program.

Help with Learning JSL

There are several places within JMP to get help with writing or understanding a JSL script.

The Scripting Guide

The Scripting Guide begins with basic information (such as terminology and syntax) for JMP
users who are not familiar with the scripting language. The Scripting Guide then progresses to
more advanced information.
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Chapters 2 through 4 Includes information about learning JSL, producing
basic scripts, and introduces you to the JSL scripting
environment.
Chapters 5 through 8 Introduces the building blocks of the language;

working with basic data types, such as numbers and
strings; writings lists, matrices, and associate arrays;
namespaces; and the fundamentals of programming in
JSL.

Chapters 9 through 13 Covers using JSL with objects in JMP, such as data
tables, platforms, windows, and graphics.

Chapter 14 Describes how to write scripts that work with external
programs, such as SAS, R, and Microsoft Excel.

Chapter 15 Describes how to organize files that you use in an
analysis, perform analyses, and run scripts from one
workspace.

Chapter 16 Introduces creating JMP applications in Application

Builder, a drag-and-drop environment for visually
designing windows with buttons, lists, graphs, and
other objects. The chapter also describes how to use
Add-In Builder to compile scripts into one easily shared
file.

Chapter 17 Contains a collection of recipes, or script examples, that
you can copy and modify for your own use.

Appendices A, B, C, and D Provides information about compatibility issues with
the previous version of JMP, provides tips for writing
more efficient scripts, gives information about
references, and defines JSL concepts and terminology.

The Scripting Index

The Scripting Index on the Help menu provides a brief description and the syntax for JSL
functions, objects, and display boxes. Each entry includes an example that you can run and
modify to test your own code. And an embedded log window lets you see messages as
examples are run.
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Notes:

e To display the Scripting Index entry for a function in a script, run the script, press Alt, and
then double-click the function. You can also run the script, right-click the function, and
select Help Scripting Index.

® To copy the syntax or description from the Scripting Index window, right-click the area
that you want to copy and select Copy Text.

The Scripting Index window includes the following buttons:
M Click the Clear button to clear the search text box to begin a new search.

«| Click the arrow to set search filter options and parameters.

After you edit the sample script in the Scripting Index, click this button to revert to the
original script.

Note: When you edit an example script, the changes persist when you view other entries in

the Scripting Index. To revert the script, click Reset, which appears above the script after you
edit it.

Search Filter Options

Click the down arrow button next to the search box to refine your search.

Contains Terms Returns items that contain a part of the search criteria. A search for “ease
oom” returns messages such as “Release Zoom”.

Contains Phrase Returns items that contain the exact search criteria. A search for “text box”

returns entries that contain “text” followed directly by “box” (for example, “Context Box”
and “Text Box”).

Starts With Phrase Returns items that start with the search criteria.
Ends With Phrase Returns items that end with the search criteria.

Whole Phrase Returns items that consist of the entire string. A search for “text box” returns
entries that contain only “text box”.

Regular Expression Enables you to use the wildcard (*) and period (.) in the search box.
Searching for “get.*name” looks for items that contain “get” followed by one or more
words. It returns “Get Color Theme Names”, “Get Name Info”, and “Get Effect Names”,
and so on.

Invert Result Returns items that do not match the search criteria.
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Match All Terms Returns items that contain both strings. A search for “t test” returns
elements that contain either or both of the search strings: “Pat Test”, “Shortest Edit Script”
and “Paired t test”.
Ignore Case Ignores the case in the search criteria.
Match Whole Words Returns items that contain each word in the string based on the Match
All Terms setting. If you search for “data filter”, and Match All Terms is selected, entries
that contain both “data” and “filter” are returned.
Search Category and ltem Names Returns category names (in the left column) and item
names (in the middle column) that match the search criteria.
Search Prototypes and Descriptions Returns prototypes (the JSL syntax) and descriptions
that match the search criteria.
Search Examples Returns examples that match the search criteria.
Let JMP Teach You JSL

The best JSL writer is JMP. You can work in JMP interactively and then save the results as a
script to reuse later. With simple modifications, your script can serve as a template for
speeding up routine tasks.

Because JSL is a very flexible language, you can reach your goals in many different ways. Here
is an example. Typically, the script that JMP saves for you specifies every detail of your
analysis, even if most of the details happen automatically by default. Does that mean that the
scripts that you write have to be just as complete and detailed? Not at all. You usually need to
specify only those details that you would select in the graphical user interface (GUI). For
example, if you open Big Class.jmp from the sample data folder and want to launch
Distribution for height, weight, and sex, the following script is all that is necessary:

Distribution( Y( :height, :weight, :sex ) );

Suppose you run the Distribution platform in the GUI and then select Save Script > To Script
Window from the red triangle menu for the report. The following script appears:

Distribution(
Continuous Distribution( Column( :height ) ),
Continuous Distribution( Column( :weight ) ),
Nominal Distribution( Column( :sex ) ),

);
Both scripts give the same result.

Feel free to experiment with JSL. If you think something ought to be possible, it probably is.
Give it a try, and see what happens.
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Terminology

Before you begin creating scripts, you should become familiar with basic JSL terms used
throughout the Scripting Guide.

Operators and Functions

An operator is one- or two-character symbol (such as + or =) for features such as common
arithmetic actions, scoping names, regular expressions, concatenating, and subscripting.

A function is a command that might contain additional information for the function to use.

Certain JSL functions work the same as operators but provide access to more complex actions.
For example, the following two lines are equivalent:

2 + 3; // returns 5
Add( 2, 3 ); // returns 5

The first line uses the + operator. The second line uses the Add() function equivalent.

Although all JSL operators have function equivalents, not all functions have operator
equivalents. For example, Sqrt(a) can be represented only by the Sqrt() function.

Note: In previous versions of JMP and its documentation, the terms operators and functions
were used interchangeably. Now each term has a specific meaning.

Objects and Messages

An object is a dynamic entity in JMP, such as a data table, a data column, a platform results
window, a graph, and so on. Most objects can receive messages that instruct the object to
perform some action on itself.

A message is a JSL expression that is directed to an object. That object knows how to evaluate
the message. In the following example, dt is the data table object. << indicates that a message
follows. In the following example, the message tells JMP to create a summary table with the
specified variables.

dt << Summary( Group( :age ), Mean( :height ) )

In this expression, dt is the name of a variable that contains a reference to a data table. You
could use any name for this variable. The Scripting Guide commonly uses dt to represent data
table references. Here are some of the more common names used to represent references to
certain objects:
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Abbreviation Object
dt data table
col column in a data table
colname the name of a column in a data table
obj an object
db display box

These variables are not pre-assigned references. Each one must be assigned prior to its use. In
the following example, the global variable named A is assigned the value “Hello, World”.
When the Show( A ) command is processed, the result is the value of A.

A = "Hello, World";
Show( A );
A = "Hello, World";

Arguments and Parameters

An argument is additional information that you can provide to a function or message. For
example, in Root (25), 25 is an argument to the Root () function. Root () acts on the argument
that you provide and returns the result: 5.

Programming and scripting books commonly talk about parameters as well. A parameter is a
description of the argument that a function accepts. For example, the general specification for
Root () might be Root( number ), where number is the parameter.

Parameter and argument express two perspectives of the same concept: information that a
function needs.

For simplicity in the Scripting Guide, we use the word argument in both cases.

A named argument is an optional argument that you select from a predetermined set and
explicitly define. For example, title("My Line Graph") in the Graph Box() functionis a
named argument because the title is explicitly defined as such.

Graph Box( title( "My Line Graph" ),
Frame Size( 300, 500 ),
Marker( Marker State( 3 ), [11 44 771, [75 25 50] );
Pen Color( "Blue" );
Line( [10 30 70], [88 22 44] ));

Note that the Frame Size() arguments 300 and 500 are not named. The position of these
arguments implies meaning; the first argument is always the width, the second argument is
always the height.
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Optional Arguments

Functions and messages require certain arguments, and other arguments are optional. You
can include them, but you do not have to. In specifications, optional arguments are enclosed in
angle brackets. For example:

Root( x, <n> )
The x argument is required. The n argument is optional.

Optional arguments often have a default value. For example, for Root (), the default value of n

is 2:
Code Output Explanation
Root( 25 ) 5 Returns the square root of 25.
Root( 25, 2 ) 5 Returns the square root of 25.
Root( 25, 3 ) 2.92401773821287 Returns the cube root of 25.

Or and the Vertical Bar Symbol

A single vertical bar (|) represents a logical OR. For brevity, | represents the word or when
referring to alternative values.

For example, a pathname can be either absolute or relative. When you see an argument such
as absolute|relative, this means that you enter either one of the following two options:

e absolute indicates an absolute pathname.

e relative indicates a relative pathname.

More than two options can also be strung together with a vertical bar in this way.

Script Formatting

Whitespace characters (such as spaces, tabs, and newlines) and capitalization are ignored in
JSL. This means that the following two expressions are equivalent:

Expression 1:

sum = 0;
ForCi =1, i <= 10, i++,
sum += 1i;

Show( i, sum );

s

Expression 2:
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Sum = 0;
ForC i =1, i <= 10, i++,
Sum += 1i;
Show( i, Sum );
J;

You can format your script in any way that you like. However, the script editor can also format
your script for you. The Scripting Guide uses the script editor’s default formatting for
capitalization, spaces, returns, tabs, and so on. See “Work with the Script Editor” for more
information about using the script editor.

Note: The only white space exception is two-character operators (such as <= or ++). The
operators cannot be separated by a space.

Basic JSL Syntax

A JSL script is a series of expressions. Each expression is a section of JSL code that
accomplishes a task. JSL expressions hold data, manipulate data, and send commands to
objects.

Many expressions are nested message names. Message contents are enclosed in parentheses:
Message Name ( argument 1, argument 2, ... );

The meaning of JSL names depends on the context. The same name might mean one thing in a
data table context and something entirely different in a function context. See “Rules for Name
Resolution”.

Almost anything that follows certain punctuation rules, such as matching parentheses, is a
valid JSL expression. For example:

win = New Window( "Window Example",

<<Modal,
Text Box( "Hello, World" ),
Text Box( "----- ",
Button Box( "OK" )
J;
Notes:

e Names can have embedded spaces. See “Names”.

* Message contents are enclosed in parentheses, which must be balanced. See
“Parentheses”.

® [tems are separated by commas. See “Commas”.

* JSL is not case sensitive; you can type “text box();” or “Text Box()”.
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® Messages are commonly nested inside other messages.

Book Conventions

In the Scripting Guide, the function names that are case sensitive are capitalized as you must
use them. Arguments that are placeholders for actual choices are in Towercase. For example,
Connect Color is a function that you need to type as is, and color stands for some color
choice that you make yourself.

Connect Color(color);

In this case, the argument in parentheses must be some color value (for example, a JMP color
number, or a supported color name like "red", "blue", and so on, or an RGB value given as a
list, such as {.75, .50, .50}).Sometimes alternatives like these are shown with the vertical
bar (|) character for “or,” like this:

Connect Color( number | "color name" | {r,g,b} );

Syntax coloring is applied to scripts that you can paste into a script editor and then run.
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Chapter 3

Getting Started
Let JMP Write Your Scripts

You often have to produce the same reports for the same data on a regular basis. This chapter
shows you how to let JMP write scripts for common tasks like importing text data, opening
Microsoft Excel files, and producing reports. A final tutorial shows you how to put it all
together into a single script to open an Microsoft Excel file and produce three reports
automatically.

The Scripting Guide is written for users who are familiar with JMP but might not be familiar
with JSL. For more information about performing common tasks, see Using JMP. Discovering
JMP is also a good resource for learning basic concepts and understanding the JMP workflow.
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Capturing a Script for an Analysis Report

Here are the basic steps for capturing a script to reproduce an analysis:

1. Launch a platform, such as Distribution.

2. Make any changes or additions that you need. For example, add tests and other graphs.
3. Capture the script to recreate your results.

You can save the script in the data table, so that if you send the data table to others, they can
run your script and duplicate your reports.

Example
Follow these steps to produce a distribution report, capture the script to reproduce it, and save
it to the data table.

Note: The data tables that you use in examples are located in JMP’s Samples/Data folder.

1. Select Help > Sample Data Library and open Companies.jmp.

2. Select Analyze > Distribution to open the Distribution launch window.

3. Select Profits ($M) in the Select Columns box and click the Y, Columns button.
4. Click OK.

The Distribution report window appears.

o1

Click the Distributions red triangle and select Stack to make your report horizontal.

6. Click the red triangle next to Profits ($M) and deselect Outlier Box Plot to turn the option
off.

7. Click the red triangle next to Profits ($M) and select Test Mean.
The Test Mean window appears.
Type 500 in the Specify Hypothesized Mean box.
Click OK.
The test for the mean is added to the report window.

Now you have your customized report.



52 Getting Started Chapter 3
Capturing a Script for a Data Table Scripting Guide
Figure 3.1 Customized Distribution Report
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10. Click the Distributions red triangle and select Save Script > To Data Table.

Your data table now has a script named Distribution saved to it. Right-click the
Distribution script and select Edit to see the script.

Figure 3.2 Distribution Script Saved to the Data Table

mCompatiies b Name: |Distributic>n | [ 0K |
Notes Selected Data on the .
= Distributicn Script: Distribution( -

stack( 1 ), Run |

Continuous Distribution( Debug Script|
Column( :Name( "Profits (SM)" ) ),
Horizontal Layout( 1 ), Save |
Vertical( @ ),
Outlier Box Plot( @ ), @'

Test Mean( 500 )

11. To run the script and reproduce your final report exactly, click the green triangle next to
the script.

Capturing a Script for a Data Table

Here are the basic steps for capturing a script to reproduce a data table:

1. Open the data table.
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2. Make any changes that you need. For example, add a script, correct values, add new
columns.

3. Capture the script to recreate your data table.

Example
Use the data table from the previous example, where you saved a script to it.

1. Inthe data table, select the red triangle next to the data table’s name.

2. Select Copy Table Script.

Figure 3.3 Copy the Table Script

@ompanies Dl 4 hd

Tables 4
Mew Table Variable
Mew Script

Suppress Formula Eval
Lock Data Table

Compress File When Saved

Disable Undo

Copy Table Script R

by’
Copy Table Script (No Data)

Rerun Formulas

3. Open a script window by selecting File > New > Script.
4. Select Edit > Paste.

You now have a script that duplicates your data table. You can save this script and run it at
any time to recreate your data table, with all its scripts attached.

Capturing a Script to Import a File

To capture a script that imports a file, you open the file in JMP. JMP automatically records the
steps that occurred when you opened the file.

Import a Text File
1. Select File > Open.
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The Open Data File window appears.
2. Select Text Files from the list next to File name.
3. In the Open as section, select Data (Best Guess).

JMP formats the data based on tabs, commas, white space, and other characters in the text
file.

4. Browse to select the file, and then select Open.

The file is opened as a data table. The data table includes a script named Source. This JSL
script imports your text file with the text import rules that you used.

5. Right-click the Source script and select Edit.

You can copy this script, paste it into a new script window, and save it. Then you can run
this script later to reimport the text file.

Tip: The import script is an Open () expression that specifies the text file and the import
options to correctly import the file into JMP. The first part of this expression is the pathname to
the specific file that you imported. If you save this script and want to run it a different place,
you might need to edit the pathname so that it points to the text file. Pathnames are discussed
in greater detail in “Path Variables”.

Gluing Scripts Together

Suppose new data is saved out to an Microsoft Excel file once a week, and you need to
produce the same reports every week. You could open the file and perform the same steps
every week. However, creating a script that imports the new Microsoft Excel file into JMP and
runs all analyses automatically is more efficient. The following example shows you how to set
up your script and run it each week.

Import the Microsoft Excel File

1. Open a new script window (File > New > Script).

2. Inyour script window, enter the Open() expression to open the Solubil.xIsx sample import
data file. The file is located in JMP’s Samples/Import Data folder.

dt = Open( "$SAMPLE_IMPORT_DATA/Solubil.xTsx" );

Be sure to put the semicolon at the end of this expression, because you will add more
expressions. The semicolon glues expressions together.

3. Run your script to import the Microsoft Excel file by selecting Edit > Run Script.

The Microsoft Excel file opens as a data table.
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Notes:

You can also include the Excel Wizard argument in the Open() expression to preview the
worksheet before importing it. See “Import Data from a Microsoft Excel File”.

You can specify an absolute or relative path to the file rather than using a path variable.
For relative links, the script and file being opened must be in the same relative location
each time you run the script. With absolute links, make sure that other users running the
script have access to the file’s location. See “Path Variables” for more information about
using pathnames.

Run Your Reports and Capture Their Scripts

You have three reports to produce: a distribution report, a 3D scatterplot, and a multivariate
report. Perform each one using the GUI, and add its script to the script window.

1
2
3.
4

o

L »® N

12.
13.
14.
15.

With your new data table open, select Analyze > Distribution.

Select all the columns except Labels and click Y, Columns.

Click OK.

Press Ctrl, click the eth red triangle, and then select Histogram Options > Show Counts.
Bar counts are added to all six histograms.

In the Distribution window, click the Distributions red triangle and select Save Script > To
Clipboard.

Click a line or two after your Open() expression and select Edit > Paste.
Type a semicolon after the last close parenthesis.
Select Graph > Scatterplot 3D.

Select all the columns except Labels and click Y, Columns.

. Click OK.
. Copy and paste the script for Scatterplot 3D into the script window just like you did for

your Distribution report. Be sure to add the semicolon at the end.
Select Analyze > Multivariate Methods > Multivariate.

Select all the columns except Labels and click Y, Columns.

Click OK.

Copy and paste the script for Multivariate into the script window just like you did for
Distributions and Scatterplot 3D.

You should see the following script:

dt = Open( "$SAMPLE_IMPORT_DATA/SolubiT.x1sx" );
Distribution(
Continuous Distribution( Column( :eth ), Show Counts( 1) ),
Continuous Distribution( Column( :oct ), Show Counts( 1 ) )
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Continuous Distribution( Column( :ccl4 ), Show Counts( 1 ) ),
Continuous Distribution( Column( :c6¢c6 ), Show Counts( 1 ) ),
Continuous Distribution( Column( :hex ), Show Counts( 1) ),
Continuous Distribution( Column( :chcl3 ), Show Counts( 1 ) ),
s
Scatterplot 3D(

Y( :eth, :oct, :ccl4, :c6c6, :hex, :chcl3 ),

Frame3D( Set Grab Handles( 0 ), Set Rotation( -54, 0, 38) )

s
MuTtivariate(
Y( :eth, :oct, :ccld4, :c6c6, :hex, :chcl3 ),
Estimation Method( "Row-wise" ),
Scatterplot Matrix( Density Ellipses( 0 ), Shaded Ellipses( 0 ) )
s
Save the Script

You now have a script that reproduces all of the steps that you performed manually. Save the
script, and close your data table and all its report windows.

1. In the script window that contains your script, select File > Save or File > Save As.
2. Specity a filename (for example, Weekly Report).
3. Click Save.

Run the Script

As long as your weekly updated Microsoft Excel file is saved in the same place and contains
the same columns, you can run your script and automatically produce all your reports.

1. Open the script that you saved.
2. Select Edit > Run Script.

Your Microsoft Excel file is opened in JMP, and all three of your reports appear.
You can send this script to others. As long as they have access to the same Microsoft Excel file
in the same location, they can also run the script in JMP and see your reports.
Advanced Note: Auto-Submit

If you want a particular script to always be executed instead of opened into the script window,
put the following command on the first line of the script:

//!
If this is not the very first line, with nothing else on the same line, this command does nothing.
You can override this command when opening the file.

1. Select File > Open.
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2. Press Ctrl, select the JSL file, and then click Open.

The script opens into a script window instead of being executed.

The command is also ignored when you right-click the file in the Home Window and select
Edit Script.
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Scripting Tools
Using the Script Editor, Log Window, Debugger and Profiler

JMP provides several programming tools for script writers. The script editor supports syntax
coloring, autocompletes functions as you type, highlights matching braces, allows for code

folding, and has additional features to help you develop scripts more quickly. Error messages
and output are shown in the log window, which can be displayed inside the script editor. The
JMP Scripting Language (JSL) Debugger and Profiler can help you troubleshoot your scripts.

Figure 4.1 Script Editor with Embedded Log and the Debugger

&) scoping - JMP Pra — O X
File Edit Tables DOE Analyze Graph Tools Add-Ins View Window Help

Has % 53 - HERE-S - i (no tables) v -

1 /* This script was written to demonstrate JSL debugging techniques.

2 See the Scripting Guide for an example. =/
3

4 Names Default To Here(8);

5 x =5;

6

7 Names Default To Here(1);

s |

9 x =0;

10

11 Local Here(

12 x = 10;

13 Show(x, global:x, here:x);
14 Write("\IN");

15 );

(SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks
of SAS Institute Inc. in the USA and other countries. ® indicates USA registration. Other brand and

File Edit
EI product names are registered trademarks or trademarks of their respective companies.)
=/
scoping,js!
1 /* This script was writte
2 See the Scripting Gui
3 x = 10;
4 @ Names Default To Here(@); global:x = 5;
5 x=25; here:x = 10;
6
7 Names Default To Here(1); test:x = 15;
8 here:x = @;
9 x=80; global:x = 5;
10 "Finished!"
11 Local Here(
12 x = 10;
13 Show(x, global:x, her
14 Write("\IN");
15 )5
16
17  New Namespace( "test".
Globals | Locals | Watch | Namespaces | Classes ¥ | Call Stack | Breakpoints = Data Breakpoints | Options Log
Variable Value Location

b 5 scopingjsl Line 4
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Work with the Script Editor

e “Introduction to the Script Editor”

® “Run a Script”

e “Stop a Script”

e “Edit a Script”

¢ “Color Coding and Themes”

e “Autocomplete Functions”

e “Tooltips”

e “Splita Window”

e “Match Parentheses, Brackets, and Braces”
e “Select a Rectangular Block of Text”

e “Select Fragmented Text”

¢ “Drag and Drop Text”

* “Find and Replace”

e “Automatic Formatting”

* “Errors Are Marked by Special Characters”
e “Typing in Multiple Rows at Once”

e “Add Code Folding Markers”

* “Advanced Options”

e “Set Preferences for the Script Editor”

Introduction to the Script Editor

The script editor provides a friendly environment for writing and reading JSL scripts.

Figure 4.2 shows basic features such as syntax coloring, inline commenting, and automatic

formatting. Other common programming options are described later in this section.

Script editor features are also available in the log window and anywhere else that you can edit
or write a script (for example, in the Scripting Index or Application Builder).
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Figure 4.2 The Script Editor

L=

File Edit Tables DOE Analyze Graph Tools Add-Ins View Window Help

I_gl *:j' __; =3 = < (no tables) ~ _

1 // Kernel Buildup

2 // Inspired by page 21 of Foster, Stine, and Waterman, Basic Business Statistics
>

4 Mames Default To Here( 1 );

5

6 data = [5, 7, 8, 9.5, 1@, 16.5, 11, 11.2, 12, 13, 15, 17, 18];

7 sigma = 1.5;

8

9 t = New Window( "Kernel Addition",

10 Graph(

11 FrameSize( 460, 300 ),

3l X Scale( @, 20 ),

a3t Y Scale( 0, 2.5 ),

14 Double Buffer,

15 n = N Row( data );

16 For{ i =1, i <= n, i++,

a7 xx = data[i, 1];

18 Y Function( Mormal Density( (x - xx) / sigma ) / sigma, x );
ik, )i

20 Pen Color( 3 ); // the sum is in red
21 Y Function(
22 Summation( i = 1, n, Normal Density( (x - data[i, 1]) / sigma ) / sigma ),
23 X
24 b
25 Pen Color( @ );
26 Handle( sigma, .5, sigma = x );

o[> Ov

Tip: Consider setting the Autosave timeout value in the General preferences to automatically
save open scripts at the specified number of minutes. This autosave value also applies to data
tables, journals, scripts, projects, and reports.

Run a Script

To run an entire script, select Edit > Run Script.
To run specific lines in a script, select those lines and then select Edit > Run Script.

To run specific lines that are not adjacent, press Ctrl, select the lines, and then select Edit > Run
Script.

On Windows, you can also click in a line or select several lines and press Enter on your
numeric keypad.

Run the script automatically when you open it by using one of the following methods:
e Type //! on the first line.
e Include Run JSL(C 1 ) in the Open() statement:
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Open( "$SAMPLE_SCRIPTS/scoping.js1", Run JSLC 1 ) );

Stop a Script

To stop the script, press Esc on Windows (or Command-period on macOS). You can also select
Edit > Stop Script. On macOS, Edit > Stop Script is available only when the script is running.

Edit a Script

To edit a script on Windows, press Insert. You can then type directly over (overwrite) any
existing JSL code. Note that this feature is not available on macOS.

Color Coding and Themes

On Windows, the default font in the script editor is 10-point Consolas. On macOS, the default
script editor font is 13-point Menlo.

JMP applies the following colors in the script window:

e Dblack for text, identifiers (JSL functions), braces, and user macros
¢ white for the script editor background

e gray for the disabled background and guides

e green for comments

e purple for strings

¢ maroon for platform names
Note: If a platform name is used in a message, the JSL messages color is used.

e teal blue for numbers
e dark blue for operator symbols, the first keyword, and JSL messages
¢ medium blue for function names, second and third keywords, and macros

* red for unknown objects

You can customize colors and fonts in the Customize Styles section of the Script Editor
preferences. Syntax coloring for JSL, the log, SAS code, JavaScript, Text, JMP Text Analytics, R,
Matlab, Python, C, JSON, and SQL are supported. In addition, options for dark and light
themes are provided.
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Autocomplete Functions

If you do not remember the exact name of a function, use autocompletion to see a list of
functions that match what you have typed so far. Type part of the name, and then press
Ctrl+Space on Windows (Option+Esc on macOS).

Suppose that you want to clear your JSL variables, but do not remember the command. You
can type clear and then press Ctrl+Space, to see a list of possible clear commands. Select the
command that you want to insert.

Figure 4.3 Autocomplete Example

1 clear|

Clear Globals

Clear Log
Clear Symbols

Tooltips

If you are using a function and do not remember the syntax or need more information about
it, place the cursor over it to see a brief explanation. This works only with JSL function names,
not platform commands, messages, or user-created functions. JSL function names are colored
blue in the script editor.

The tooltip shows the syntax, arguments, and a brief explanation of the function (Figure 4.4).
The tip also appears in the script editor window status bar.

Figure 4.4 Tooltip for a JSL Function
5 Normal Density();

y = Normal Density( q, <mu=0z=,
<sigma=1=)

Returns the density at g of a Normal
distribution with mean mu and
standard deviation sigma.

After running a script, you can also place the cursor over variable names to see their current
value. To turn off variable tooltips, deselect Preferences > Script Editor > Show Variable Value
Tips.

To turn off function tooltips, deselect Preferences > Script Editor > Show Operator Tips.
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Tip: In addition to showing the tooltip for a function, you can display its Scripting Index entry.
Run the script, press Alt, and then double-click the function. A description, sample script, and
information about syntax is provided. You can also read help for the topic by running the
script, right-clicking the function, and selecting Help Browser.

Example of a Tooltip for a JSL Variable

1. Enter and run the following line in a script window:
my_variable = 8;
2. Hover over the variable name after you run the line.
A tooltip shows the name of the variable and its value: 8.
3. Enter and run the following line:
my_variable = "eight";
4. Hover over the variable name after you run the line.
A tooltip shows the name of the variable and its value: “eight”.
Split a Window

You can split the Script Editor window into two vertical or horizontal windows. This feature
enables you to independently scroll through your code in two different places and edit the
contents in both. When you make a change in one window, the change is immediately
reflected in the other window.

To split an open Script Editor window, right-click in the window and select Split >
Horizontal or Vertical.

To revert to a single window, right-click and select Remove Split.
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Figure 4.5 Example of Splitting a Window Horizontally

File Edit Tables DOE Analyze Graph Tools Add-Ins View Window Help
HaE $ =2 - i R "3‘@; i (no tables)
1 //Michael Barnsley's Chaos Game 1 //Michael Barnsley's Chaos Game
2 2
3 Memes Default To Here( 1 ); 3 Names Default To Here( 1 );
4 4
5 //these matrices are the original positions 5 //these matrices are the original positions of
of the three corners 6 xcorners = [@, 1, 8.5];
6 xcorners = [8, 1, 8.5]; 7 ycorners = [@, B, 1];
7 ycorners = [@, @, 1]; 8
2 9 mSize = 1;
9 mSize = 1; 18 nPoints = N Row( xCorners );
18 nPoints = N Row( xCorners ); 11
11 12 //a and b are the coordinates of the point tha
12 //a and b are the coordinates of the point 13 a = 0;
that moves around 14 b = ©;
13 a = ©; 15
14 b = 0; 16 showpoints = @; //flag used to turn off points
15 17 iterations = 1@; //number of iterations to go
16 showpoints = @; //flag used to turn off 18 userFactor = 2; //factor to shrink by
points during drags 19 factor = 1 / userFactor;
17 iterations = 18; //number of iterations to 20 rotate = 1( nPoints, 1, @ ); // angle to rotat
go through 21 userRotate = ©;
18 userFactor = 2; //factor to shrink by 22
19 factor = 1 / userFactor; 22 New Window( "The Chaos Game",
20 rotate = J( nPoints, 1, ® ); // angle to 24 V List Box(
rotate through 25 Text Box( " Drag the vertices to chan
21 userRotate = 0; 26 Text Box( " (Click to designate starti
22 27 g = Graph(
3 Mew Window( "The Chaos Game™, 28 Framesize( 466, 400 ),
24 V List Box( 29 X Scale( -8.2, 1.2 ),
25 Text Box( " Drag the vertices to 30 Y Scale( -8.2, 1.2 ),
change shape." ), 31
26 Text Box( " Click to designate 32 //draw the initial points -- draggable
starting point." ), 33 Marker Size( 3 );
27 g = Graph( 34 Drag Marker( xcorners, ycorners, s

22

Eramacizal ABR  ADG N\

Match Parentheses, Brackets, and Braces

The script editor helps you match fences (or parentheses, square brackets, and braces) in the
following ways:

The matching closing fence is added when you type an opening fence.

When you click next to either an opening or closing fence, the fence and its match are
highlighted in blue. If the fence does not have a match, it is highlighted in red.

If you double-click a fence, everything between the matching fence is selected (including
the fences).

If you put your cursor within an expression and press Ctrl+] on Windows (Command+B
on macOS), the entire expression is selected. Fences that enclose the expression are
included. Repeat this process to highlight the next-higher expression. Figure 4.6 shows an
example.



Chapter 4 Scripting Tools 67
Scripting Guide Work with the Script Editor

Figure 4.6 Each Step in Matching Fences

<<Script|(
tempf = Num{ teblAlpha$ << Get Text ):
If( Not( Is Missing( temp# ) ) & (0 < tempf < 1),

alpha%# = temp#
)i
tebAlpha# << Set Text({ Char{BEEEEY ) ;

evalSummary$;

) <<Script|(
tempf = Num{ teblAlpha$ << Get Text ):
If( Not( Is Missing( temp# ) ) & (0 < tempf < 1),

alpha%# = temp#
)i
tebAlpha# << Set Text[s:CEdEENECtNEN] -

evalSummary$;

<<Script|}
temp$ = Num( tebllpha# << Get Text ):
If( Not( Is Missing( temp# ) ) & (0 < tempd < 1),

)i
tebAlpha# << Set Text({ Char( alpha# ) ):
evalSummary# ;

When you type an opening brace, JMP adds the closing brace. Enter code between the braces,
type the closing brace, and then your cursor automatically moves after the closing brace that
JMP added. This prevents you from accidentally adding an unnecessary closing brace.

You can turn on and off the autocompletion of braces in the JMP preferences. See “Set
Preferences for the Script Editor”.

Select a Rectangular Block of Text

To select a rectangular block of text, press Alt and drag your cursor from the starting point to
the end of the block. You can either copy or cut the text enclosed in the block.

Suppose that you want to the select all of the following code except for the comment marks.

/7 YC Y ),
/7 XC X)),

Select a rectangular portion beginning with Y. When you paste, you get the following code:

YC:Y ),
X(C : X)),

The rectangular selection inserts returns where needed to maintain the structure of the text.
Select Get Menu Item State on both lines in the following example.

bb << Get Menu Item State(l),
bb << Get Menu Item State(2),

When you paste, a return is inserted at the end of each line.

Get Menu Item State
Get Menu Item State



68 Scripting Tools Chapter 4
Work with the Script Editor Scripting Guide

Select Fragmented Text

To select text that is not contiguous, press Ctrl on Windows or Command on macOS and drag
your cursor over the text. Continue this action for any other text that you want to select. You
can then copy and paste your selection into a new script or you can run the selected text. Text
will be pasted or run in the order it was selected.

Drag and Drop Text

You can drag and drop text within a script editor window or between windows or from a data
table into a script editor window. On Windows, pressing Ctrl before dragging and dropping
copies the text. On macOS, the text is copied by default.

Drag and drop text in any of these ways:

® Select a row or column, pause, and then drop it into the script editor window.

* Double-click text in a text field and then drop it into the script editor window. Examples
are text in a data table cell and any other selectable text.

On Windows, you can also drag and drop text into a minimized window.

1. Drag the text over the Home Window button ++ in the lower right corner of the window.
The Home Window appears.

2. In the Home Window list, drag the text over the destination window.
That window appears.

3. Drop the text where you want it.

Find and Replace
Many find and replace options are available in the script editor, including the support of
regular expressions. For example, searching with the following regular expression:
get.*name
returns messages such as “Get Button Name”, and “GetFontName”

Basic regular expressions such as A and $ (which match the start of line and end of line) and \n
(which matches a carriage return) are also supported.

See Using [MP for more information about the Search options.
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Automatic Formatting

The script editor can format a script for easier reading. Any generated script (for example, by
saving a platform script) is automatically formatted with tabs and returns in appropriate
places.

You can also reformat individual scripts that are difficult to read (for example, scripts in which
all commands are strung together with no whitespace characters). From the Edit menu, select
Reformat Script.

Tip: This command alerts you if your script is badly formed (for example, if your parentheses
are not matched).

Errors Are Marked by Special Characters

After you run a script, the /*###%*/ characters in the log indicate the location of an error in the
script execution. The following example shows a script in which the height column name is
misspelled.

Names Default To Here( 1 );
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt:heihgt[3]; // misspelled column name

After you run the script, the log reads:

Scoped data table access requires a data table column or variable in access or
evaluation of 'dt:heihgt' , dt:heihgt/*###*/

In the following script, error marked by /*###*/

Names Default To Here( 1 );

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

dt:heihgt/*###*/[3];

/*###* / directly follows the misspelled height argument.

Typing in Multiple Rows at Once

When you edit a script, you can type in multiple rows at once instead of manually updating
the same code on multiple lines. For example, in the following script, you want to change the s
variable to aString. You can easily change the first instance of s to aString. To change the
other instances at once, hold down Alt and select the column of s variables. Type aString
once.

S = ;

For( i =1, i <= n, i++,
s += "Hello";
s += "Number";
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s 4= Char( i );
)

The script then looks like this:

aString = "";

ForCi =1, i <= n, i++,
aString += "Hello";
aString += "Number";
aString += Char( i );

)3

Note: You can type in multiple rows at once, but you can type only in the same column. In the
preceding example, the s variables are in the same column.

Add Code Folding Markers

You can add code folding markers that show the beginning and the end of the code block,
enabling you to collapse and expand code inside stand-alone functions.

To turn on this feature, select Code folding in the Script Editor preferences. Then you can
expand and collapse blocks of code by right-clicking on a script and selecting Advanced >
Expand All or Collapse All.

Tip: To fold or expand all code in the entire script, press Shift+Ctrl and then click a code
marker.

After you select this preference, Function and Expr expressions are foldable. See “Add More
Folding Keywords” for more information about adding folding markers to other expressions.

Figure 4.7 Code Folding Markers Shown in a Script

HcomputeBayes# = Expr(
computeBayes$;

updateBayes$ = Expr(
computeBayes$;
nch# << Set Values( factorProbability# ):
pcb# << Delete;
th# << Append( pcb# = Flot Col Box( "Frobability"™, factorProbabilitv# ) ):

By default, code does not remain collapsed after you save the script and restart JMP. To save
the state of the folded code, select Save and restore document state information in the Script
Editor preferences.
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Add More Folding Keywords

Custom code folding is supported for other stand-alone functions as shown in the following
example:

{"If", "For", "For Each Row", "While", "Try", "New Window", "V List Box",
"H List Box"}

JMP supports multiple keyword lists. A system administrator can define a set of keywords in
jmpKeywords.jsl and save the script in C:/ProgramData/SAS/JMP/ or designated directory
listed below. You save your version of jmpKeywords.jsl in your C:/Users/<user>/Documents/
folder. JMP merges all keyword lists from the designated directories.

On Windows, the following directories are examined in the order listed:

C:/ProgramData/SAS/JMP/16/
C:/ProgramData/SAS/JMP/
C:/Users/<user>/AppData/Roaming/SAS/JMP/16/
C:/Users/<user>/AppData/Roaming/SAS/JMP/
C:/Users/<user>/Documents/

On macOS, the following directories are examined in the order listed:

/Library/Application Support/JMP/16/
/Library/Application Support/JMP/
~/Library/Application Support/JMP/16/
~/Library/Application Support/JMP/
~/Documents/

Note that jmpKeywords.jsl is stored in the designated JMP directory, even if you are using JMP
Pro.

Notes:

The list in jmpKeywords.jsl is case insensitive.

Code folding is not supported for messages, platforms, user-defined functions, and
comments.

After you edit and save the list in jmpKeywords.jsl, turn the Allow additional code folding
keywords preference off and then back on for the changes to take effect. Messages in the
log indicate that the keywords were loaded.

Advanced Options

Right-clicking on selected text in the Script Editor provides the following Advanced options:

Expand All (Appears only if JSL code folding is on.) Expands all blocks of code.
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Collapse All (Appears only if JSL code folding is on.) Collapses all blocks of code.
Comment Block Makes the selected text comments.

Uncomment Block Uncomments the selected comments.

Make Uppercase Changes all selected text to uppercase.

Make Lowercase Changes all selected text to lowercase.

Set Preferences for the Script Editor

In the JMP preferences, customize the script editor settings such as the font, colors, and
spacing options.
Setting the Fonts

1. Select File > Preferences.
2. Select the Fonts group.
3. Click Mono to set the font for the script editor.

For more information about font preferences, see Using [MP.

Set Script Editor Preferences

Select File > Preferences > Script Editor to further customize the editor. For more information
about script editor preferences, see Using [MP.

Work with the Log

The Log in JMP has two modes:
* “Enhanced Log in JMP”
e “Text Log in JMP”

You can switch between the two modes by selecting File > Preferences > Log.

Note: The log shows the steps you take during data cleanup. For example, if you add a
column property or import the data into Excel, then the JSL expressions for those actions are
captured in the log. This enables you to clean up the data more efficiently when you receive a
new data set.
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Enhanced Log in JMP

The Enhanced Log is a tabular view of the events in a JMP session. To view the JMP Log, select
View > Log (Window > Log on macOS). By default, the log in JMP appears in Enhanced mode.
The log window contains events, or actions, in the rows of the table and the corresponding JSL
code and output in a separate text pane. This tabular view of the events is easy to navigate,
displays errors and warnings, and can help you create a JSL script of the actions in a JMP
session. For an example of using the log to generate a JSL script for recorded actions, see
“Example of Recording Actions in the Enhanced Log”.

Note: When you used the embedded log in a script window, the embedded log does not use

the Enhanced Log mode. Further, any script output from a script window with an embedded
log does not appear in the Enhanced Log.

Figure 4.8 Enhanced Log

I Fitter P |-
:Type Message Origin _ Result Ti p
: - 2%pi() H 09/18/2020 3:44:35 PM
| = 6.28318538717959 H 09/18/2020 3:44:35 PM
+## w = New Window("Hi",b=ButtonBox("Press Me")); B 09/18/2020 3:45:00 PM
| = bDisplayBox[EvalContextBox] = = 09/18/2020 3:45:00 PM
+ b H 09/18/2020 3:45:11 PM
! = DisplayBox[ H 09/18/2020 3:45:11 PM
7 sin("A"); H 09/18/2020 3:47:19 PM
@ Cannot convert argument to a number [or matrix] = 09/18/2020 3:47:21 PM
+# print("Here is a note"); B 09/18/2020 3:47:32 PM
6 "Here is a note” = 09/18/2020 3:47:32 PM
+# [/ A longer script: - 09/18/2020 3:4845 PM

dt = Open("$SAMPLE_DATA/Big Class.jmp"});
biv = dt << Run Script( "Bivariate"” );

= Bivariate[ el 00/18/2020 3:4845 PM
1 Report snapshot: Big Class - Bivariate of weight by height 3 09/18/2020 3:4851 PM
Subset data table BB B 09/18/2020 3:49:20 PM

// Subset data table

Data Table( "Big Class™ ) << Subset(
Sampling Rate( ©.5 ),
Selected columns only( @ )

i
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Each row of the tabular view contains information in the following columns:

Type Contains an icon that represents message type. For more information about the types
of messages, see “Filter”.

Tip: You can hover over an icon in the Type column to see the type of message that a
particular icon represents.

Message Contains a description of the event or result. Among other things, this could be a
recorded action, JSL that was submitted, the result of JSL that was submitted, or an error
message. Each description of a logged item or result is limited to three lines of text; longer
items are denoted with an Ellipsis icon = in the upper right corner of the Message section
of the row. The full text for longer items appears in the text pane at the bottom of the log
window.

Origin Contains an icon that shows the type of JMP window from which the logged item or
result was generated. If the Color by Window option is selected in the red triangle menu
next to Filter, logged items generated by the same JMP window are specified by a common
color. You can click on the icon in the Origin column to bring the corresponding window
to the front.

Note: Not all rows in the log table have an icon in the Origin column.

Result Contains an icon that shows the type of JMP window that contains the result. If the
Color by Window option is selected, logged items generated by the same JMP window are
specified by a common color. You can click on the icon in the Result column to bring the
corresponding window to the front.

Note: Not all rows in the log table have an icon in the Result column.

Timestamp Contains a date-time value that indicates when the logged item was generated.

Enhanced Log Options

The red triangle menu in the Enhanced Log contains the following options:

Go To (Available only when one or more rows of the log table are selected.) Brings the
window corresponding to the selected row in the log table to the front. If an Origin
window and a Result window both appear in the selected row, both windows are brought
to the front with the Result window on top of the Origin window.

Run Scripts (Available only when one or more rows of the log table that contain a scriptable
action are selected.) Runs the JSL script that corresponds to the selected rows in the log
table.
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Color by Window Specifies whether the rows in the log table are colored by the JMP window
that created the row of the log output.

Clear (Available only when one or more rows of the log table are selected.) Removes the
selected row or rows from the log table.

Caution: This action cannot be undone.

Clear Log Removes all rows from the log table.

Caution: This action cannot be undone.
Filter Contains the following options to filter what types of logged events appear in the log
table.
Result — Shows or hides rows that correspond to the results of running JSL.
Script #+ Shows or hides rows that correspond to submitted JSL.
Log @ Shows or hides rows that correspond to informational log messages.
Warning 4 Shows or hides rows that correspond to warning messages in the log.
Error @ Shows or hides rows that correspond to error messages in the log.

Action & Shows or hides rows in the log table that correspond to interactive JMP
actions. These actions include data table operations, platform launches, and closing
report windows. You can customize which actions are shown in the log table by
selecting specific options in the Action Recording submenu.

Action Recording Contains the following options to filter what types of interactive JMP
actions appear in the log table.

Data Table Operations Shows or hides rows that correspond to manipulations of a data
table. These actions can include row and column operations, as well as actions in the
Tables, Rows, and Cols menus.

Platform Launch Shows or hides rows that correspond to launching a JMP platform.

Report Snapshot on Close Shows or hides rows that correspond to a JSL script that is
saved when a report window is closed.

Save Script Contains the following options that save a script that reproduces all selected
rows in the log table. If no rows are selected, these options save a script to reproduce all
events recorded in the log table.

To Script Window Saves the script to a script window.
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To Clipboard Saves the script to the clipboard.

Make Into Data Table Creates a data table that contains all rows from the log table. If
rows are selected in the log table, they are also selected in the data table that is created.

Filter the Results in the Enhanced Log

To the right of the red triangle menu, use the search field to filter the items in the log table
view.

Click the down arrow button next to the search box to refine your search.

Contains Terms Returns items that contain a part of the search criteria. A search for “ease
oom” returns messages such as “Release Zoom”.

Contains Phrase Returns items that contain the exact search criteria. A search for “text box”
returns entries that contain “text” followed directly by “box” (for example, “Context Box”
and “Text Box”).

Starts With Phrase Returns items that start with the search criteria.
Ends With Phrase Returns items that end with the search criteria.

Whole Phrase Returns items that consist of the entire string. A search for “text box” returns
entries that contain only “text box”.

Regular Expression Enables you to use the wildcard (*) and period (.) in the search box.
Searching for “get.*name” looks for items that contain “get” followed by one or more
words. It returns “Get Color Theme Names”, “Get Name Info”, and “Get Effect Names”,
and so on.

Invert Result Returns items that do not match the search criteria.

Match All Terms Returns items that contain both strings. A search for “t test” returns
elements that contain either or both of the search strings: “Pat Test”, “Shortest Edit Script”
and “Paired t test”.

Ignore Case Ignores the case in the search criteria.

Match Whole Words Returns items that contain each word in the string based on the Match
All Terms setting. If you search for “data filter”, and Match All Terms is selected, entries
that contain both “data” and “filter” are returned.
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Example of Recording Actions in the Enhanced Log
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You can use the Enhanced Log to record many of the interactive actions that you perform for
data cleanup and analysis. In this example, the Enhanced Log is used to generate a JSL script
for some data manipulation and analysis actions.

O X Nk W=

I e N Sy e
o N O U = W NN =R O

Select View > Log.
Click the red triangle next to the Filter box and select Clear Log.
Select Help > Sample Data Library and open Car Physical Data.jmp.

Right-click Displacement in the Columns panel in the data table, and select Column Info.

Type Engine Size for the Column Name. Click OK.

Right-click Type in the Columns panel in the data table, and select Column Info.
Select Ordinal for the Modeling Type. Click OK.

Click Horsepower in the Columns panel in the data table and drag it above Weight.
Select Graph > Graph Builder.

. Drag Horsepower to the Y drop zone.

. Drag Engine Size to the X drop zone.

. Close the Graph Builder window.

. Select Analyze > Distribution.

. Select Type and Horsepower and click Y, Columns.

. Click OK.

. Click the red triangle next to Horsepower and select Continuous Fit > Fit Lognormal.
. Close the Distribution window.

. Select View > Log.
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Figure 4.9 Enhanced Log

| Fifter P -
Type Message Origin__ Result Timestamp
1 Open Data Table: Car Physical Data.jmp E¥] | 09/23/2020 2:55:57 PM
1 Change column name: Displacement + Engine Size B ‘ 09/23/2020 2:56:20 PM
1 Change column modeling type: Type B | 09/23/2020 2:56:37 PM
1 Move selected column: Horsepower B 09/23/2020 2:56:49 PM
1 Report snapshot: Car Physical Data - Graph Builder 09/23/2020 2:57:24 PM
1 Launch platform: Distribution B | 0972372020 2:58:04 PM
ji Report snapshot: Car Physical Data - Distribution of Type, Horsepower | 09/23/2020 2:59:26 PM

// Report snapshot: Car Physical Data - Distribution of Type, Horsepower
Data Table( "Car Physical Data" ) << Distribution(

Nominal Distribution( Column{ :Type )} ),

Continuous Distributieon( Column{ :Horsepower ), Fit Lognormal )

)H

19. Press Ctrl and select the first, second, third, and last rows of the log table.
20. Click the red triangle next to the Filter box and select Save Script > To Script Window.

The script to reproduce the selected actions appears in a new script window. You can save this
script to reuse later or use it as a starting point for a more complex analysis.

Text Log in JMP

The Text Log in JMP is a text-based log of JSL scripts that have been run during a JMP session
and the results of those scripts. When the log is open, output appears in the log after you run a
script. The script that was run is shaded in the log, and the corresponding output appears
beneath it. To view the log in Text mode, select Text for the Mode preference after selecting
File > Preferences > Log.

Syntax and compatibility errors are reported in the log, including the line number, script
filename, and code that JMP could not process. Many interactive JMP actions are also
recorded in the log.

Tips:

¢ To omit compatibility warnings from the log, deselect Show log warnings for JSL
compatibility changes in 12 in the JMP General preferences.

¢ To choose which actions are recorded in the log, you can use the Action Recording
preferences after selecting File > Preferences > Log.
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Show the Text Log in the Script Window

You can view the log inside the script window by right-clicking and selecting Show
Embedded Log. To view the embedded log by default, select Show embedded log on script
window open in the Script Editor preferences. This option makes it easy to edit and run a
script, quickly see the results of your changes, and then continue to develop the script. The
embedded log uses the Text log mode. See “Text Log in JMP”.

The embedded log always appears in the Scripting Index script window, but it is not available
in Application Builder and the Debugger.

Figure 4.10 The Script Window with an Embedded Text Log

File Edit Tables DOE Analyze Graph Tools Add-Ins View Window Help
= | __: = 53 I _ i (notables) v

1 A = "Hello, World";

2 Show( A );

A = "Hello, World";
Show( A );

A = "Hello, World";

Debug or Profile Scripts

In an open script, click the Debug Script button % (or select Edit > Debug Script) to show the
script in the JSL Debugger window. You can also use a keyboard shortcut:

e Press Ctrl+Shift+R (Windows).
e Press Shift+Command+R (macOS).
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The JSL Debugger helps identify the point at which a script causes an error or fails. Rather
than commenting out portions of the script or adding Print() expressions, you can use the
Debugger to find the problem.

Once the JSL Debugger appears, you can continue in this mode, or you can click the Profile
JSL Script button [E to move into the JSL Profiler mode. The JSL Profiler helps with
optimization. You can profile your scripts during execution to see how much time is spent
executing particular lines or how many times a particular line is executed.

Tip: To debug a script automatically when you open it, include Debug JSL( 1 ) in the Open()
statement:

Open( "$SAMPLE_SCRIPTS/scoping.js1", Debug JISLC 1) );

Debugger and Profiler Window

The Debugger opens in a new instance of JMP (Figure 4.11). The original instance is
inoperable until the script produces something that requires interaction. At that point, the
Debugger window becomes inoperable until you perform whatever action is required. Then
control is returned to the Debugger. Close the Debugger to work again in the original instance
of JMP.

Figure 411 The Debugger Window
o] @A @ (e |

scoping.jsl

1 /* This script was written to demonstrate JSL debugging techniques.
2 See the Scripting Guide for an example. */

3
4 ¢Names Default To Here(@);
5 x =5;

6

7 MNames Default To Here(1);
8

9 x =9;

11 Local Here(

12 x = 10;

13 Show(x, global:x, here:x);
14 Write("\IN");

15 );

17 New Namespace( “"test”,
18 {x = 15}
19 );

21 Show(test:x, here:x, global:x);

22 Print("Finiched!"Y-

Globals | Locals Watch Namespaces Classes Call Stack | Breakpoints Data Breakpoints | Options = Log

Variable Value Location
scopingjsl Line 4
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Use the buttons at the top to control the Debugger or the JSL Profiler. One or more scripts that
you are debugging or profiling are shown in tabs. If your script includes other scripts, each
one opens in a new tab.

Tabs in the bottom portion of the Debugger provide options to view variables, namespaces,

the log, and the current execution point; work with breakpoints; and set options.

Tip: To view or edit long values on a tab in the Debugger, right-click the value and select Edit.
The code opens in a script editor.

Using the Execution Buttons

Use the buttons at the top to control execution of the script within the Debugger or JSL

Profiler.

Table 4.1 Description of the Debugger Buttons

Button

&

B

i

Button Name

Run

Run without
breakpoints

Run profiler

Break All

Stop

Restart

Action

Runs the script in the Debugger until it reaches either a
breakpoint or the end of the script.

Note: If there is an error in the script, an abbreviated error
message is displayed at the top of the window. Click More to
see the complete error message.

Runs the script through the end without stopping.

If the script is busy, click Break All to stop all action in the
script and return to the Debugger or JSL Profiler (for example,
if you are in a very long loop).

The Debugger or JSL Profiler might not be able to break
execution if the executing script is waiting on some interactive
user action, such as completing a window or interacting with
an opened window.

Stops debugging the script and exits the Debugger or the JSL
Profiler.

Closes the current Debugger session and opens a new session.
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Table 4.1 Description of the Debugger Buttons (Continued)

Button Button Name Action

7 Step Into Lets you step into a function or an included file. Otherwise, it
™1 behaves the same as Step Over.

=} Step Over Runs all expressions on a single line, or a complex expression
1 that spans multiple lines, without stepping into a called
expression, function, or Include() file.

[ﬁ Step Out Runs the current script or function to a breakpoint or the end

: and returns to the calling point. If you are in the main script
and the Debugger reaches the end, a message appears:
Program execution terminated. The Debugger remains open in
order for you to inspect the final program conditions.

) Profile JSL Opens the JSL Profiler. (Press the Run profiler button to start
. Script the JSL Profiler.) Use the JSL Profiler to see how much time is
spent executing particular lines or how many times a
particular line is executed.

Notes:

* You can switch back and forth between the Debugger and
JSL Profiler modes only prior to the start of the program.

¢ Some of the debugger buttons are disabled when profiling.

¢ All breakpoints are disabled when running in the JSL
Profiler mode.

@| Show Profile Shows the number of times each line is executed.
by Line Count
@| Show Profile Shows how much time is spent executing a line.
by Time
Show Profile For line counts, shows the number of times the line is executed.
(=) . ! s ¢
by Count For time, shows the number of microseconds (or milliseconds

or seconds) the line takes to complete.

E' Show Profile For line counts, shows the individual line count divided by the
by Percent total line count. For time, shows the percentage of time spent
on an individual line (line time/total time*100).

:“5 = Time Units Sets the time unit to microseconds, milliseconds, or seconds.
Available in the JSL Profiler after you click the Run profiler
button = .
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Table 4.1 Description of the Debugger Buttons (Continued)
Button  Button Name Action

[Red Color Theme Sets the color of the shading for the JSL Profiler. Available in
the JSL Profiler after you click the Run profiler button [ .

Variable Lists

The tabs on the bottom left of the Debugger let you examine global variables, local variables,
watch variables, and variables within namespaces.

Globals The Globals tab lists all global variables and updates their values as you step
through the script. Each variable is added as it is initialized. If there are already global
variables defined from running earlier scripts, they will be listed with their current values
when you start the Debugger. See “View Variables”.

Locals The Locals tab lists all variables by scope and updates their values as you step
through the script. Select a scope in the menu. See “View Variables”.

Watch If there is a particular variable or value of an expression whose values you want to
watch as you step through the code, you can add them here. This is particularly useful if
your script uses many variables that might be difficult to watch in the Globals or Locals
lists. See “Work with Watches”.

Namespaces Asnamespaces are defined, they are added to the menu. Select a namespace to
view any variables and their values used within the namespace. See “View Variables”.

Classes The Classes tab lists classes that are defined in the script. See “Classes”.

Debugger Options

The tabs on the bottom right of the Debugger let you view the call stack, work with
breakpoints, set options, and view the log.

Call Stack The call stack lists the current execution point in scripts and functions. The main
script is always the first script listed. If you call a function, the function is added on top of
the calling script. Likewise, any included files are added to the top of the list as you step
through them. When you exit any function or script, it is removed from the list and you
return to the next one in the list. The current line numbers are updated as you step
through.

Double-click a row in the call stack to move the cursor to the specified line.

Breakpoints Add, edit, delete, and disable or enable breakpoints on lines. See “Work with
Breakpoints”. You can also double-click a row on the Breakpoints tab to move the cursor to
the specified line.
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Data Breakpoints Add, edit, delete, and disable or enable breakpoints in variables. Data
breakpoints watch for changes in variables, unlike breakpoints, which watch for changes
in lines.

Options Set the Debugger preferences interactively on this tab. See “Modify Preferences in
Debugger”.

Log The log from the script that you are debugging is shown on this tab.

Work with Breakpoints

A breakpoint interrupts the execution of a script. Although you can step through a script line by
line, this can be tedious and lengthy for a long or complex script. You can set breakpoints at
places of interest and simply run the script in the Debugger. The script is run normally until a
breakpoint is reached. At the breakpoint, the Debugger stops executing the script so that you
can look at the values of variables or start stepping line by line.

Breakpoints that appear on the Breakpoints tab in the lower right corner watch for changes in
a line. Breakpoints that appear on the Data Breakpoints tab watch for changes in variables.

JMP preserves breakpoints across sessions. So when you close and reopen JMP, the
breakpoints still appear.

Tip: Turn on line numbers by right-clicking in the script and selecting Show Line Numbers.
You can also show line numbers by default in all scripts by modifying the Script Editor
preferences.

Create a Breakpoint

When creating a breakpoint, you can specify settings such as conditions and break behavior.
To do so, click @| on the Breakpoints tab or Data Breakpoints tab, and then enter the
breakpoint information.

Otherwise, create a quick breakpoint by doing one of the following:

¢ In the Debugger margin, click the appropriate line (to the right of the line number if
displayed).

¢ In the Debugger margin, right-click in the margin where you want the breakpoint and
select Set Breakpoint.

The red breakpoint icon appears where you inserted the breakpoint and on the Breakpoints
tab.
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Delete Breakpoints

Do one of the following:

¢ In the Debugger margin, click the breakpoint icon.

¢ In the Debugger margin, right-click the breakpoint icon and select Clear Breakpoint.
* On the Breakpoints tab, select the breakpoint and then click E|

* On the Breakpoints tab, click g| to delete all breakpoints (not just the selected
breakpoints).

The red breakpoint icon is removed, and the breakpoint no longer appears on the Breakpoints
tab.

Disable and Enable Breakpoints

Disabling a breakpoint is helpful when you potentially fix a problem and then want to see
whether the script will run correctly past that breakpoint. You can then enable the breakpoint
when necessary rather than re-creating it.

Do one of the following:

¢ In the Debugger margin, right-click the breakpoint icon and select Enable Breakpoint or
Disable Breakpoint.

* On the Breakpoints tab, select or deselect the breakpoint’s check box.
* On the Breakpoints tab, click E| to disable or enable all breakpoints.

A disabled breakpoint turns white; enabled breakpoints are shaded red.

Specify and Clear Conditional Expressions on Breakpoints

Setting a condition on a breakpoint is an alternative to single-stepping through code. Rather
than single-step and view the variables for each expression, you specify that the script break
only when a condition is met. Then you can step through the code and figure out where the
problem arises.

Suppose that a calculation in your script is incorrect, and you suspect the problem occurs
when i==19. Set a conditional breakpoint for 1==18. The Debugger will run until that
condition is met, then you can step through the code to identify the problem.

Specify a Breakpoint Condition
Right-click the breakpoint icon and select Edit Breakpoint.

1
2. On the Condition tab, select Condition and enter the conditional expression.
3. Specify whether to break when the expression Is true or Has Changed.

4. Click OK.
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Disable or Enable a Condition

1. Right-click the breakpoint icon and select Edit Breakpoint.

2. On the Condition tab, deselect or select Condition.

Delete a Condition

On the Breakpoints tab, click in the breakpoint’s Condition field and press Delete.

Specify Break Options

Right-clicking the breakpoint and selecting Edit Breakpoint provides a quick way to manage
breakpoint behavior. Alternatively, select the breakpoint on the Breakpoints tab and click @|
Both methods display the Breakpoint Information window, where you customize settings on
the Hit Count and Action tabs.

Change the Hit Count

You can control the number of times a breakpoint must be hit and when the break occurs. For
example, to break when the condition is met twice, select break when the hit count is equal to
and type 2 on the Hit Count tab.

Define an Action

You also have the option of defining a JSL expression or script that the Debugger executes
when a breakpoint is hit and execution has stopped. This script is called an action. On the
Action tab, enter the JSL expression to be executed.

Run the Script to the Cursor

When you right-click and select Run To Cursor, all expressions before the location of the
cursor are executed. Select this option when you want to see values only up to the current line.
To see values when each expression is executed, use the stepping options.

Tips for Setting Breakpoints

e If you do not want to watch for errors in a specific loop, set a breakpoint after the loop
ends. The Debugger will hit the next breakpoint rather than stepping through each line of
the loop.

* Avoid inserting a breakpoint in lines that do not trigger an action (such as comments,
blank lines, and end parentheses). Debugger will not break on these lines.

* When you insert breakpoints, close Debugger, and edit the script, the breakpoints remain
on the original line numbers. You might need to delete and then reinsert the breakpoints.
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* Breakpoints are remembered across Debugger sessions. This means that your breakpoints
list includes breakpoints that have been set in all scripts, not just the script that you are
currently debugging.

* Breakpoints are remembered by the Debugger session, not by each script. This means that
breakpoints are listed even for scripts that have been moved or deleted.

* On the Breakpoints tab, click El to remove all breakpoints in scripts whether they are
currently open or not, or for scripts that no longer exist.

View Variables

The variables lists are populated as they appear in the script. Their values are updated every
time the script changes them. If you are uncertain why a variable has a particular value when
you run your script, you can watch its value at every step to see what happens.

You can also assign the variables whatever value you want. For example, if you are stepping
through a For () loop but are interested only in what happens starting with a particular
iteration, you can assign your iterating variable that value. Step through the first part of the
loop that initializes the iteration variable and then assign it the value that you want in the
variable list at the bottom. Then when you step through, the loop begins executing at that
point.

Tips for Managing Variables

e If you have run several scripts using the global scope, you might want to clear or delete
global variables. This makes the list of variables in the Debugger shorter and relevant. Use
the Delete Symbols() function to do so. You can also close JMP and restart to clear the
space.

e If your script uses so many variables that they are difficult to find and watch in the
variable lists, add watches for the specific variables in which you are interested.

e To view or edit long values on a tab in the Debugger, right-click the value and select Edit.
The code opens in a script editor.

Work with Watches

JMP preserves the Watch variables across sessions. So when you close and reopen JMP, the
Watch variables are still listed on the Watch tab.

Create a Watch
e On the Watch tab, click E| and enter the value in the window.
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* In the Debugger, right-click the line that you want to watch, select Add Watch, and then
enter the variable name in the window.

e In the Debugger, place the cursor in or next to a variable name (or select the variable
name), right-click, and select Add Watch.

® On the Watch tab, enter the variable in an empty Variable field.

Modify a Watch
Do one of the following on the Watch tab to enter a new value:

e Select the watch and click [&].

e (lick in the Variable field and enter a new value.

Delete Watches
Do one of the following on the Watch tab to delete watches:

* Select the watch and then click [X].
e (Click [i| to remove all watches.

Modify Preferences in Debugger

The Debugger lets you change preferences as you work in the Debugger. Select the Options
tab to find the following settings:

Show Line Numbers Shows or hides the line numbers for the script in the Debugger.

Break on Multiple Statements Per Line Stops executing the script between each expression
in a single line.

Break On Throw Breaks when the script executes the Throw() function. For example,
Throw() might be enclosed in a Try () expression. The Debugger breaks on Throw()
instead of continuing through the rest of the expression. This lets you identify where the
problem occurred in the script and then return to debugging.

Break On Execution Error Stops executing the script when the error occurs rather than
closing the Debugger.

Warn On Assignment In Condition Shows a warning when you enter a breakpoint condition
that contains the assignment. For example, if you have a breakpoint on x = 1 and add the
condition x = 1 to the breakpoint, you are prompted to verify the assignment of x.

Enter Debugger Upon Termination Keeps the Debugger open after a JSL program
terminates execution. On by default, this option lets you examine attributes of the
executed program.
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Break For Compatibility Warnings Breaks when a JSL compatibility issue is found.

Persistent Debugger Sessions

JMP saves all breakpoints and watches until you delete them. Other user-specific settings,

such as column widths on the tabs and the Debugger window size, persist between sessions of
JMP.

These settings are stored in a file named JMP.jdeb, the location of which is defined in the
USER_APPDATA variable:

e Windows 7 and higher: "/C:/Users/<username>/AppData/Roaming/SAS/JMP/16/"
¢  macOS: "/Users/<username>/Library/Application Support/JMP/16/"

As usual, the values of local variables, global variables, and namespaces clear when you close
and reopen JMP.

Note: On Windows, the paths differ based on the JMP edition. In JMP Pro, the path refers to
“JMPPro”.

Examples of Debugging and Profiling Scripts

This section includes examples of setting breakpoints to watch variables; stepping into, over,
and out of expressions; watching variables in different scopes and namespaces; debugging
interactive scripts; and profiling scripts with the JSL Profiler.

Example scripts are located in the JMP Samples/Scripts folder.

Tip: Make sure that Show Line Numbers is selected on the Debugger Options tab before
proceeding.

Using Breakpoints and Watching Global Variables

The following example shows how to set a breakpoint in a loop and watch variables change
through each iteration of the loop.

1. Open the string.jsl sample script and click the Debug Script button.
2. Click in the margin for line 12 to add a breakpoint.

You should have a breakpoint for the following expression inside the For () loop:

stringFunction(i);
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Figure 4.12 Set the Breakpoint

string.jsl

3
4 ®stringFunction = Function( {i}, {vl,

5 y = Char(i);

6 str = str || y;
7 );

8

9 str="";

18

11 For( i =9, i <=9, i++,
12 @ stringFunction(i);
13

)s
14
15 Print{ "Finished.", str );
3. Click Run.
The first two expressions are evaluated:
— stringFunctionis defined as a function.
— stris defined as an empty string.

Both variables and their types and values have been added to the Globals list. In addition,
the For() loop has been evaluated up to the line with the breakpoint, shown in
Figure 4.12.

— 1 has been assigned to 0.
— 1 and its value and type have been added to the Globals list.
— 1 has been determined to be less than or equal to 9.

— stringFunction() has not yet been called.

Figure 4.13 View the Initial Global Variables

Globals | Locals Watch = Namespaces | Classes

Variable Value Type
i 10 Mumber
sir "0123456780" String
stringFunct... |[Function( {i}, {y}, y = Char(i]}: str=str||y:) Function

Tip: The initial value of 1 is 10 because the script was run before entering the Debugger; it’s
showing the value of i after running the script (10). Start a new instance of JMP, open the
script without running it, and enter the Debugger immediately.

4. Click Run again.
The script runs until it hits the breakpoint. The results are shown in Figure 4.14.

- stringFunction() is called, evaluated, and returns to the loop.

— 1iisincremented and determined to be less than or equal to 9.
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— In the Globals list, i isnow 1 and str is now “0”.

Figure 4.14 Global Variables at First Breakpoint

Globals | Locals  Watch | Namespaces | Classes

Variable Value Type
i 1 Mumber
sir "g" String
stringFunct... |[Function( {i}, {y}, v = Char(i); str=str||yv: Function

5. Click Run again.

The script runs until it hits a breakpoint. The results are shown in Figure 4.15.
- stringFunction() is called, evaluated, and returns to the loop.
— i isincremented and determined to be less than or equal to 9.

In the Globals list, i is now 2, and str is now “01”.

Figure 4.15 Global Variables at Second Breakpoint

Globals | Locals  Watch | Namespaces | Classes

Variable Value Type
i 2 Mumber
sir "01" String
stringFunct... |Function({i}, {y}, v = Char(i]); str=str||y Function

You can continue to click Run and watch i and str change with each iteration of the loop. Or,

C

Steppin

lick Run without breakpoints to complete running the script and exit the Debugger.

d Into, Over, and Out

Step Into, Step Over, and Step Out offer flexibility when your script contains expressions,
functions, or includes other JSL files.

1.
2.

Open the scriptDriver.jsl sample script and click the Debug Script button.

This script writes information to the log, so select the Log tab at the bottom of the
Debugger to view the messages.

Click Step Over.
The first line in the script is evaluated.
Click Step Over again.

The current expression is evaluated, and the Debugger moves to the following line. In this
case, the expression is a few lines long, and it assigns an expression to a variable.

Click Step Over again.

This expression is several lines long, and assigns a function to a variable.
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10.

11.

Line 30 calls the expression that was created earlier.

Click Step Over.

The Debugger steps into the expression, running it line by line.
Continue clicking Step Over until the expression ends.

The Debugger returns to the line following the expression call.
Line 31 calls the function defined earlier.

Click Step Over to run the function without stepping into it. The Debugger runs the entire
function, and returns to the line following the function call.

Line 33 includes another script.

Click Step Into.

The Debugger opens the script in another tab and waits.
Click Step Over.

The next line in the included script is run.

Click Step Out.

The Debugger runs the rest of the included script and returns to the line following the
Include() function.

Watching Variables in Different Scopes and Namespaces

Tabs at the bottom of the Debugger window let you watch variables as they are created and
changed. This example shows variables in several scopes and a namespace.

1.
2.

Open the scoping.jsl sample script and click the Debug Script button.
Click Step Over.

The fourth line turns off Names Default To Here.If you run this script again in the same
JMP session, this line resets the scoping so that the first variable that is created is in the
global scope.

Click Step Over.

A global variable named X is created. On the Globals tab, x has been added to the list,
showing its value as 5 and its type as number.

Select the Locals tab, and then select Global from the list of scopes.
The global variable x is also shown here.
Click Step Over twice.

Names Default To Hereis turned on, which places the rest of the script into a Here
scope. Then a new variable X is created in that scope.

Notice that the value of the global variable x has not changed.
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6. Select Here from the list on the Locals tab.
The local x is listed under Here, with its value and type.

7. Click Step Over.
A Local Here scope is created. A second Here scope is shown in the Locals list.

8. C(lick Step Over.
A new X variable is created in this Here scope. On the Locals tab, select each of the three
scopes from the list (Here, Here, and Global) to see three different x variables.

9. C(lick Step Over.
Look in the Debugger’s log to see the output. Notice that here: x scopes to the local here,
not the script window’s here.

10. Click Step Over.
After writing an empty line to the log, the script exits the Local Here scope. The second
Here, along with its” x variable, has disappeared from the Locals list.

11. Click Step Over.
A namespace called “test” is created, with another variable named x. Select the
Namespaces tab to see it.

12. Click Step Over and look at the log.

13. Click Step Over to exit the Debugger.

Using the Debugger with Interactive Scripts

When your script creates interactive elements, the Debugger hands control back to the main
instance of JMP so that you can interact with it. When you are finished, control returns to the

Debugger.
1. Open the interactive.jsl sample script and click the Debug Script button.
2. Click Step Over twice.
The New Window expression is evaluated, and a modal window waiting for input is
created. You might need to move the Debugger window to see the new modal window.
3. Enter two numbers in the Assign X and Y window and click OK.
Control is given back to the Debugger.
4. Click Step Over three times and look at the log in the Debugger.
The log shows the two new numbers that you entered in the window.
5. Click Step Into to exit the Debugger.
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Using the JSL Profiler

Chapter 4
Scripting Guide

Use the JSL Profiler to see how much time is spent executing particular lines or how many

times a particular line is executed.

1. Open the string.jsl sample script.
2. Click the Debug Script button .
3. Click the Profile JSL Script button [ .

Figure 4.16 Initial JSL Profiler Window

EI el Time Units psec Color Theme p.4

string.sl

1 /* This secript was written to demonstrate using breakpoints and watching variables
2 in the 1SL Debugger. See the Scripting Guide for an example. */
3

4 stringFunction = Function( {i}, {y},

5 y = Char(i);

6 str = str || y;

7);

8

Ok —u it

1@

11For{ i =09, 1 <=9, i++,

12 stringFunction(i);

1305

14

15 Print( "Finished.", str );

16

4. Click the Run button [;3' to start profiling.

The profiler collects information about the number of times a statement is executed and
the time it takes to execute it. Time is cumulative and collected each time a JSL statement is

executed.

Figure 4.17 Profiled Script Window

string.jsl

3

4 [§30888% s tringFunction = Function( {i}, {v},
5 0.911% y = Char(i);

6 0.214% str = str || y;

7 )

8

9 0.854%str = "";

11 0.250%For( i = @, i <= 9, i++,
12 2.859% stringFunction(i);
13 )3

15 11.723% Print( "Finished.™, str );
16
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In the left margin, the selected statistics are displayed. Percent of time is displayed by default.
Click the Show Profile by Count button E| to switch to percent of statement counts instead.
The left margin is color-coded to allow for quick identification of problematic performance
areas.
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Chapter 5

JSL Building Blocks

Learning the Basics of JSL

Studying the syntax and basics of JSL is crucial, whether you are a beginning or an advanced
user. Some concepts (such as loops and variables) are common among many scripting
languages, but punctuation rules differ in JSL.

Figure 5.1 Example of a JSL Script

comment multiplication
operator concatenate
operator quoted text string

7 [/ Compute the areg of a fircle.
i 8 ius = 2:
variables radius = 2;
T circle area = Pi() * radfius * radius;
18 Print( "The arga is " || Format( circle area, "Fixed", 2 ) );
11
Commas separate  Semicolons separate

functions arguments. certain expressions.

This chapter introduces you to the basic concepts of JSL, from syntax rules and file path
conventions to conditions and namespaces.
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JSL Syntax Rules

All scripting and programming languages have their own syntax rules. JSL looks familiar if
you have programmed in languages such as C and Java. However, rules for punctuation and
spaces differ in JSL.

The following sections describe JSL syntax rules for the following basic components of the
language.

Value Separators

Words in JSL are separated by parentheses, commas, semicolons, spaces, and various
operators (such as +, —, and so on). This section describes the rules for using these separators
and delimiters in JSL.

Commas

A comma separates items, such as items in a list, rows in a matrix, or arguments to a function.

my list = {1, 2, 3};

your Tlist = List( 4, 5, 6) ;

my matrix [321, 0-1-2];

IfCY <20, X=Y);

Table Box( String Col Box( "Age", a ) );

Note: To glue a sequence of commands into a single argument inside a function, separate each
sequence with a semicolon. See “Semicolons”.

Parentheses

Parentheses have several purposes in JSL:

¢ Parentheses group operations in an expression. The following parentheses group the
operations in the If() expression.
y = 10;
If(
Y <20, X=Y,
X =20
);
® Parentheses delimit arguments to a function. In the following example, parentheses
enclose the argument to the Open() function.

Open( "$SAMPLE_DATA/Big Class.jmp" );



Chapter 5 JSL Building Blocks 101
Scripting Guide JSL Syntax Rules

® Parentheses also mark the end of a function name, even when arguments are not needed.
For example, the Pi function has no arguments. However, the parentheses are required so
that JMP can identify Pi as a function.

PiQ;
Note: Be careful that parentheses match. Every (needs a ), or errors result.

The script editor can match fences (parentheses, brackets, and braces). Press Ctrl+]
(Command+B on macOS) with your cursor in any part of a script. The editor searches for
fences, highlighting the text between the first set of opening and closing fences that it finds.
Repeat this process to highlight the next-higher fence. See “Match Parentheses, Brackets, and
Braces” for an example.

Semicolons

Expressions separated by a semicolon are evaluated in succession, returning the result of the
last expression. In the following code, 0 is assigned to the variable i and then 2 is assigned the

variable j.
i=0;
i=2

You can also use semicolons to join arguments that are separated by commas as shown in the
following If () expression.

If( x <5,y =3; z++; );

The semicolon in other languages is used as an expression terminator character. In JSL, the
semicolon is a signal to continue because more commands might follow. For more information
about separating expressions with semicolons, see “Alternatives for Gluing Expressions
Together”.

Semicolons at the end of a script or at the end of a line of arguments are harmless, so you can
also think of semicolons as terminating characters. Trailing semicolons are allowed at the end
of a script stream and after a closing parenthesis or closing curly brace. In fact, terminating
each complete JSL expression with a semicolon helps avoid errors when you copy and paste
small scripts into a larger one.

The semicolon is equivalent to the Glue () function. See “Operators” for more information
about semicolons and Glue().

Double Quotes

Double quotes enclose text strings. Anything inside double quotes is taken literally, including
spaces and upper- or lower-case; nothing is evaluated. If you have "Pi() A 2" (inside double
quotes), it is just a sequence of characters, not a value close to ten.
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You do have to be a careful with text strings. Extra spaces and punctuation do affect the
output, because text strings inside double quotes are used literally, exactly as you enter them.

To have double quotes inside a quoted string, precede each quotation mark with the escape
sequence \! (backslash-bang). For example, run the following script and look at the title of the
window:

New Window( "\!"Hello\!" is a quoted string.",
Text Box( Char( Repeat( "*", 70 ) ) )
s

Table 5.1 Escape Sequences for Quoted Strings

\!b  blank

\!t  tab

\!r  carriage return only
\!n linefeed (newline) only

\!N inserts line breaking characters appropriate for the host
environment?

\!f  formfeed (page break)
\!0  null character

Note: The null character is dangerous to use, because it is
typically treated as the end of the string. Be sure to type the
number zero, not the letter O.

\!\ backslash
\!"  double quotation mark

a. On macQOS, this escape sequence is CR (carriage return character,
hexadecimal ‘0D’). On Windows, this sequence is CR LF (carriage
return followed by a linefeed, hexadecimal ‘OD0A").

Sometimes, long passages require a lot of escaped characters. In these cases, use the notation
\[...]\ and everything between the brackets does not need or support escape sequences.
Here is an example where \[...]\ is used inside a double-quoted string.

js1Phrase = "The JSL to do this is :\[

a = "hello";
b =all " world.";
Show(b) ;

]\ and you use the Submit command to run it.";
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Spaces

JSL allows whitespace characters inside names; spaces, tabs, returns, and blank lines inside or
between JSL words are ignored. This is because most JSL words come from the user interface,
and most of those commands have spaces in them. For example, the JSL expression for the Fit
Model platform is Fit Model() or FitModel().

Spaces inside an operator or between digits in a single number are not allowed. In these cases,
the script generates errors. For example, you cannot put spaces between the two plus signs in
i++ (i+ +) orinnumbers (4 3 is not the same as 43).

Note: Why does JSL allow whitespace characters inside names? For one reason, the names of
commands and options match the equivalent commands in JMP menus and windows.
Another reason is that data table column names often include spaces.

Numbers

Numbers can be written as integers, decimal numbers, dates, times, or date-time values. They
can also be included in scientific notations with an E preceding the power of ten. For example,
these are all numbers:

1 12 1.234 3E3 0.314159265E+1 1E-20 01JAN98

Note: A single period by itself is considered a missing numeric value (sometimes called NaN
for “not a number”).

For more information about dates, times, and date-time values, see “Date-Time Functions and
Formats”. See “Currency” for more information about combining numbers with currency
symbols.

Names

A name is simply something to call an item. When you assign the numeric value 3 to a variable
in the expression a = 3, ais a name.

Commands and functions have names, too. In the expression Log( 4 ), Logis the name of the
logarithmic function.

Names have a few rules:

¢ Names must start with an alphabetic character or underscore and can continue with the
following:

— alphabetic characters (a-z A-Z)

— numeric digits (0-9)
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— whitespace characters (spaces, tabs, line endings, and page endings)
— mathematical symbols in Unicode (such as the Greek small alpha letter cx)

— afew punctuation marks or special characters (apostrophes (*), percent signs (%),
periods (.), backslashes (\), and underscores (_))

*  When comparing names, JMP ignores whitespace characters (such as spaces, tabs, and line
endings). Upper case and lower case characters are not distinguished. For example, the
names Forage and for age are equivalent, despite the differences in white space and
case.

You can still have a name that is any other sequence of characters. If the name does not follow
the rules above, it needs to be quoted and followed by "n".For example, to use a global
variable with the name taxable income(2011), you must use "taxable income(2011)"n
every time the variable appears in a script:

"taxable income( 2011 )"n = 456000;

tax = .25;

Print( tax * "taxable income( 2011 )"n) ;
114000

Note: Previously, the Name () parser directive wrapped the column name that contained
illegal characters. Name () is deprecated.

For more information about how JMP interprets names, see “Rules for Name Resolution”.

Comments

Comments are notes in the code that are ignored by the JSL processor (or parser). You include
comments to describe sections of the script. Comments are also convenient for removing
portions of a script temporarily. For example, you can insert comment symbols around code
that might be causing an error and then rerun the script.

Type the comment symbols around code that you want to comment. The following example
shows code commented with /* */ in the middle of a line. When the script is run, JMP
considers both expressions to be identical.

tax /*percentage*/ = .25;
tax = .25;
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Table 5.2 describes the comment symbols.

Table 5.2 Comment Symbols

Symbol Syntax Explanation

// // comment Begins a comment. The comment does not have to be at the
beginning of a line, but everything up to the end of the line is
a comment.

/* /* comment */  Begins and ends a comment. This comment can appear in the

middle of a line. Script text before and after the comment is
parsed normally.

/7! /7! Add //! to the first line of the script, and the script runs
automatically when opened in JMP. (In other words, the
script editor does not open.)

Operators

An operator is a one- or two-character symbol used to perform common arithmetic actions,
compare values, construct lists, subscript into a data element, send messages, concatenate
lists, scope names, glue expressions, and end expressions.

Arithmetic operators come in several varieties:

* infix (with arguments on either side, suchas+in 3 + 4,or=ina = 7)

e prefix (with one argument on its right side, such as !a for logical negation)

® or postfix (with one argument on its left side, such as a++ for incrementing a

To make writing expressions easier, JSL uses certain special character operators that are
alternatives to using functions. These operators have the same meaning as if the phrase had
been written as a function. For example, the following two expressions are equivalent.

Net Income After Taxes = Net Income - Taxes;
Assign( Net Income After Taxes, Subtract( Net Income, Taxes ) );

The assignment operation can be written either as the Assign() function or as an infix
operator =. Similarly, subtraction can be done with the Subtract () function or the infix minus
sign; they are equivalent inside JMP.



106

JSL Building Blocks Chapter 5
Operators Scripting Guide

Note: Usually white space is ignored in JSL, so that “netincomeaftertaxes” and “net income
after taxes” are the same thing. There is one exception: the two-character operators must not
have a space between characters. Always enter the following operators without spaces in
between:

o

[, 1/, <=, >=, I=, ==, 4=, -=, *=, /=, ++, --, <<, 11, %, 1/, /%, */

Another common operator is the semicolon ( ; ). You use the semicolon to:

* Separate yet join one expression to another in a programming sequence. The semicolon
returns the result of its last argument, so a;b is the same as Glue(a,b).

¢ End an expression. Though the semicolon is permitted at the end of an expression, it is not
the expression terminator used in other languages.

An expression can contain more than one operator. In these instances, the operators are
grouped in order of precedence with decreasing priority. For example, * takes precedence
over +:

a+b*c
Sob * cisevaluated first, and then the result is added to a.
+ takes precedence over -:

a+b*c-d

Sob * cisevaluated, and then the result is added to a. d is then subtracted from the result of
a+b*c

Table 5.3 shows operators shaded in order of precedence and each operator’s function
equivalent.

Table 5.3 Operators and Their Function Equivalents in Order of Precedence

Operator Function Syntax Explanation

{1 List {a, b} Construct a list.
List(a, b)

[1] Subscript arb, cl Subscripts identify specific
Subscript(a, b, ©) elements within a data element a,

where a could be a list, a matrix, a
data column, a platform object, a
display box, and so on.
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Table 5.3 Operators and Their Function Equivalents in Order of Precedence (Continued)

Operator

++

Post
Increment

Post
Decrement

Power

Minus

Not

Multiply

EMult

Divide

EDiv

Function Syntax

a++
Post Increment(a)

a__
Post Decrement(a)

arb
Power(a, b)
Power (X)

-a
Minus(a)

la
Not(a)

a*b
Multiply(a, b)

a:*b
EMult(a, b)

a/b
Divide(a, b)
Divide(X)

a:/b
EDiv(a, b)

Explanation
Adds one (1) to &, in place.

JMP does not have a pre-increment
operator. Instead, use the Add To()
operator, which is (+=).

Subtracts one (1) from 4, in place.

JMP does not have a pre-decrement
operator. Instead, use the Subtract
To () operator, which is (-=).

Raise a to exponent power b. With
only one argument, 2 is assumed as
the power, so Power (Xx) computes

Reverses sign of a.

Logical Not. Maps nonzero (or
true) values to 0 (which means
false). Maps O (or false) values to 1
(which means true).

Multiplies a by b.

Elementwise multiplication for
matrices a and b. (Each element in
matrix ais multiplied by each
element in matrix b.)

Divide(a, b) divides aby b.

Divide(x) interprets the argument
as a denominator and implies 1 as
the numerator, yielding the
reciprocal 1/x.

Elementwise division for matrices
aand b. (Each element in matrix a
is divided by each element in
matrix b.)
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Table 5.3 Operators and Their Function Equivalents in Order of Precedence (Continued)

Operator

+

<<

Add

Subtract

Concat

VConcat

Index

Send

Equal

Not Equal

Less

Less or Equal

Greater

Greater or
Equal

Function Syntax

a+b

Add(a, b)

a-b
Subtract(a, b)

allb
Concat(a, b)

matrixl|/matrix2
VConcat(matrixl,
matrix2)

a::b
Index(a, b)

object << message

Send(object, message)

a=b
Equal(a,b)...

al'=b
Not Equal(a,b)...

a<b
Less(a,b)...

a<=b
Less or Equal(a,b)

ab
Greater(a, b)

a>=b

Greater or Equal(a,b)

Explanation

Adds aand b.
Subtracts b from a.

Joins two or more strings; two or
more lists; and horizontally
concatenates matrices. See
“Concatenate Lists” or the JSL
Syntax Reference.

Vertically concatenate matrices.
(Use | | or Concat() to
horizontally concatenate matrices.)

For matrices, generates the integers
from ato b.

(Colons are also used as prefix
operators for scoping, where :a
means data table column a, and : :a
means JSL global variable a. See
“Scoping Operators”.)

Send message to object.

Boolean values for comparisons.
They all return 1 if true, 0 if false.
Missing values in either a or b
causes a return value of missing,
which evaluates as neither true nor
false. See “Missing Values”, for
treatment of missing values.
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Table 5.3 Operators and Their Function Equivalents in Order of Precedence (Continued)

Operator

<=, <

<, <=

Less Equal
Less

Less Less
Equal

And

Or

Assign

Add To

Subtract To

Multiply To

Divide To

Glue

Function Syntax

a<=b<c

Less Equal Less(a,b, ©)

a<b<=c

Less Less Equal(a,b, ©

agb
And(a, b)

alb
or(a,b)

a=b
Assign(a, b)

a+=b
AddTo(a, b)

a-=b
SubtractTo(a, b)

a*=b
MultiplyTo(a, b)

a/=b
DivideTo(a, b)

a;b

Glue(expr, expr,

Explanation

Range check. Return 1 if true, 0 if
false. Missing values in either aor b
propagate missing values.

Logical And. Returns true if both
are true. If the value on the left is
false, the value on the right is not
evaluated. See “Missing Values”,
for treatment of missing values.

Logical Or. Returns true if either or
both are true. See “Missing Values”,
for treatment of missing values.

Put the value of binto a. Replaces
the current value of a.

Add the value of binto a.

Subtract b from @, and put back
into a.

Multiply b with a, and put back
into a.

Divide binto &, and put back into
4.

First do a, and then do b.

Boolean Values

A Boolean value enables or disables an option. To enable the option, use 1, true, or yes as the

argument.

obj << Unequal Variances( 1 );
obj << Unequal Variances( "true" );
obj << Unequal Variances( "yes" );
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Note: Quoting the value prevents it from being evaluated as a variable.

Omitting the argument also enables the option. This is the default for all but row state
messages.

obj << Unequal Variances;
obj << Unequal Variances(Q);

To disable the option, use 0, false, or no as the argument.
To toggle an option (turn off an enabled option or turn on a disabled option), use "toggle".

Notes:

e The quoted "present", "absent”, "on", "off", "switch", and "f1ip" are supported for
backwards compatibility.

e For row state messages, an empty argument always toggles the option.

Global and Local Variables

Variables are names that hold values, which you reference later in scripts. There are two types
of variables:

®  Global variables are shared among all scripts that you run in a JMP session.

®  Local variables apply only to the script context in which you define them. They can also be
local to only a piece of a script, as with variables local to a particular function.

To limit the scope of variables, you can define them in a namespace, which is a collection of
variables, functions, and other unique names. JMP has a single global variable namespace that
all scripts use by default. When you use a name plainly, without a qualifying syntax, the name
is an unscoped variable and therefore in the global namespace.

x =1;

Local Namespaces

Putting variables in the global namespace can cause conflicts. When two scripts have variables
with the same names, the value of the variable in the last script that you run last overwrites the
variable’s value in the first script.

To prevent this problem, we recommend that you begin each script with the following line:

Names Default To Here( 1 );
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The Names Default To Here( 1 ); function makes all unscoped variables in the script local
to that script and does not affect the global variable namespace. See “Advanced Scoping and
Namespaces”.

Notes:

e The Names Default to Here setting is true by default for custom menus and toolbar
buttons. A script that runs when you select a custom menu item or click a custom toolbar
button does not affect global variables.

e The Names Default to Here setting is false by default for table scripts. If a table script
specifies Names Default to Here(1), this setting lasts only as long as the table script
runs. After the script finishes running, the setting is reset to whatever it was before the
script ran.

Named Namespaces

You can also create a variable in a specific namespace. In the following example, the x variable
is created in the aa namespace:

aa:x = 1;

Preceding local variables with the Local () function is another option. Both a and b are local
variables in the following expression:

Local( fa =1, b}, ... );

Scoping operators also distinguish a global variable from a local variable. See “Rules for Name
Resolution”.

The following sections describe functions that help you manage variables.

Show Symbols, Clear Symbols, and Delete Symbols

The Show Symbol1s() function lists all variables and namespaces that are defined both
globally and in the local script, along with their current values. Here is an example of Show
Symbo1s () messages that are shown in the log:

Show Symbols(Q);
// Her
a 5;
b =6;

// 2 Here

// Global
c = 10;
// 1 Global
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Tip: The JSL debugger also shows you the values of variables and namespaces. See “Debug or
Profile Scripts”.

The Clear Symbols() function erases the values set for variables that are defined both
globally and in the local script. For example, after you clear and then show symbols, the
variables are empty.

Clear SymbolsQ);
Show Symbol1s();

// Here

a Empty;

b = Empty;
// 2 Here

// Global
c = Empty;
// 1 Global

Note: The older Show Globals() and Clear Globals() functions are aliases of the newer
Show Symbols() and Clear Symbols() functions.

To remove all global variables and namespaces, use the function Delete Symbols(). After the
last Show Symbols() in the following script is run, nothing shows up in the log. All variables
have been completely removed from memory.

Delete Symbols(Q);
Show Symbols();

To list variables in all namespaces, use Show Namespaces (). To delete only a specific
namespace, use ns << Delete. Clear Symbols() and Delete Symbols() do not clear or
delete variables in each namespace, although they do clear and delete variables that contain
references to namespaces. See “Rules for Name Resolution” for more information about
unscoped variables.

Note: Clear Symbols() and Delete Symbols() break all scripts that are currently in use.
These functions can be very useful in a programming and debugging environment, but do not
include them in any script that you plan to distribute. If you include Names Default To
Here(1) in your scripts, clearing and deleting global symbols is unnecessary.

Lock and Unlock Symbols

If you want to lock a variable to prevent it from being changed, use the Lock Symbols()
function. (Lock Globals() is an alias.)

Lock Symbols( namel, name2, ... );
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To release the lock and enable the global to be changed, use the UnTock Symbols() function.
(Unlock Globals() is an alias.)

Unlock Symbols( namel, name2, ... );

The primary use of these two commands is to prevent inadvertent changes to variables. For
example, locking a variable prevents Clear Symbols() from clearing a variable that is being
used by another script.

Note: You cannot use Lock Symbols() to lock a namespace. Instead, use ns <<Lock
Namespace.

Hide a Global Variable

To hide (or protect) a global variable, put two underscores (__) before the name. Protecting a
global variable means that it will be hidden and can not be examined or shown. However, the
behavior is different depending upon the context.

This example will not print the variable because it is protected:
Show(::__xyz);

This example returns a NULL value for the protected variable:
::a = Name Expr( ::_xyz );

This example does return a value for the protected variable:

Show( Eval( ::_xyz ) );

Rules for Name Resolution

In JMP, you identify the following types of objects by a name:

e Columns and table variables in a data table

¢ Global variables, which hold values for the remainder of a JMP session
® Scriptable object types

* Arguments and local variables inside formulas

Most of the time, you can just use an object’s name directly to refer to the object. Consider the
following example:

ratio = height / weight;
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Depending on the complexity of your script, it might be obvious that ratio is a variable and
height and weight are data table column names. But what if the meanings are ambiguous? A
script might use ratio as a global variable and as column names.

Variable Names Used as Arguments

Message arguments are evaluated as a rule. In previous versions of JMP, some messages
interpreted a variable name as a string value. For example, the following script results in a
linear scale in the current version of JMP and a log scale in JMP 11.

Log = "Linear";
axis box << Scale( Log );

The syntax Scale( "Log" ) is preferred for setting a string literal. To catch ambiguous
instances, set the “Allow Unquoted Strings in JSL” General preference to “Yes (with a
warning)” or “No”.

Rules for Resolving Names

JMP interprets object names using name resolution. The following rules are applied
sequentially to unscoped names:

1. If the variable is followed by a pair of parentheses ( ), look it up as a function.

2. If the variable is prefixed by : scope operator or an explicit data table reference, look it up
as a data table column or table variable.

If the variable is prefixed by :: scope operator, look it up as a global variable.

4. If the variable is an explicit scope reference (such as group:vowel), look it up in the
user-defined group namespace.

5. If the variable is in a Local or Parameter function, look it up as a local variable. If it is
nested, repeat until a function call boundary is found.

6. If the variable is in a user-defined function or method, look it up as a function or method
argument or local variable.

7. Look the variable up in the current scope and its parent scope. Repeat until the Here scope
is encountered.

Look the variable up as a variable in the Here scope.
Look the variable up as a global variable.
10. If Names Default to Here(1l) is at the top of the script, stop looking. The scope is local.

11. Look the variable up as a data table column or table variable. Columns are preferred over
table variables.
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12.

13.

Look the variable up as an operator or a platform launch name (for example, Distribution,
Bivariate, Chart, and so on).

When the name cannot be found:

— If the name is used in a reference, print and error to the log.

— If the name is used as the target of an assignment (as an L-value), test the following:
If the variable is preceded by : : scope operator, create and use a global variable.

If the variable is an explicit scope reference, create and use the variable in the specified
namespace Or scope.

If Names Default to Here(0) is at the top of the script, create a global variable.

If Names Default to Here(l) is at the top of the script, create a Here namespace
variable.

Exceptions

Some names are variables that refer to an object such as a data table, data column, or
platform; they are not used for getting or setting a value. These names are passed through
(or interpreted literally) rather than resolved.

For function definitions, column formulas, and Nonlinear platform formulas, the scope is
the same for each row in a column.

If a name is a direct reference to a column in a data table that has been closed, the name is
resolved again to that column when the table is reopened.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

Show( :weight << Get As Matrix ); // weight resolves to a column name
Close( dt, NoSave );

Show( :weight << Get As Matrix ); // weight cannot be resolved

dt = Open( "$SAMPLE_DATA/Big Class.jmp" ); // reopen data table

Show( :weight << Get As Matrix ); // weight resolves to a column name

However, the following example does not resolve the variable to the second instance of the
data table:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

col = Column( dt, 5); // col is Column( "weight" );

Close( dt, NoSave );

dt = Open( "$SAMPLE_DATA/Big Class.jmp" ); // reopen data table

Show( col << Get As Matrix ); // the reference to the first data table no
longer exists

The following sections describe how JMP resolves the names of data table columns. For more
information about name resolution, see “Advanced Scoping and Namespaces”.
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Scoping Operators
Using scoping operators is an easy way to help JMP resolve ambiguous names (for example,
when a name refers to both a variable and a column name).

In the following example, the prefix double-colon operator (: :) identifies z as a global
variable. The single-colon prefix operator (:) identifies x and y as column names.

iZ = X+ Y,

Tip: The Names Default to Here(l) function also affects name resolution. See “Names
Default To Here and Global Variables”.

Two JSL functions are interchangeable with scoping operators. Table 5.4 describes the
functions and syntax.

Table 5.4 Scoping Operators

Operator and Function Syntax  Explanation
Equivalent Function

As Column :name Forces name to be evaluated as a data table
dt:name column. The optional data table reference
As Column(dt, argument, dt, sets the current data table. See
name) ug ”
coped Column Names” for examples.
As Global : tname Forces name to be evaluated as a global variable.

As Global(name)
Note: The double-colon is also used as an infix

operator to represent ranges.

Scoped Column Names

Scoping column names is the simplest way to prevent conflicts with variable names. Use
scoping operators to force names in a script to refer to columns.

1. The prefix colon (:) means that the name refers to a table column or table variable only,
never a global variable. The prefix colon refers to the current data table context.
:age;

2. The infix colon (:) operator extends this notion by using a data table reference to specify

which data table has the column. This is particularly important when multiple data tables
are referenced in a script.

In the following example, the dt variable sets the data table reference to Big Class.jmp.
The infix colon separates the data table reference and age column.
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dt = Data Table( "Big Class.jmp" );
dt:age // The colon is an infix operator.

As Column() achieves the same results:
dt = Data Table( "Big Class.jmp" );
As Column( dt, age );

Therefore, the following expressions are equivalent when only Big Class.jmp is open:

:age;
As Column( dt, age );
dt:age;

The Column function can also identify a column. For Big Class.jmp, the following expressions
all refer to age, the second column in the table:

Column( "age" );
Column( 2 );
Column( dt, 2 );
Column( dt, "age" );

Prevent Column Name and Variable Name Conflicts
To avoid conflicts, use unique column and variable names or scope the names.

* When a global variable and a column have the same name, the global variable name takes
precedence. In this situation, you must scope the column name.

::age = [1;
age = :age << Get As Matrix;

* To avoid ambiguity between the global variable and column name, scope both variables.
1:age = :age << Get As Matrix;

e If more than one data table might be open, assign data table references to variables. Scope
your columns to the appropriate table.
dtl = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt2 = Open( "$SAMPLE_DATA/Students.jmp" );

::age = dtl:age << Get As Matrix;
::height = dt2:height << Get As Matrix;

Note that JMP evaluates column formulas through each consecutive cell of the column, so
scoping the column name is usually unnecessary. However, if a variable assigned in a formula
has the same name as a column, you must scope the column name. See “Scoped Names”.

Tip: The Names Default to Here(l) function also affects name resolution. See “Names
Default To Here and Global Variables”.



118 JSL Building Blocks Chapter 5
Rules for Name Resolution Scripting Guide

Unscoped Column Names

Sometimes an unscoped name gets or sets a value. JMP resolves it as a column in a data table
(rather than a global variable) under these circumstances:

e if no global variable, local variable, or an argument using that name already exists,
e and the data table in context has a column of that name,
* and

— either the current row is set to a positive value

— or the name is subscripted (for example, the subscript [1] in weight[1] selects the first
value in the weight column).

Exception

In column formulas and Nonlinear formulas, column names take precedence over global
variables.

Set the Current Data Table Row

By default, the current row is 0, an illegal row number. So the following expression assigns a
missing value to the ratio global variable:

ratio = height / weight;

Specify the row number with the Row() function. In the following example, the row is set to 3.
The height in that row is divided by the weight, and the result is assigned to the ratio global

variable.
Row() = 3;
ratio = height / weight;

Another possibility is to use subscripts to specify the row number. The following expression
divides the height in row 3 by the weight in row 4.

ratio = height[3] / weight[4];

Specifying the row number is unnecessary when the script iterates a row at a time down the
whole column. The following example creates the ratio column. For each row, the height is
divided by the weight.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "ratio" );
For Each Row( :ratio = height / weight );

JMP evaluates formulas and calculates pre-evaluated statistics iteratively down a column. In
these instances, identifying the row number is also unnecessary. (Pre-evaluated statistics are
single numbers computed from the data table, as discussed in “Pre-Evaluated Statistics”.)
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Name Resolution in Automatically Run Scripts

In an Open () function, you can specify that the script run automatically when it’s opened.
Open( "$MY_SCRIPTS/A.js1", Run ISL( 1) );
Open( "$MY_SCRIPTS/B.js1", Run ISL( 1) );

You can also type //! on the first line of the script to run the script automatically.

In these instances, the only shared names between A.js1 and B. js1 are globals and
namespaces (not here and not local).

To apply the names in A.js1 to B. js1, include B. js1in A.js1 instead of opening and
running both scripts.

Include( "$MY_SCRIPTS/B.js1" );

Troubleshoot Variables and Column Names

When you reference a column name using As Name(), and Names Default To Here( 1 )is
set, JMP returns a variable reference. That reference is then processed using the standard
reference rules.

In the following example, there is no height variable in the Here: scope, so JMP returns an
error.

Names Default To Here( 1 );

Open( "$SAMPLE_DATA/Big Class.jmp" );

As Name( "height" )[3]; // converts height to a variable reference
As Name( "height" )[/*###*/3];

The /*###*/ characters in the log indicate the location of an error in the script execution.
To prevent this problem, use one of the following methods:

e Use As Column() instead of As Name():

Names Default To Here( 1 );
Open( "$SAMPLE_DATA/Big Class.jmp" );
As Column( "height" )[3]; // converts height to a data column reference

* Explicitly scope height with As Name() :

Names Default To Here( 1 );
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt:( As Name( "height" ) )[3]; // scopes height as a data column reference

These scripts return 55, the value of height in the third row of Big Class.jmp.
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Troubleshoot Variables and Keywords

Name resolution errors can also occur when a variable and unquoted keyword have the same
name. For example, one argument for <<Preselect Role() is “Y”. Quote this argument if
your script also uses Y as a variable.

Frequently Asked Questions about Name Resolution

Should you always scope?

Yes. When in doubt, scope. Scoping is especially important in scripts that might be used by
many people on a variety of data tables; you will not necessarily know whether a name is used
in two contexts (such as for both a global variable and column name).

If you are writing such scripts, consider using explicit scoping and namespaces. See
“Advanced Scoping and Namespaces”.

Prefix scope operators do not take run-time overhead after the first resolution. Infix scope
operators, which follow data table references, always take run-time overhead.

What is the difference between a column reference and a column referred to by
name? If I have a column reference in a global variable, how do I assign a value to
a cell in the column?

With a column reference, you can send messages to change specific characteristics of the
column or to access its values (for example, coloring cells or setting a formula).

When a column has been assigned to a global variable, assign a value to a cell in the column
using a subscript. Suppose that the name of the column height has been assigned to the x
variable:

x = Column( "height" );
Assign a value to the third row in the height column:

x[3] = 64 // sets the third row of height to 64
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Note: The current row in a JSL script is not determined by selecting rows or positioning your
cursor in the row. The current row is defined to be zero (no row) by default. You can set a
current row with Row() (for example, Row() = 3). Please note that such a setting only lasts for
the duration of that script. Then, Row() reverts to its default value, zero. This behavior means
that submitting a script all at once can produce different results than submitting a script a few
lines at a time.

Another way to establish a current row for a script is to enclose it in For Each Row(). This
method executes the script once for each row of the current data table. For an example, see
“It”. See “Data Tables” for more information about working with data tables.

Which Has Precedence When Scoping, ":" or "[ ]"?
Scoping occurs before subscripting. This means that these two lines of code are equal:

dataTable:colName[i]
(dataTable:colName) [1i]

Alternatives for Gluing Expressions Together

You can separate expressions with a semicolon, either on the same line or on different lines.
JMP then evaluates each expressions in succession, returning the result of the last one. Here is
an expression that first sets a to 2 and then sets b to 3:

a=2;
b =3;

The semicolon joins the two expressions and returns the value of the last one. Soif x = (a =
2; b = 3), the value of xis 3.

The Glue ) function returns the result of the last expression. This function is equivalent to
using semicolons. The following expressions both return 3:

GlueCa =2, b=3);
a=2;b=3;

The First() function also evaluates each argument sequentially but returns the result of the
first expression. The following expression returns 2:

FirstCa =2, b = 3);

Example
What does First() do in the following script?
x = 1000;
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First( x, x = 2000 );

The First() function returns the value of x (1000). 2000 is then assigned to x.

Iterate

For

JSL provides the For (), While(), Summation(), and Product() functions to repeat (or iterate)
actions according to the conditions that you specify.

Note: A similar function called For Each Row() is for iterating actions over rows of a data
table. See “If” for an example. “Additional Ways to Access Data Values” also describes
iterating through table rows.

e “For”

e  “While”

e  “Summation”
e  “Product”

e “Break and Continue”

The For () function expects four arguments separated by commas. The first three arguments
are rules for how many times to repeat the loop, and the fourth is what to do each time the
loop is executed.

Here is the basic syntax for For():
For( initialization, while, iteration, body );
For example, the following script sums the numbers from 0 to 20:

s = 0;
For( i =0, i <= 20, i++, s +=1 );

The script works like this:

s =0; Sets the s variable to 0. This variable holds the sum.
For( Begins the For () loop.
i=0, Sets the initialization variable (i) to 0. This expression is performed

only once.
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i <= 20, Each time the loop begins, compares 1 to 20. As long as 1 is less than
or equal to 20, continue evaluating the loop. If i is greater than 20,
immediately break out of the loop.

i+, At the end of the loop, increments i by 1. Note that this step is done
after the body of the loop (next line) is evaluated.

s +=1 Evaluates the body of the loop. Adds the value of 1 to s. After the
body is finished, 7 is incremented (previous line).

)3 Ends the loop.

Infinite Loops

For loops that always evaluate as true create an infinite loop, which never stops. To stop the
script, press Esc on Windows (or Command+period on macOS). You can also select Edit >
Stop Script. On macOS, Edit > Stop Script is available only when the script is running.

Comparing For Loops in JSL to C and C++

The JSL For () loop works just like it does in the C (and C++) programming language,
although the punctuation is different.

Tip: If you know C, watch out for the difference between JSL and C in the use of semicolons
and commas. In JSL, For() is a function where commas separate arguments and semicolons
join expressions. In C, for is a special clause where semicolons separate arguments and
commas join them.

While

A related function is While(), which repeatedly tests the condition and evaluates its body
script as long as the condition is true. The syntax is:

While( condition, body );

For example, here are two different programs that use a While() loop to find the least power
of 2 that is greater than or equal to x (287). The result of both programs is 512.

X = 287;
// loop 1:
y =1;

WhileCy < x, y *= 2 );
Show( y );
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// loop 2:

k = 0;

WhiTe( 2 A k < x, k++ );
Show( 2 A k );

The scripts work like this:

X = 287; Sets x to 287.
// loop 1
y =1; Setsy to 1.
While( Begins the WhiTe() loop.
y <X, As long as y is less than x, continues evaluating the
loop.
y *=2 Multiplies 1 by 2 and then assigns the result to y. The
loop then repeats while y is less than 287.
)3 Ends the loop.
Show(y); Shows the value of y (512).
// Tloop 2
k = 0; Sets k to 0.
While( Begins the While() loop.
2 Ak <x, Raises 2 to the exponent power of k and continues
evaluating the loop as long as the result is less than 287.
k++ Increments k to 1. The loop then repeats while 2 A k is
less than 287.
); Ends the loop.
Show(2 A k); Shows the value of 2 A k (512).

As with For () loops, While() loops that always evaluate as true create an infinite loop, which
never stops. To stop the script, press Esc on Windows (or Command-period on macOS). You
can also select Edit > Stop Script. On macOS, Edit > Stop Script is available only when the
script is running.
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Summation

The Summation() function adds the body results over all i values. The syntax is:
Summation( initialization, Timitvalue, body );

For example:
s = Summation( i = 1, 10, i );

returns 55, the result of 1+2+3+4+5+6+7+8+9+10.

The script works like this:

s = Sets the s variable to the value of the function.
Summation( Begins the Summation() loop.

i=1, Sets i to 1.

10, Sets the limit of i to 10.

i All values of i from 1 to 10 are added together,

resulting in 55.

)3 Ends the loop.

This behavior is similar to £ in the Formula Editor. The following expression:
Summation( i = 1, N Row(), x A 2 );

is equivalent to the following formula in the Formula Editor:

NRow _»
Zi-1 ¥

Product
The Product () function is similar to Summation() except that it multiplies the body results
rather than adding them. The syntax is the same as for Summation(). For example:
p = Product( i =1, 5, 1 );
returns 120, the result of 1¥2*3%4*5,

In this example, the initial value of 1 is 1, the upper limit is 5, then all integer values of i up to
5 are multiplied.

Here is the equivalent in the Formula Editor:
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Break and Continue

The Break() and Continue() functions give you more control over looping. Break O
immediately stops the loop and proceeds to the next expression that follows the loop.
Continue() is a gentler form of Break (). It immediately stops the current iteration of the loop
and continues with the next iteration of the loop.

Break

Break() is typically used inside a conditional expression. For example:

ForCi =1, i <=5, i++,
IfC i == 3, Break(Q );

Print(C "i=" || Char(C i ) J;
s
results in:
"7':1"
"7'=2”

The script works like this:

For( Begins the For () loop.
i=1, Sets i to 1.
i<=5, Aslong as 1 is less than or equal to 5, continues

evaluating the loop.

i++, Increments 1 by 1. Note that this step is done after the
If loop is evaluated.

If( Begins the IT() loop.
i == 3, Break(Q If i is equal to 3, breaks the loop.

); Ends the loop.

Print( When 1 is not equal to 3, opens the Print() loop.
"i=" Prints the string "i=" to the log.

[ Places "i="" on the same line as the value that follows.
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Char(i)); Prints the value of i to the log.

The For () loop then repeats until the value of i is less
than or equal to 5, breaking when i equals 3, and
breaking and printing only when i is less than 3.

)3 Ends the loop.

Note that when the If () and Break () expressions follow Print(), the script prints the values
of i from 1 to 3, because the loop breaks after "i=3" is printed.

"7':1 n

II7'=2 n

"7'=3 n

Continue

As with Break(), Continue() is typically used inside a conditional expression. For example:

ForCi =1, i <=5, i++,
IfC i < 3, Continue() );

Print(C "i=" || Char( i ) J;
)
results in:
Il.l'=3 n
117':4 n
117'=5 n

The script works like this:

For( Begins the For() loop.
i=1, Sets i to 1.
i <=5, Evaluates 1 as less than or equal to 5.
i+, Increments 1 by 1. Note that this step is done after the

If loop is evaluated.

If( Begins the If() loop.
i < 3, Continue(Q) Evaluates i as 1 and continues as long as 1 is less than
3.

); Ends the If(Q loop.
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Char(i));
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When 1 is no longer less than 3, opens the Print()
loop.
Prints the string "i="" to the log.

Places "i=" on the same line as the value that follows.
Prints the value of i to the log.

The For () loop then repeats until the value of 1 is less
than or equal to 5, continuing and printing only when i
is equal to or greater than 3.

Ends the loop.

Conditional Functions

JSL provides five functions to evaluate an expression conditionally:

o ItV

e “Match”

* “Choose”

e “Interpolate”

° /Tﬁepu

If

The If() function evaluates the first result expression when its condition evaluates as true (a
nonzero or nonmissing value). Otherwise, it evaluates the second result expression.

The syntax is:

If ( condition, resultl, result2 );

For example, the following script returns "Young" when the age is less than 12. Otherwise, the

script returns "Young at Heart".

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "age group", "Character" );

For Each Row(

:age group = If( :age <= 12,

"Young",
"Young at Heart"
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You can also string together multiple conditions and results. The syntax is:

If( conditionl, resultl,
condition2, result2,

resultElse );

In the preceding example, if condition1 is not true, the function continues evaluating until it
finds a true condition. Then that condition’s result is returned.

The last result is returned when all conditions are false. And when a value is missing, the
missing value is returned. For these reasons, it's very important to include a default result at
the end of the expression. Consider the following example, which recodes gender
abbreviations in Big Class.jmp:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row( sex =
If(
sex == "F", "Female",
sex == "M", "Male",
"Unknown" );

);
The script works like this:

For Each Row( sex = For each row in the table, sex is the column that is
recoded.
If( Begins the If() loop.
sex == "F", "Female", If the value of sex is F, replaces the value with Female.
sex == "M", "Male", If the value of sex is M, replaces the value with Male.
"Unknown" ); If neither of the above conditions are true, replaces the

value with Unknown. If this result were omitted and
the value of sex were missing, the script would return a
missing value.

); Ends the loop.

You can also put actions and assignments in the result expression. The following example
assigns 20 to x, because the first condition (y < 20) is false:

y = 25;
z=IfC(y <20, x=y, x =20 );



130 JSL Building Blocks Chapter 5
Conditional Functions Scripting Guide

Note: Be careful to use two equal signs (==) for equality tests, not one equal sign (=). An If
with an argument such as name=value assigns rather than tests the value.

Avoiding Memory Issues with Multiple If Statements

Running a script that contains dozens of If() Statements can cause memory problems. We
recommend reducing the If() nesting. Suppose that your script contains 100 If() statements
in this format:

IfC val, If(C val, If( val, If(C val, If( val,
IfC val, If( val, If( val, If(C val, If( val,

3333390 s

Rewrite the script:

If( val, vall, If(val, val2, If(C val, val3,
If( val, val4, If(C val, val5, If(C val, val6, ...) ) D) D) ) );

You can also try setting the maximum call depth. The Maximum Call Depth preference sets
the default for the maximum call depth (or stack size) in which JSL built-in functions,
user-defined functions, or Recurse() function calls can be made. By default, the maximum
call depth is set to 256.

In JMP, your JSL script has a limited amount of physical runtime stack memory in which to
perform JSL function calls. By default, this size is set to 2MB. Increasing the maximum call
depth can cause a physical runtime stack overflow, so incrementally increase this preference
in small amounts until you find the best value that works for your JSL script.

Preferences[1] << Set( Maximum IMP call depth( 64 ) );

Match

You can use the Match() function to make several equality comparisons without needing to
rewrite the value to be compared. The syntax is:

Match( x, valuel, resultl, value2, result2, ..., resultElse );
For example, the following script recodes gender abbreviations in Big Class.jmp:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
For Each Row( sex =

Match(
sex,
"F", "Female",
"M", "Male",
"Unknown') ;
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The script works like this:

For Each Row( sex = For each row in the table, sex is the column that is
recoded.
Match( Begins the Match () loop.
sex, Specifies sex as the match argument.
"F", "Female", If the value matches "F" replace it with “Female”.
"M", "Male", If the value matches "M", replace it with "Male".
"Unknown" ); If F or M are not matched, replaces the value with
"Unknown".
J; Ends the loop.

This Match () example is a simplified version of the example in “If”. The advantage of
MatchQ) is that you define the comparison value once rather than repeat it in each condition.
The disadvantage is that you cannot use expressions with operators as you can with If; the
argument sex == "F" returns an error in a Match() expression.

With more groups of conditions and results, the value of Match() becomes more apparent.
The following script would require many additional lines of code with If().

dt = Open( "$SAMPLE_DATA/Travel Costs.jmp" );
For Each Row(
Booking Day of Week = Match( Booking Day of Week,
"Sunday", "SUN",
"Monday", '"MON",
"Tuesday", "TUE",
"Wednesday", "WED",
"Thursday", "THU",
"Friday", "FRI",
"Saturday", "SAT",
"Not Specified"
)
)3

Be careful with the data type of the condition and result. In the preceding example, the
conditions and results are both character data. If the data types do not match, JMP
automatically changes the column’s data type. The results might not be what you want.
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Note: The Match() function explicitly checks to see if the compare expression X is missing
and if the value of valuelis missing, then it returns the value of resultl; otherwise it
continues to compare the expression X to each valueN value in each valueN/resultN pair,
ignoring any missing values. If the expression X is equal to any of the valueN value, then the
corresponding resultN value is returned. If no matching valueN value is found, then the
resultElse value is returned.

Choose

The Choose () function shortens scripts even more than Match(), provided the arguments are
tested against integers. The syntax is:

Choose( expr, resultl, result2, result3, ..., resultElse );

Suppose you have a data table with a group column of numeric values from 1 through 7. If the
first cell contains the number 1, the following script returns x = "Low".

x = ( Choose( group[1l], "Low", "Medium", "High", "Unknown" ); );
Show( x );

The script works like this:

X = Creates the x variable.

Choose( Begins the Choose () loop.
group[1], Evaluates the value of group in the first row.
"Low", If the value of group is 1, return "Low".
"Medium", If the value of group is 2, return "Medium".
"High", If the value of group is 3, return "High".
"Unknown" Otherwise, return "Unknown'".
) Ends the loop.

)3 Closes the x variable.

Show( x ); Returns the value of x.

If the expression evaluates to an out-of-range integer (such as 7 when only 4 replacement
values are listed), the last result is returned. In the preceding example, "Unknown" is
returned.
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Notice that If () and Match() require more code to achieve the same results as the Choose
function:

If(
group[1l] == 1, "Low",
group[1l] == 2, "Medium",
group[1l] == 3, "High",
"Unknown"
J;
Match( group, 1, "Low", 2, "Medium", 3, "High", "Unknown" );

Note: If the data types in the expression do not match, JMP automatically changes the
column’s data type.

Interpolate

The Interpolate() function performs linear interpolation for continuous data or bilinear
interpolation for two-dimensional continuous data.

In the simplest case, the function finds the y value that corresponds to a given x value between
two sets of points. You might use Interpolate() to calculate missing values between data
points.

The data points can be specified as alternating ordered arguments:
Interpolate( x, x1, yl, x2, y2, ... );

or as matrices containing the x and y values:
Interpolate( x, xmatrix, ymatrix );

Suppose that your data set includes the height of individuals from age 20 through 25.
However, there is no data point for age 23. To estimate the height for 23-year-olds, use
interpolation. The following example shows the value that you want to evaluate (age 23),
followed by matrices for ages (20 through 25) and heights (59 through 75).

Interpolate( 23, [20 21 22 24 25], [59 62 56 69 75] );
returns:
62.5

The value 62.5 is halfway between the y values 56 and 69, just as 23 is halfway between the x
values 22 and 24.

You can also interpolate multiple points by specifying a matrix or list of values in the first
argument.

Interpolate( [23, 24.5], [20 21 22 24 25], [59 62 56 69 75] );
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returns:
[62.5, 72]

Bilinear Interpolation
You can also interpolate in two-dimensions:
Interpolate( {x, y}, xvector, yvector, zmatrix );

Here, the first argument is a list of two points, the second and third arguments are vectors that
define the grid of x and y values, and the fourth argument is a matrix of data points. The
function then finds the interpolated z value within the appropriate quadrant of the zmatrix.
The appropriate quadrant is found by comparing the x and y values to the xvector and
yvector arguments.

Suppose you have a 2x3 matrix and you want to interpolate a point that is halfway between
the first and second rows of points and halfway between the second and third columns of
points.

Interpolate( {0.5, 0.75}, [0 1], [0 0.5 1], [10 15 20, 12 16 18] );
returns:
17.25

Note that 0.5 is halfway between 0 and 1 for the x values (corresponding to the rows of the
matrix) and 0.75 is halfway between 0.5 and 1 for the y values (corresponding to the columns
of the matrix). You can find the bilinear interpolation in two steps:

1. Find the halfway points between the second and third columns for the each row of the
matrix:

— Row 1:17.5 is halfway between 15 and 20.
— Row 2:17 is halfway between 16 and 18.
2. Find the halfway point between the two points in the previous step: 17.25.

Notes:

* The x values must be in ascending order. For example, Interpolate(2,1,1,3, 3) returns
2. However, Interpolate(2,3,3,1,1) returns a missing value (.).

e Interpolate() is best used for continuous data, but Step() is designed for discrete data.
See “Step”.
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Step

The Step() is like Interpolate() except that it finds the corresponding y for a given x from
a step-function fit rather than a linear fit. Use Step() with discrete y values (that is, when the
y value’s corresponding X value can be only y; or y,). However, when the y value’s
corresponding x value can fall between y; and y,, use Interpolate().

As with Interpolate, the data points can be specified as a list:
Step( x, x1, yl, x2, y2, ... );

or as matrices containing the x and y values:
Step( x, xmatrix, ymatrix );

Suppose that your data table shows the discount percentage for purchases of $25, $50, $75,
and $100. You want to create a graph that shows the discount for a $35 purchase, which the
data table does not specify. The following example shows the value that you want to evaluate,
35, followed by matrices for purchases from $25 to $100.

Step( 35, [25 50 75 100], [5 10 15 2571 );
returns:

5

If the discounts were on a sliding scale (in this example, between 5 and 10, you would use
Interpolate(Q):

Interpolate( 35, [25 50 75 100], [5 10 15 25] );
returns:
7

As with Interpolate(), the data points must create a positive slope.

Compare Incomplete or Mismatched Data

Comparing data that contains missing values can return misleading results unless you specify
a condition that is always true or use functions such as Is Missing() or Zero Or MissingQ.
Comparisons of data with mismatched types (numeric versus character) or data in matrices
can also be confusing.

Table 5.5 shows examples of such comparisons and matrices and explanations of the results.
For a review of operators used in comparisons, see “Operators”. For an overview of
comparing data, see the JSL Syntax Reference.

Note: Matrices must include the same number of columns or rows.
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Table 5.5 Some Special-Case Comparison Tests

Test

m=.; m==1

m=.; ml=1

m=.; m<l; m>1; and
SO on

m=.; 1l<m<0

{a, b}==List(a, b)

{a, b}<{a, c}
1=—"abc"
1<="abc"

[1 2 3]==[2 2 5]

[1 2 3]==2

[1 23] <[225]

[123] <2

Is Missing(m)

Zero Or Missing(m)

AT1([2 2]==[1 2D)

Result

[0 10]

[0 10]

[101]

[100]

Explanation
An equality test with a missing value returns missing.
An inequality test with a missing value returns missing.

A comparison with a missing value returns missing
(unless it could not possibly be true, see next).

A comparison involving a missing value that could not
possibly be true returns false; false takes precedence
over missing for comparisons with more than two
arguments (as with logical operators).

An equality test of list arguments returns a single result.
A comparison test of list arguments is not allowed.

An equality test with mixed data types returns false.

A comparison with mixed data types returns missing.

An equality test of matrices returns a matrix of
elementwise results. When a matrix is compared to a
matrix, comparison is done element-by-element and
returns a matrix of 1s and 0s.

An equality test of a matrix and a matrix filled with 2s.
If a matrix is compared to a number, the number is
treated as a matrix filled with that number.

A comparison of matrices returns a matrix of
elementwise results.

A comparison of a matrix and a matrix filled with 2s.

Returns 1 for a missing value and returns 0 otherwise.
For missing character values, you can also use empty

"

quotes for the comparison, as inm=="".

Returns 1 when the value is 0 or missing. The argument
must be numeric or a matrix and not a string.

Summarizes elementwise comparisons; returns 1 only if
all comparisons are true and returns 0 otherwise.
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Table 5.5 Some Special-Case Comparison Tests (Continued)
Test Result Explanation

Any([2 2]==[1 2D) 1 Summarizes elementwise comparisons; returns 1 if any
comparison is true and returns 0 otherwise.

Missing Values

In a comparison, missing values typically return missing, not true or false. For this reason, it is
very important to include a result that is always true. Suppose that a data table column
contains the values 1, 2, 3, and a missing value in column A. A formula in column B sets up the
comparison.

New Table( "Testing Comparisons",

Add Rows( 4 ),
New Column( "A",

Numeric,

"Continuous",

Format( "Best", 10 ),

Set Values( [1, 2, 3, .]1)
),

New Column( "B", Character, "Nominal", Formula( If( :A, "true", 1, "false"
D)D) )
J;

The following values are stored in column B:

"true n
"tr‘ue n
"true"
"false"

The script works like this:

If(C Begins the comparison.

tA, "true", If the value of A is nonmissing and nonzero, the result is
"true". This comparison is true for the first three rows.

1, "false" The value of 1 is always true, so the missing value
returns "false".

); Closes the comparison.
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Notes:

*  When a cell contains a non-empty string, the comparison fails with the first comparison.
The following script returns a missing value if a is a string. It works for numeric values.

a="a";
IfC a, "true", "false" );

*  When one value is false and another one is missing, Or () returns missing. Use OrMZ() to
return false instead. See the JSL Syntax Reference.

*  When one value is true and another one is missing, And() returns missing. Use AndMZ () to
return false instead. See the JSL Syntax Reference.

* MatchMZ() is similar to Match() except that missing values are treated as 0.

e IfMZ(Q) is similar to If() except that missing values are treated as 0.

Is Missing

If you know that some values are missing, you can also compare with Is Missing(). The
comparison in the preceding example can be rewritten to return "missing" for missing values:

IfC :A, "true", Is Missing( :A ), "missing", "false" );
The preceding expression returns "true" when A is nonmissing and nonzero, "missing" when
A is missing, and "false" otherwise.
Zero Or Missing
If the missing value could be 0, use the Zero Or Missing() function instead:
Zero Or Missing( A );
This expression returns 1 when A is 0 or missing.

Tip: You cannot compare a known value with an explicitly defined missing value, only with
variables, matrices, or other things that could contain missing values.

Inquiry Functions

Inquiry functions identify the type of an element, such as a string, list, or matrix. You can then
write a script specific to that element type.

JMP also uses inquiry functions to determine the writability of a directory or file and to
identify a computer’s operating system and the JMP version.
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General Element Types

The Type () function returns a string naming the type of the resulting value. For example:
Show( Type( 1 ), Type( "hi" ), Type( {"a", 2} ), Type( [10 24 325] ) );
results in:
Type(1) = "Integer"
Type("hi") = "String"

Type({"a'l’ 2}) = "L_"St”
Type([10 24 325]) = "Matrix";

Specific Element Types

Other inquiry functions (such as Is Matrix(), Is List(), Is Scriptable(), and so on) let
you test for specific types of objects. In the following example, Is Matrix() evaluates as true,
then the specified calculations are run:

a = [2 3];
b =[1, 1];
c=a* b;
IfC Is Matrix( c ),

(cra) / (@a* b,
Print( "c is not a matrix." )
);
[5 25]
Is Scriptable() returns 1 when the object is scriptable. Four variables in the following
example refer to a data table, column, platform, and report. All four objects are scriptable, so
Is Scriptable() returns 1 for each example.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = Column( "weight" );
plat = Bivariate( Y( :weight ), X( :height ) );
rep = Report( plat );
Show( Is Scriptable( dt ) );
Is Scriptable(dt) = 1;
Show( Is Scriptable( col ) );

Is Scriptable(col) = 1;
Show( Is Scriptable( plat ) );

Is Scriptable(plat) = 1;
Show( Is Scriptable( rep ) );
Is Scriptable(rep) = 1;

Is Empty() tests to see whether a variable has a value, a function, an expression, or a
reference to an object. It returns 1 if the variable is undefined or holds the Empty()
value.Otherwise, you get errors when referring to something that has not been created or
assigned a value yet. Programmers call this an uninitialized variable.
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Here is an example of a test to see whether a data table is opened and therefore assigned to the
dt variable. If a data table is not opened, the Open() function prompts the user to open the

table.
If( Is Empty( dt = Current Data Table(Q) ),
dt = Open()
)3
You can use Is Empty() for any variable (such as global variable, local variable, and
columns).

Table 5.6 shows functions that identify object types.

Table 5.6 Inquiry Functions That Identify Object Types

Syntax Explanation

Is Associative Returns 1 if the evaluated argument is an associative array or 0
Array (X) otherwise.

Is Directory(x) Returns 1 if the x argument is a directory and 0 otherwise.

Is Empty(global)  Returns 1 if the global variable, data table, or data column does not

Is Empty(dt) have a value (is uninitialized) or 0 otherwise.
Is Empty(col)

Is Expr(x) Returns 1 if the evaluated argument is an expression or 0 otherwise.
Is File(x) Returns 1 if the x argument is a file and 0 otherwise.

Is List() Returns 1 if the evaluated argument is a list or 0 otherwise.

Is Matrix(x) Returns 1 if the evaluated argument is a matrix or 0 otherwise.

Is Name(X) Returns 1 if the evaluated argument is a name or 0 otherwise. See

“Retrieve a Stored Expression Rather than its Result”.
Is Namespace(X) Returns 1 if the evaluated argument is a namespace or 0 otherwise.

Is Number(X) Returns 1 if the evaluated argument is a number or missing
numeric value or 0 otherwise.

Is Scriptable(X) Returns 1 if the evaluated argument is a scriptable object or 0
otherwise.
Is String(x) Returns 1 if the evaluated argument is a string or 0 otherwise.

Type(X) Returns a string naming the type of x.
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Object Attributes

JMP provides the following functions to determine whether a file or directory is writable
before attempting to write to them. Use these functions in combination with Is
Directory(path) and Is File(path) to verify a script destination and attribute. See the JSL
Syntax Reference for additional information.

The Is Directory Writable(path) function returns 1 if the directory specified in the path
argument is writable and 0 otherwise.

The Is File Writable(path) function returns 1 if the file specified in the path argument is
writable and 0 otherwise.

For example, the following code verifies the path refers to a directory and then checks to
ensure the directory is writable:

If( Is Directory( "$SAMPLE_DATA/Loss Function Templates" ),
If( Is Directory Writable( "$SAMPLE_DATA/Loss Function Templates" ),
"Directory 1is writable.",
"Directory 1is read only!"

),

"Is a read only directory."

s

Host Information

The Host Is() inquiry function identifies the current operating system. Then actions specific
to that operating system can be performed.

The following example specifies text sizes in reports for different operating systems. If you
commonly write your scripts on Windows and share them with macOS users, the results can
look different from what you intended. For example, the following expression sets the text to a
larger size (12) on macOS and a smaller size (10) on Windows:

textsize = If( Host is( "Mac" ), 12, 10 );

Version Information

The JMP Version() inquiry function returns the JMP version as a string. You might use this
function to determine the JMP version and then run a script compatible with that version.

JMP Version(); // returns "16.0.0" in IMP 16
JMP Version(); // returns " 9.0.0" in JMP 9

Notice that a leading blank is inserted before versions less than 10.0.0. This blank helps when
comparing version numbers. Without the leading blank, 9.0.0 is interpreted as greater than
10.0.0.
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Chapter 6

Types of Data

Working with Numbers, Strings, Dates, Currency, and More

This chapter discusses basic data types:

numbers and strings

paths, which are a special type of string

dates and times, which can be either special numbers or special strings
currency

hexadecimal values and blobs

At the end of the chapter are two sections that show more advanced methods of interacting
with strings and pattern matching with regular expressions.
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Numbers and Strings

Numbers can be written as integers, decimal numbers, in scientific notation with an E
preceding the power of ten, and as date-time values. A single period by itself is the missing
numeric value.

For example, these are all numbers:
1 12 1.234 3E3 0.314159265E+1 1E-20

One or more characters placed within double quotation marks constitute a string. For
example, these are all strings:

"Green" "Hello,\NWorld!" "54"

Notice that if a number is in quotation marks, it is a string, not a number. There are two
functions you can use to change a number into a string or a string into a number.

e Use Num(Q) to convert a string into a number. For example:

Num( "54" );
54

Note: Num() cannot convert non-numeric characters, so it produces a missing value.

Num( "Hello" );

* Use Char(Q) to convert a number into a string. For example:

Char( 54 );

”54”
Char( 3E3 )

"3000 "

To preserve locale-specific numeric formatting in Num() or Char () output, include the <<Use
Locale(1) option as shown in the following example:

Char( 42, 5, 2, << Use Locale( 1) );
// results in the character value "42,00" in the French Tocale

To look at each character in a string, use the Substr() function. This example looks for the
letter “a” in the string and prints a message to the log:

ch = Substr( "alphabetic", 1, 1 ); // start and end with the first character
If( ch == "a",

Print( "First Tetter is a." )
J;

"First letter is a."
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Formatting Numbers

The Format () function provides options for formatting numbers with thousands separators,
decimal points, geographic symbols, p-values, and so on. The following example shows a
basic format for a fixed decimal column.

Format( x, "Fixed Dec", 10, 2, "Use thousands separator');

The format starts with the number to be formatted. Then you can specify the width of the
number, the number of decimal places, and whether to use a thousands separator.

Here are other examples:

Format( x, "Currency", 20, <<Use Locale(0) );
// ignores computer Tocale and uses a period for the decimal separator

Format( x, "Currency", 20, "Use thousands separator" );

Format( x, "m/d/y", 10 );

Format( x, "Precision", 10, 2, "Keep trailing zeroes", "Keep all whole digits"
);

Format( x, "Latitude DDD", "PUNDIR"); // "PUN" for punctuation, "DIR" for
direction, PUNDIR for both

Format( x, "Custom", Formula( Abs( value ) ), 15 );

The syntax for Function() arguments is shown in the JSL Syntax Reference. You can also find
the argument names and options in the data table Column Info window.

See “Date-Time Functions and Formats” and “Currency” for more information about

formatting date-time values and currency.

Note: If the date format is unknown, an error is written to the log.

Matrix Box, Number Col Box, Number Col Edit Box, Number Edit Box

To format numbers in Matrix Box(), Number Col Box(), Number Col Edit Box(), and
Number Edit Box(), send the Set Format message to the display box. You can then specify
the same arguments as for the Format () function, such as the following:

<<Set Format( 10, 2, "Use thousands separator');
<<Set Format( "Currency", "EUR", 20 );

The syntax for Set Format arguments is shown in the JSL Syntax Reference. You can also find

the argument names and options in the data table Column Info window.

Note: If you specify the number of decimal places, that number must be preceded with the
width.
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Unicode Characters

JMP supports both Unicode UTF-8 and UTF-16 standards for encoding and representing text
for most of the world languages. See the The Unicode Consortium for code charts and more
information on the Unicode standard.

To display Unicode characters in JMP, precede the Unicode code for the character with "\!".
For example:

¢ Greek letter sigma (o) in Unicode = U+03C3; in JMP, use \!U03C3
e Greek letter mu () in Unicode = U+03BC; in JMP, use \!U03BC

To use Unicode to express superscripts and subscripts:

* subscript 1 (1) in Unicode = U+2081; in JMP, use \!U2081

® superscript 2 (%) in Unicode = U+00B2; in JMP, use \!U00B2
To express x%in Unicode, in JMP, use \'U0078\!U00B2.

To use Unicode surrogate pairs, specify the Unicode escape sequence twice. If you specify an
emoji Unicode character, you might need to change the font for it to appear correctly. The
following example shows how to include an emoji in a text box.

New Window( "Emoji Example",
V List Box(
Text Box( "Surrogate Pair with space: \!UD83D \!UDE00", Set Font( "Segoe
UI Emoji"™ ) ),
Text Box( "Surrogate Pair without space: \!UD83D\!UDEO0O", Set Font(
"Segoe UI Emoji" ) )
)
J;

Path Variables

Path variables are shortcuts to directories or files. Rather than enter the entire path to the
directory or file, you use the path variable in a script. A path variable is a special type of string
and is always contained within double quotation marks.

One common predefined path variable in JMP is $SAMPLE_DATA. This variable points to the
sample data folder in your JMP or JMP Pro installation folder. The following example opens
the Big Class.jmp sample data table.

Open( "$SAMPLE_DATA/Big Class.jmp" );

Several path variables are predefined in JMP. The following table shows the definitions for the
current JMP version. Variables in previous versions of J]MP might differ.


http://www.unicode.org
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Table 6.1 Predefined Path Variable Definitions

Variable

ADDIN_HOME(com.your.ad
din.id)

Defines the folder where
the specified add-in is
stored.

ALL_HOME

Defines a folder that can be
accessed by all users on a
machine.

BUILTIN_SCRIPTS

DESKTOP

DOCUMENTS

DOWNLOADS

GENOMICS_HOME

Path

Add-In Builder stores the specified add-in in the following folders,
based on your operating system:

Windows:
"C:/Users/<username>/AppData/Roaming/SAS/JMP/Addins/"

macOS: "/Users/<username>/Library/Application
Support/JMP/Addins/"

For example, Convert File Path(
"$ADDIN_HOME (com.your.addin.id) evaluates to the location of
the com.your.addin.id add-in.

To install your add-ins in a shared network location, use the
Register Addin() function. See “Register an Add-In Using JSL”.

Windows (JMP): "/C:/ProgramData/SAS/JMP/16/"
Windows (JMP Pro): "/C:/ProgramData/SAS/JMPPro/16/"
macOS: "/Library/Application Support/JMP/16/"

To see if the directory exists, run the script Is
Directory("$ALL_HOME") ;. If the folder exists, 1 is returned.

Windows (JMP): "/C:/Program
Files/SAS/JMP/16/Resources/Builtins/"

Windows (JMP Pro): "/C:/Program
Files/SAS/JMPPRO/16/Resources/Builtins/"

macOS: "/Applications/JMP 16.app/Contents/Resources/Builtins/"

Windows: "/C:/Users/<username>/Desktop/"

macQOS "/Users/<username>/Desktop/"

Windows: "/C:/Users/<username>/Documents/"

macOS: "/Users/<username>/Documents/"

Windows: "/C:/Users/<username>/Downloads/"

macQS: "/Users/<username>/Downloads/"

"/<JMP Genomics installation directory>/"
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Table 6.1 Predefined Path Variable Definitions (Continued)

Variable Path

HOME e  Windows (JMP):
"/C:/Users/<username>/AppData/Roaming/SAS/JMP/16/"

e  Windows (JMP Pro):
"/C:/Users/<username>/AppData/Roaming/SAS/JMPPro/16/"

¢ macOS: "/Users/<username>/"
JMP_HOME ¢  Windows: /C:/<JMP installation directory>
Note: The variable is not available on macQOS.
SAMPLE_APPS e  Windows: /C:/<JMP installation directory>/Samples/Apps/"
e  macOS: "/Library/Application Support/JMP/16/Samples/Apps/"

SAMPLE_DASHBOARDS e  Windows: /C:/<JMP installation directory>/Samples/Dashboards/"

e macOS: "/Library/Application
Support/JMP/16/Samples/Dashboards/"

SAMPLE_DATA e  Windows: "/C:/<JMP installation directory>/Samples/Data/"

e  macOS: "/Library/Application Support/JMP/16/Samples/Data/"
SAMPLE_IMAGES e  Windows: "/C:/<JMP installation directory>/Samples/Images/"

e  macOS "/Library/Application Support/JMP/16/Samples/Images/"
SAMPLE_IMPORT_DATA e  Windows: "/C:/<JMP installation directory>/Samples/Import Data/"

e  macOS: "/Library/Application Support/JMP/16/Samples/Import
Data/"

SAMPLE_PROJECTS e  Windows: "/C:/<JMP installation directory>/Samples/Projects/"

e  macOS: "/Library/Application Support/JMP/16/Samples/Projects/"
SAMPLE_SCRIPTS e  Windows: "/C:/<JMP installation directory>/Samples/Scripts/"

e  macOS: "/Library/Application Support/JMP/16/Samples/Scripts/"

TEMP e  Windows: "/C:/Users/<username>/AppData/Local/Temp/"

e  macQOS: "var/folders/..."
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Table 6.1 Predefined Path Variable Definitions (Continued)

Variable Path

USER_APPDATA e  Windows (JMP):

Changes to JMP "/C:/Users/<username>/AppData/Roaming/SAS/JMP/16/"
preferences, menus, and e  Windows (JMP Pro):

the Home Window are "/C:/Users/<username>/AppData/Roaming/SAS/JMPPro/16/"
stored here, along with e macOS: "/Users/<username>/Library/Application

Debugger session settings. Support/JMP/16/"

Path variable definitions are updated automatically based on the version of JMP you are
using. For example, when you run a JMP 14 script in JMP 16, the JMP 16 path variable
definitions are used.

To see the definition of any path variable, use the function Get Path Variable:

Get Path Variable( "HOME" );
"/C:/Users/<username>/AppData/Roaming/SAS/IMP/16/"

Note that you don’t include a dollar sign for Set Path Variable() or Get Path
Variable(). But you must include the dollar sign when using the variable in a script.

Trailing Slashes

Make sure to include a trailing slash after the path variable. In the following example, the root
name "Big Class" is assigned to the dtName variable. The Open() expression evaluates
$SAMPLE_DATA and the trailing slash and then appends the dtName value along with the file
extension . jmp.

dtName = "Big Class";
dt = Open( "$SAMPLE_DATA/" || dtName || ".jmp" );

The path is interpreted as:
C:/Program Files/SAS/JMP/16/Samples/Data/Big Class.jmp
Without the slash that follows $SAMPLE_DATA, the path is interpreted as:
C:/Program Files/SAS/JMP/16/Samples/DataBig Class.jmp

Create and Customize Path Variables

You can create your own path variables or override some of the built-in variables with the Set
Path Variable(). In the following example, the path variable is called root. The variable
points to the c:/ directory.

Set Path Variable( "root", "c:/" );
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To get the value of the new variable, use Get Path Variable().

Get Path Variable( "root" );
"C:/"
Use your path variable as you would other variables. The following expression opens the
myimportdata.txt file in the c:/ directory.

Open( "$root/myimportdata.txt" );

As with getting path variables, omit the dollar sign when setting path variables.

Relative Paths

If you plan to use relative paths in variables, you must set the default directory. Then any path
not preceded by a drive letter is relative to the default directory. Here is an example:

Set Default Directory( "c:/users/smith/data" );

To return the value of the default directory, use Get Default Directory().
Get Default Directory(); // returns "c:/users/smith/data"

So the following expression resolves as C:/users/smith/data/cleansers.jmp:

Open("cleansers.jmp");

File Path Separators

In JMP, the preferred file path format is the Portable Operating System Interface (POSIX), or
UNIX, format with forward slashes (/) as separators. This means that you do not have to
identify the current operating system in scripts run on both Windows and macOS. However,
each host still accepts its native format for compatibility.

You can a convert file path format from Windows to POSIX (and vice versa) using Convert
File Path(). Converting from a POSIX to a Windows path might be useful when you need to
output a path to a file or to another application. The syntax is:

Convert File Path (path, <absolute|relative>, <POSIX|windows>, <base(path)>);
For example, the following script converts a POSIX path to a Windows path:

Convert File Path( "c:/users/smith", windows);
c:\users\smith

You can substitute a path variable (such as $HOME) for the path inside quotes.



152 Types of Data Chapter 6
Date-Time Functions and Formats Scripting Guide

Date-Time Functions and Formats

A date-time value consists of any portion of a date or time. The value can be seconds
(3388594698), a complete date (such as “Wednesday, May 18, 2011”), the date and time
(“05/18/2011 8:18:18 PM”), the week number (3), and so on.

JMP lets you convert date-time values to common formats, perform arithmetic on the values,
and manipulate the data in a number of ways.

Tip: For descriptions of all date-time functions and their arguments, see the JSL Syntax
Reference.

Date-Time Values

Date-time values are stored and calculated as the number of seconds since midnight, January
1, 1904. For example:

Today(); // returns 3388649872 on May 19, 2011 at 12:00:00 AM

As with Today (), the Date DMY() and Date MDY() functions also return month, day, and year
arguments as seconds. For example, if it were 12:00:00 a.m. on May 19, 2011, all of the
following statements would return the same value:

Date DMY( 19, 5, 2011 );
Date MDY( 5, 19, 2011 );
TodayO;

3388608000

The As Date() function takes the number of seconds and displays it as a date or duration.

® Values that represent one year or more are returned as dates:

As Date( 3388608000 );
19May2011

® Values that represent less than a year are returned as durations.

As Date( 50000 );
:0:13:53:20

You can use date-time values in two ways:
* aliteral value, for example 19May2011:10:10
® astring, for example "Thursday, May 19, 2011"

You can perform arithmetic with date-time literals, which use the number of seconds as the
base number.

As Date( 19May2011 + 1 );
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Program with Date-Time Functions

Table 6.2 shows functions that convert seconds into date-time values and date-time values into

seconds.

Table 6.2 Date-Time Functions

Function

Abbrev Date(date)

As Date(expression)

Date DMY(day, month,
year)

Date MDY(month, day,
year)

Day Of Week(date)

Explanation

Returns a string representation for the date supplied. The format
is based on your computer’s regional setting. So for the English
(United States) locale, the date is formatted like "02/29/2004".
Even if you are running JMP in English with a different locale,
the locale format is applied.

Formats a number or expression so that it shows as a date or
duration in a text window. For example, values that represent
one year or more are returned as dates.

x = As Date( 8Dec2000 + In Days( 2 ) );
shows as:

10Dec2000

Values that represent less than a year are returned as durations.
As Date( 50000 );
shows as:
:0:13:53:20

Returns the specified date expressed as the number of seconds
since midnight, 1 January 1904. For example, the second Leap
Day of the third millennium is DateDMY (29, 2,2004), which
returns 3160857600.

Returns the specified date expressed as the number of seconds
since midnight, 1 January 1904. For example, the second Leap
Day of the third millennium is DateMDY(2,29,2004), which
returns 3160857600.

Returns an integer representation for the day of the week of the
date supplied. Weeks are Sunday—Saturday.
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Table 6.2 Date-Time Functions (Continued)

Function

Day Of Year(date)

Day(date)

Format(date,
"format'

Hour(datetime)

In Days(n)
In Hours(n)
In Minutes(n)
In Weeks(n)
In Years(n)

Long Date(date)

MDYHMS (date)

Minute(date-time)

Month(date)

Num(date-time)

InFormat(string,
"format")

Parse Date(string,
"format')

Explanation

Returns an integer representation for the day of the year of the
date supplied.

Returns an integer representation for the day of the month of the
date supplied.

Returns the value in the format specified in the second
argument. Most typically used for formatting datetime values
from a number of seconds to a formatted date. Format choices
are those shown in the Column Info dialog box. Also see
Table 6.3.

Returns an integer representation for the hour part of the
date-time value supplied.

These functions return the number of seconds per n minutes,
hours, days, weeks, or years. Divide by these functions to
express an interval in seconds as an interval in other units.

Returns a string representation for the specified date. The
format is based on your computer’s regional setting. So for the
English (United States) locale, the date is formatted like
"Sunday, February 29, 2004".Even if you are running JMP
in English with a different locale, the locale format is applied.

Returns a string representation for the date supplied, formatted
like "2/29/2004 00:02:20 AM".

Returns an integer representation for the minute part of the
date-time value supplied.

Returns an integer representation for the month of the date
supplied.

Returns an integer representation for the date-time value
supplied.

Parses a string of a given format and returns datetime value
expressed as if surrounded by As Date(), returning the date in
ddMonyyyy format.
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Table 6.2 Date-Time Functions (Continued)

Function

Second(date-time)

Short Date(date)

Time Of Day(date)

Today )

Week Of Year(date,
<rule_n>)

Year(date)

Explanation

Returns an integer representation for the second part of the
date-time value supplied.

Returns a string representation for the date supplied, in the
format MM/DD/YYYY, regardless of locale (for example,
"02/29/2004").

Returns an integer representation for the time of day of the
date-time supplied.

Returns the current date and time expressed as the number of
seconds since midnight, 1 January 1904. No arguments are
accepted, but the parentheses are still needed.

Returns the week of the year as a date-time value. Three rules
determine when the first week of the year begins.

¢ With rule 1 (the default), weeks start on Sunday, with the
first Sunday of the year being week 2. Week 1 is a partial
week or empty.

¢ With rule 2, the first Sunday begins with week 1, with
previous days being week 0.

e With rule 3, the ISO-8601 week number is returned. Weeks
start on Monday. Week 1 is the first week of the year with
four days in that year. It is possible for the first or last three
days of the year to belong to the neighboring year’s week
number.

Returns an integer representation for the year of the specified
date.

Examples of Common Date-Time Functions

You can use any function that returns seconds within a function that returns a date-time.

For example, if today is May 19, 2011 and the time is 11:37:52 AM, Today () returns the
number of seconds, and the functions that follow show that number of seconds since the base
time in different date-time formats:

Today O
3666955847

Short Date( Today() );

"03/13/2020"
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Long Date( Today(Q) );

"Friday, March 13, 2020"
Abbrev Date( Today(Q );

"3/13/2020"
MDYHMS( Today () );

"03/13/2020 2:50:17 PM"

The date argument in parentheses can be seconds (or any function that returns seconds), or
any date-time literal value. For example, both of the following expressions return the same
value:

Long Date( 3388649872 );
Long Date( 19May2011 );
"Friday, March 13, 2020"

Note: Long Date() and Abbrev Date() values are formatted according to your computer’s
regional settings.

Extract Parts of Dates

You can extract parts of date values using the functions Month(), Day ), Year(), Day Of
Week (), Day Of Year(), Week Of Year(), Time Of Day, Hour(), Minute(), and Second(),
which all return integers. If today is May 24th, 2011, each of the following examples returns
the 144th day of the year:

Day of Year( Today(Q) );

Day of Year( 24May2011 );

Day of Year( Date MDY( 5, 24, 2011 ) );
144

Example

A data table column named Date contains date-time values that are formatted as "'m/d/y". You
want to create a column that shows only the time. In the following script, the second column’s
formula extracts the time of day from the Date value in the first column.

New Table( "Assembly Tests",
Add Rows( 1 ),
New Column( "Date",
Numeric, Continuous,
Format( "m/d/y" ),
Set Values( [3389083557] )
)
New Column( "Time",
Numeric, Continuous,
Formula( Format( Time Of Day( :Date ), "h:m:s") )
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Figure 6.1 shows the result. Note that the time of day does not appear in the Date column,
because the Format function applies the “m/d/y” format.

Figure 6.1 Example of Extracting the Time

Date Time
1/05/24/2011 12:05:57 PM

Rules for Determining the Week of the Year

Week of Year() returns the week of the year as a date-time value. Three rules determine
when the first week of the year begins.

e With rule 1 (the default), weeks start on Sunday, with the first Sunday of the year being
week 2. Week 1 is a partial week or empty.
Week Of Year( Date DMY(C 19, 6, 2013 ), 1 );
25
¢ With rule 2, the first Sunday begins with week 1, with previous days being week 0.
Week Of Year( Date DMY(C 19, 6, 2013), 2 ) ;
24
e With rule 3, the ISO-8601 week number is returned. Weeks start on Monday. Week 1 is the
first week of the year with four days in that year. It is possible for the first or last three days
of the year to belong to the neighboring year’s week number.

Week Of Year( Date DMY( 19, 6, 2013 ), 3 );
25

Arithmetic on Dates

You can perform the usual arithmetic operations with date-time data as with any other
numeric data. One option is simple arithmetic, such as subtracting a number from a date-time
value.

Another option is writing a formula to perform the arithmetic.

Example

The Date column in your data table shows when a customer uses his credit card to buy gas.
You want to know how many days elapse between purchases. The following script creates a
Days elapsed column. The formula in that column subtracts the Date value in the current row
from that of the previous row.

New Table( "Gas Purchases",
Add Rows( 3 ),
New Column( "Date",
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Numeric,

"Continuous",

Format( "m/d/y" ),

Set Values( [3392323200 3393532800 3394828800] )

)’
New Column( "Days elapsed",
Formula(
// returns a missing value for the first row
IfC Row(Q) == 1,
(:Date[Row()] - :Date[Row() - 1]1) / In DaysQ
)
)
)

);
Figure 6.2 shows the result.
Figure 6.2 Example of Calculating Date-Time Values

Date Days elapsed

1 07/01/2011 .
2 | 07/15/2011 14
3 1 07/30/2011 15

Time Intervals

The In Minutes, In Hours, In Days, In Weeks, and In Years functions are used to express
time intervals in units rather than seconds. Each of these functions returns the number of
seconds associated with a particular period of time. For example, the following expression
returns the number of weeks between now and July 4, 2012.

(Date DMY(C 04, 07, 2012 ) - Today()) / In WeeksQ);
-208.225444775132

When the argument for the interval function is empty, JMP counts by 1. You can enter another
number to change the count. For example, In Years(10) converts the interval to decades. The
following expression returns the number of decades between now and December 31, 2037.

(Date DMY( 31, 12, 2037) - Today() ) / In Years( 10 );
2.18927583529799
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Two-Digit and Four-Digit Years

JMP applies its own algorithms for interpreting and displaying datetime strings rather than
supporting operating system-specific datetime formats. However, JMP uses the date-time
separators selected in the Region and Language control panel (Windows) or the Date & Time
preferences (macOS) to interpret and display dates.

Two-digit years are interpreted according to the current system clock year and JMP rules. For
example, when the year in a script is 11, and you run the script after 1990, the year shows as
2011.

Long Date( 25Mayll );
"Wednesday, May 25, 2011"

To avoid ambiguity, enter four-digit years. The following expression returns 1911 (rather than
2011) as indicated:

Long Date( 25May1911 );
"Thursday, May 25, 1911"

Table 6.3 explains how JMP interprets two-digit years.

Table 6.3 How JMP Interprets Two-Digit Years

Two-Digit When it is Evaluated Result Examples Resul
Year Value t
00-10 before 1990 (on Windows) 19__ enter 5 in year 1905
1979
before or during 1990 (on
macOS)
during or after 1990 (on 20__ enter 5 in year 2005
Windows) 1991
after 1990 (on macQOS)
11-89 (on  any time current enter 13 in year 1913
Windows) century 1988
11-90 (on enter 13 in year 2013
macOS) 2024
90-99 (on  before 2011 19__ enter 99 in year 1999
Windows) 1999
91-99 (on  during or after 2011 20__ enter 99 in year 2099

macQOS) 2015
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Note: JMP always displays four-digit years regardless of the regional settings. If you need to
show two-digit years, use character string functions. See “Types of Data”.

Date-Time Values in Data Tables

Change Date-Time Input and Display Formats

In data tables, JMP can accept the input of date-time values in one format (the input format),
store them internally as the number of seconds since the base date, and display them in a
different date-time format. The Informat() and Format() functions give you this control.

e Informat() takes a string date-time value, defines the date format used in that string, and
returns the date in ddMonyyyy format.

Informat( "19May2011 11:37:52 AM", "ddMonyyyy h:m:s" );
19May2011:11:37:52
e Format() takes the number of seconds since the base date (or a date-time function that
returns that number) and returns the date in the specified format.

Format( 3388649872, "ddMonyyyy h:m:s" );

"19May2011 11:37:52 AM"
Format( Today(), "ddMonyyyy h:m:s" );

"19May2011 11:37:52 AM"

Suppose that you are entering dates into a column using the d/m/y h:mformat, but you want
to see the dates in the m/d/y format. Input Format defines the input format, and Format
defines the display format. For example,

New Table( "Widget Assembly",
Add Rows( 1 ),
New Column( "Date",
Numeric,
"Continuous",
Format( "m/d/y" ),
Input Format( "d/m/y h:m" ),
Set Values( [3126917100] )
)
J;

The Format and Input Format values are shown in the data table’s column properties
(Figure 6.3). Note that when you click in the cell to edit it, the date-time value appears in the
input format. When you edit the value, or add a new value, the format specified in the data
table column Format list is used to display the value.
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Figure 6.3 Example of Date-Time Display and Input Values

v -

Date Date
1|02/01/2003 1 01/02/2003 4:05 AM

‘Date’ in Table “Widget Assembly’

Column Mame | Date |

Lock

Data [} MNumeric v|
Modeling B | Continuaous v|

Format

mydsy ¥ | width
Input Format | g sm sy him =
Column Properties '|

Notes:

e In a script that converts a column from character to numeric, specify Format() and
Informat() to prevent missing values. See “Convert Character Dates to Numeric Dates”.

¢ The date-separator character on your computer might differ from the forward slash (/)
character shown in the Scripting Guide.

* You can enter time values in 24-hour format (military time) or with AM or PM designators.

Table 6.4 describes the formats used as arguments in date-time functions or as data table
formats. You can also use the formats for the format argument to a Format message to a data
column. See “Set or Get Formats”.

For descriptions of specific date-time functions, see the JSL Syntax Reference.
Notes:

* Date-time formats in which a colon or T separate the date and time always use a 24-hour
format. Other formats use your computer’s regional settings.

e If the format is unknown, an error is written to the log.

Table 6.4 Date-Time Formats

Type Format argument Example

Date only "m/d/y" "01/02/1999"
"mmddyyyy" "01021999"
"m/y" "01/1999"
"d/m/y" "02/01/1999"
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Table 6.4 Date-Time Formats (Continued)

Type

Date and time

Format argument
"ddmmyyyy"
"ddMonyyyy"
"Monddyyyy"
"y/m/d"
"yyyymmdd"
"yyyy-mm-dd"
"yyyyQq"

"m/d/y h:m"

"m/d/y h:m:s"

"d/m/y h:m"

"d/m/y h:m:s"

"y/m/d h:

3

"y/m/d h:m:

7]

"ddMonyyyy h:m"
"ddMonyyyy h:m:s
"ddMonyyyy:h:m"
"ddMonyyyy:h:m:s"

"Monddyyyy h:m"

"Monddyyyy h:m:s

Example
"02011999"
"02Jan1999"
"Jan021999"
"1999/01/02
"19990102"
“1999-01-02
199901

"01/02/1999
"01/02/1999

"01/02/1999
"01/02/1999

"02/01/1999
"02/01/1999

"02/01/1999
"02/01/1999

£1999/01/02
£1999/01/02

£1999/01/02
£1999/01/02

"02Jan1999
"02Jan1999

"02Jan1999
"02Jan1999

"02Jan1999:
"023an1999:

"02Jan1999:
"02Jan1999:

"Jan021999
"Jan021999

"Jan021999
"Jan021999

13:01"
1:01 pm"

13:01:55"
1:01:55 PM"

13:01"
1:01 pm"

13:01:55"
1:01:55 PM"

13:01’
1:01 Pw’

13:01:02
1:01:02 p™m’

13:01"
1:01 pM"

13:01:02"
1:01:02 PM"

13:01"
1:01 pM"

13:01:02"
1:01:02 PM"

13:01"
1:01 pM"

13:01:02"
1:01:02 PM"

Chapter 6
Scripting Guide
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Table 6.4 Date-Time Formats (Continued)

Type Format argument Example
Day number ":day:hr:m" "34700:13:01"
and time ":33:001:01 PM"
":day:hr:m:s" "34700:13:01:02"
":33:001:01:02 PM"
"h:im:s" "13:01:02"
"01:01:02 PM"
|lh:mll Il13:01|l
"01:02 PM"
"yyyy-mm-ddThh:mm" 1999-01-02T13:01

"yyyy-mm-ddThh:mm:ss" 1999-01-02T13:01:02

Duration ":day:hr:m" “52:03:01”
reads fifty-two days, three hours, and one
minute
":day:hr:m:s" “52:03:01:30”

reads fifty-two days, three hours, one minute,
and thirty seconds

"hr:m" “17:37”
reads seventeen hours and thirty-seven
minutes

"hr:m:s" “17:37:04”

reads seventeen hours, thirty-seven minutes,
and 4 seconds

"min:s" “37:04”
reads thirty-seven minutes and 4 seconds

Note: The following formats display the date-time according to your computer’s regional
settings. They are available only for the display of dates, not for date input in a data table.
Examples are shown for the United States locale.

Abbreviated "Date Abbrev" (Display only) “01/02/1999"
date
Long date "Date Long" (Display only) "Saturday, January 02, 1999"

Locale date “Locale Date” (Display only) “01/02/1999"
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Table 6.4 Date-Time Formats (Continued)

Type Format argument Example
Locale date “Locale Date Time h:m” (Display only) “01/02/1999 13:01* or
and time “01/02/1999 01:01 PM*
“Locale Date Time (Display only) “01/02/1999 13:01:02“ or
h:m:s” “01/02/1999 01:01:02 PM“

Custom Date-Time Formatting with Format Patterns

Format patterns are strings that define a date-time format. Here’s one example:
<YYYY></><MM></><DD> <hh><:><mm><:><ss><ampm>

The parts of the pattern in angle brackets are called field descriptors. They represent a value
(such as <YYYY>, which is a four-digit year) or other date-time text (such as </>, which is a
locale-specific date separator).

The conversion of a date-time value to a string and a string converted to a date-time value
work as follows:

¢ When a date-time value is converted to a string, the field descriptors are replaced by the
appropriate value or symbols.

* When a string is converted to a date-time value, a value is or matching symbols are
expected to be found where each field descriptor is. Anything outside a format descriptor
is treated as literal text. The literal text is replaced as-is when it is converted to a string, and
is expected to be found where specified when converting from a string.

Table 6.5 Output for Custom Date-Time Formats

Format Output
<YYYY></><MM></><DD> 2020/02/10 11:54:33 AM
<hh><:><mm><:><ss><ampm>

<DayOfWeek>, <Month> <D>, <YYYY> Wednesday, February 5, 2020
<Day>d <hh24>h <mm>m <ss>s 123d 02h 34m 56s

Note: <Day> is the day count, used as the most significant field of a duration. <Hour> and
<Minute> field descriptors are also available.
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Example of Outputting the Date-Time Value to the Log

The following script uses Informat () to read a string date-time value, defines the format
pattern used in that string, and returns the date in ddMonyyyy format. The script then outputs
the date-time value to the log.

dateval = Informat( "June 16, 2016", "Format Pattern", "<Month> <D>, <YYYY>"
);
16Jun2016

Here’s another way to specify the format pattern:

date2 = 16Jun2021;

dayofwk2 = Format( date2, "Format Pattern", "<DayOfWeek>" );
monthnew2 = Format( date2, "Format Pattern", "<Month>" );

YYYYMMDD = Format( date2, "Format Pattern", "<YYYY></><MM></><DD>" );
YYMMMDD = Format( date2, "Format Pattern", "<YY></><MMM></><DD>" );
"21/Jun/16"

Example of Changing the Input Format of a Column

The following script shows how to change the input format of a column. The Input Format
appears when you edit the value in a data table.

New Table( "temp_date",

Add Rows( 2 ),

New Column( "datel",
Numeric,
"Continuous",
// specify how the value appears in the data table
Format( "Format Pattern", "<Month> <D>, <YYYY>", 35 ),
// specify how the value appears when you edit the value
Input Format( "Format Pattern", "<YYYY>*<MM>*<DD>" ),
Set Values( {"2018+%10%31", "2018+%09%09"} )

),
New Column( "date2",
Numeric,
"Continuous",
Format( "Format Pattern", "<YYYY>*<MM>*<DD>", 10 ),
Set Values( {"2018%*02*05", "2018*07*03"} )
)

s

Note: See Using JMP for details about creating a format pattern in a data table rather than in a
script.
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Currency

JMP displays numbers as currency using the Format () function, which uses the following
syntax:

Format(x,"Currency", <"currency code">, <decimal>, < << Use Locale(Boolean));
Where:
® Xis a column or a number
e ‘"currency code"is an International Standards Organization (ISO) 4217 code
e decimalis the number of decimal places
To illustrate the Format function:

Format( 12345.6, "Currency", "GBP", 3 );
"£12,345.600"

By default, the operating system locale is used for the currency if the currency code symbol is
omitted. For example, running the following script in a Japanese operating system formats the
number with the yen symbol.

Format( 12345.6, "Currency", 3);
"¥12,345.600"

To ignore the computer’s locale and use a period for the decimal separator, include the Use
Locale(0) argument:

Format( 12345.6, "Currency", 3, <<Use Locale( 0 ) );

Tip: If you change the region when JMP is open, restart JMP for the Use Locale setting to
work properly.

If the currency code is not supported by JMP, the currency code string appears before the
number.

Format( 12345.6, "Currency", "BBD", 3 );
"BBD 12,345.600"

Table 6.6 lists the currencies supported in JMP.

Table 6.6 Currencies Supported in J]MP
Code Currency Code Currency Code Currency
AUD  Australian dollar ILS Israeli new shekel RUB  Russian ruble
BRL  Brazilian real INR  Indian rupee SEK  Swedish krone
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Table 6.6 Currencies Supported in JMP (Continued)

Code Currency

CAD Canadian dollar
CHF  Swiss franc

CNY  Chinese yuan
COP  Colombian peso
DKK  Danish krone
EUR  Euro

GBP  British pound
HKD Hong Kong dollar

Code Currency

JPY Japanese yen

KRW  South Korean won
MXN  Mexican peso

MYR Malaysian ringgit
NOK Norwegian krone
NZD New Zealand dollar
PHP  Philippine peso
PLN  Polish zloty

Code
SGD
THB
TRY
TWD
uUSD
ZAR

Currency
Singapore dollar
Thai baht

New Turkish lira
New Taiwan dollar
US dollar

South African rand

For more information about how to format currency, see “Formatting Numbers”.

Hexadecimal and BLOB Functions

JMP can also handle binary (large) objects, commonly called BLOBs. The functions below
convert between hexadecimal values, numbers, characters, and BLOBs. Some of the functions
are covered in more detail following Table 6.7.

See the JSL Syntax Reference

for more information.

Table 6.7 Hexadecimal and BLOB Functions

Syntax

Hex (" text™)
Hex (" num'")
Hex("bT1ob™)

Hex To
BLOB("hexstring")

Explanation

Returns the hexadecimal codes for the characters in text, number,

or blob.

Char To Hexis an alias.

Returns a BLOB representation of the hexadecimal code

supplied as a quoted string.



168 Types of Data Chapter 6
Hexadecimal and BLOB Functions Scripting Guide

Table 6.7 Hexadecimal and BLOB Functions (Continued)

Syntax Explanation

Hex To ] Returns a character string that corresponds to the hexadecimal

Char("hexstring", code supplied as a quoted string.

"encoding")
The default encoding for the character string is utf-8.
utf-161e, utf-16be, us-ascii, iso-8859-1, ascii~hex,
shift-jis, and euc-jp are also supported.

Hex to Number Returns the number that corresponds to the hexadecimal code
suppled as a quoted string.

Char To Converts a character string into a binary (BLOB).

BLOB("string™)

Char To The default encoding for the blob is utf-8. utf-161e, utf-16be,

BLOB("s?ring", us-ascii, is0-8859-1, ascii~hex, shift-jis, and euc-jp are

"encoding") also supported.

BLOB To Char("blob"™)  Converts binary data to a character string.

BLOB To Char("blob", , o
"encoding") The default encoding for the character string is utf-8.

utf-161e, utf-16be, us-ascii, 1s0-8859-1, ascii~hex,
shift-jis, and euc-jp are also supported.

BLOB Peek("blob", Returns a new BLOB that is a subset of the given BLOB that is
offset, length) length bytes long and begins at the offset. Note that the offset is
0-based.

Matrix to BLOB(matrix,  Makes a BLOB from a matrix by converting the matrix elements
type, bytesEach, to 1-byte, 2-byte, or 4-byte signed or unsigned integers or 4-byte

endian) or 8-byte floating point numbers.
BLOB to Matrix(blob, Creates a matrix by converting each byte in the b1ob to numbers.
"type", bytes,

"endian", <nCols>)

Hex(string) returns the hexadecimal codes for each character in the argument. For example,

Hex( "Abc" );
returns
"416263"

since 41, 62, and 63 are the hexadecimal codes (in ASCII) for “A”, “b”, and “c”.

Hex to Char(string) converts hexadecimal to characters. The resulting character string
might not be valid display characters. All the characters must be in pairs, in the ranges 0-9,
A-Z, and a-z. Blanks and commas are allowed, and skipped. For example,
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Hex To Char( "4142" );
returns
AR
since 41 and 42 are the hexadecimal equivalents of “A” and “B”.
Hex and Hex To Char are inverses of each other, so
Hex To Char( Hex( "Abc" ) );
returns
"Abc"
Hex To BLOB(string) takes a string of hexadecimal codes and converts it to a binary object.

a = Hex To BLOB( "6A6B6C" );
Show( a );
a = Char To BLOB("jk1", "ascii~hex")

BLOB Peek(blob,offset,Tength) extracts bytes as defined by the arguments from a blob.

b = BLOB Peek( a, 1, 2 );
Show( b );

b = Char To BLOB("k1", "ascii~hex")
b = BLOB Peek( a, 0, 2 );
Show( b );

b = Char To BLOB("jk", "ascii~hex")
b = BLOB Peek( a, 2 );
Show( b );

b = Char To BLOB("1", "ascii~hex')

Hex (b1ob) converts a blob into hexadecimal.

c = Hex( a );
Show( ¢ );

c = "6A6B6C"
d = Hex To Char( c );

Show( d );
d = ”jk]”
Concat(blobl,blob2) or blobl || bTob2 concatenates two blobs.
e = Hex To BLOB( "6D6E6F" );
Show( e );
f =alle;
Show( f );

e = Char To BLOB("mno", "ascii~hex")
f = Char To BLOB("jkImno", "ascii~hex")

Length(blob) returns the number of bytes in a blob.
g = Length( f );
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Show( g );
g==6

Note: When blobs are listed in the log, they are shown with the constructor function
Char To BLOB("...™).

Any hex code outside the ASCII range (space to }, or hex 20 - 7D) is encoded as the
three-character sequence [~][hexdigit][hexdigit]. For example,

h = Hex To BLOB( "19207D7E" );
Show( h );
i = Hex( h );
Show( i );
h = Char To BLOB("~19 }~7E", "ascii~hex")
i = "19207D7E"
Char To BLOB(string) creates a blob from a string, converting ~hex codes.
BLOB To Char(blob) creates a string with ~hex codes to indicate non-visible and non-ASCII
codes.

Work with Character Functions

This section shows how to use some of the more complex character functions that are
described in the JSL Syntax Reference.

Concat

In the Concat function, expressions yielding names are treated like character strings, but
globals that have the name values are evaluated. The following example demonstrates that if
you have a stored name value, you need to either use Char before storing it in a global, or Name
Expr on the global name.

n = {abc};

c =n[1] || "def";

Show( ¢ );
"abcdef"

m = Expr( mno );
c=m[] "xyz";
Show( c );
Name Unresolved: mno in access or evaluation of 'mno' , mno/*###%*/
// The /*###*/ characters indicate the Tocation of an error in the script

execution.

m = Expr( mno );
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c = Name Expr( m ) || "xyz";
Show( ¢ );
"mnoxyz"
m = Char( Expr( mno ) );
c=m || "XyZ";
Show( ¢ );
"mnoxyz"

Concat Items() converts a list of string expressions into a single string, with each item
separated by a delimiter. If unspecified, the delimiter is a blank. Its syntax is

resultString = Concat Items ({list of strings}, <“delimiter string”>);

171

For example,

a = {IIABCII’ IIDEFII’ llHIJll};
result = Concat Items(a, "/");

returns

"ABC/DEF/HIJ"
Alternatively,

result = Concat Items( a );
returns

"ABC DEF HIJ"

Munger

Munger works many different ways, depending on what you specify for its arguments:

Munger(string, offset, find | length, <replace>);

Table 6.8 Munger behaviors for various types of arguments

Find, length, and replace arguments

If you specify a string as the find and
specify no replace string, Munger returns
the position (after offset) of the first
occurrence find string.

If you specify a positive integer as the
Tength and specify no replace string,
Munger returns the characters from offset
to offset + length.

Example

Munger( "the quick brown fox", 1, "quick"
)
5

Munger( "the quick brown fox", 1, 5 );
”the q'l
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Table 6.8 Munger behaviors for various types of arguments (Continued)

Find, length, and replace arguments

If you specify a string as the find and
specify a replace string, Munger replaces
the first occurrence after offset of text with
replace.

If you specify a positive integer as the
length and specify a replace string,
Munger replaces the characters from of fset
to offset + Tength with replace.

If you specify a positive integer as the
length, and offset+ Tlength exceeds the
length of text, Munger either returns text
from offset to the end or replaces that
portion of text with the replace string, if
it exists.

If you specify zero as the Tength and
specify no replacestring, Munger returns a
blank string.

If you specify zero as the Tength and
specify a replace string, the string is
inserted before the offset position.

If you specify a negative integer as the
length value and specify no replace
string, Munger returns all characters from
the offset to the end of the string.

If you specify a negative integer for Tength
and specify a replace string, Munger
replaces all characters from the offset to the
end with the replace string.

Repeat

Example

Munger( "the quick brown fox", 1,
"quick"™, "fast" );
"the fast brown fox"

Munger( "the quick brown fox", 1, 5,
"fast");
"fastuick brown fox"

Munger( "the quick brown fox", 5, 25);
"quick brown fox"

Munger( "the quick brown fox", 5, 25,

"fast" );

"the fast"

Munger( "the quick brown fox", 1, 0 );

nm

Munger( "the quick brown fox", 1, 0, "see
"

"see the quick brown fox"

Munger( "the quick brown fox", 5, -5 );
"quick brown fox"

Munger( "the quick brown fox", 5, -5,
"fast" );
"the fast"

The Repeat () function makes copies of its first argument into a result. The second (and
sometimes a third) argument is the number of repeats, where 1 means a single copy.

If the first argument evaluates to a character value or list, the result is that many copies.

Repeat( "abc", 2 );
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"abcabc"
Repeat( {"A"}, 2 );
{"A","A"}
Repeat( {1, 2, 3}, 2 );
{1,2,3,1,2,3}

If the first argument evaluates to a number or matrix, the result is a matrix. The second
argument is the number of row repeats, and a third argument can specify the number of
column repeats. If only two arguments are specified, the number of column repeats is 1.

Repeat( [1 2, 3 41, 2, 3 );

[ 121212,
343434,
121212,
343434

Repeat( 9, 2, 3 );

[ 999,

99 9]

The repeat function is compatible with the function of the same name in the SAS/IML
language, but is incompatible with the SAS character DATA step function, which repeats one
more time than this function.

Substitute and Substitute Into

The Substitute() function returns a copy of a string with a replacement expression. The
Substitute Into() function changes the original string with a replacement expression.

For example, consider the following script:
strl = str2 = "All things considered";

// str3 holds the result of the Substitute, and strl is not changed
str3 = Substitute( strl, "AT1", "Some" );

/* Substitute Into returns nothing, so str4 is missing,

and str2 is changed and now holds the result of Substitute Into */
str4 = Substitute Into( str2, "AT1", "Some" );

Show( strl, str2, str3, str4 );

This script returns the following output:

strl = "All things considered";
str2 = "Some things considered";
str3 = "Some things considered";

str4 .y
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Regular Expressions

A regular expression is a specification of a pattern frequently used to clean up or extract
pieces of data. You can search for a pattern and replace it with a different string or extract
specific parts of the string. Define the pattern in the Regex() or Regex Match() function.

*  “Regex”

e “Regex Match”

* “Special Characters in Regular Expressions”
¢ “Escaped Characters in Regular Expressions”
® “Greedy and Reluctant Regular Expressions”
* “Backreferences and Capturing Groups”

e “Lookaround Assertions”

Regex
Regex () searches for a pattern within a source string and returns a string. It simply
identifies a pattern in a string or transforms a string into another string.

Regex(source, pattern, (<replacement string>, <GLOBALREPLACE>), <format>,
<IGNORECASE>) ;

IGNORECASE disregards case. GLOBALREPLACE repeats the match until the entire string is
processed. format is a backreference to the matched group. Regex() returns missing if the
match fails.

Example of Matching a String

bus|car is the regular expression (in quotation marks because it is a string). The expression
means match “bus” or “car”.

sentence = "I took the bus to work.";
vehicle = Regex( sentence, "bus|car" );
Ilbusll

Examples of Replacing a String

The third optional argument in Regex() is a specification of the result string. The default
value, \0, is a backreference to everything that was matched by the regular expression. In the
preceding example, the word “bus” is matched in sentence. The default third argument, \0,
replaces the entire sentence with “bus”.

A more interesting variation uses parentheses to create additional backreferences.
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sentence = "I took the bus to work.";
Regex( sentence, "(.*) bus (.*)", "\1 car \2" );
"T took the car to work."

The (.*) before and after bus are part of the regular expression. The parentheses create a
capturing group. The . matches any character. The * matches zero or more of the previous
expression. As a result, the first parenthesis pair matches everything before bus, and the

second parenthesis pair matches everything after bus. The third argument, \1 car \2,
reassembles the text; it leaves out bus and substitutes car.

See “Backreferences and Capturing Groups”.

Example of Global Replacement

GLOBALREPLACE changes the behavior of Regex (). If the match succeeds, the entire source
string is returned with substitutions made for each place where the pattern matches. If there
are no matches, an unchanged source string is returned.

sentence = "I took the red bus followed by the blue bus to get to work
today.";

Regex( sentence, "bus", "car", GLOBALREPLACE);
"I took the red car followed by the blue car to get to work today."

You can also use backreferences. This example starts with a different sentence.

sentence = "I took the red bus followed by the blue car to get to work
today.";
Regex (
sentence,
"Q\w*) (bus|car)",
"bicycle (not \2) that was \1",
GLOBALREPLACE
);
"I took the bicycle (not bus) that was red followed by the bicycle (not car)
that was blue to get to work today."
The \w* matches zero or more word characters and becomes backreference 1 because of the
parentheses. bus | car becomes backreference 2 because of the parentheses. The third
argument, bicycle (not \2) that was \1, describes how to build the substitution text for
the part of the source text that was matched.

Notice how the backreferences can be used to swap data positions. This might be useful for
swapping the position of first names and last names.
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Regex Match() returns an empty list with zero elements if the match fails. If the match
succeeds, the first list is the text of the entire match (backreference 0). The second list is the text
that matches backreference 1, and so on.

Regex Match(source, pattern, <replacement>|<MATCHCASE>, <NULL>)

Unlike Regex (), Regex Match() is case insensitive. Include MATCHCASE for a case-sensitive
match. Include NULL if you want to match case but there is no replacement text.

Example of Parsing Name-Value Pairs
The following example parses pairs of names and values.

Regex Match(
"person=Fred id=77 friend= favorite=tea",
"AwH)=O\S*) Qw)=A\S*) QAw+H)=(\S*) Qw+)=(\S*)"
)
{"person=Fred id=77 friend= favorite=tea"”, "person", "Fred", "id", "77",
"friend", "", "favorite", "tea'}
The \w+ matches one or more word characters. The \S* matches zero or more characters that
are not spaces. In the resulting JSL list, the field names (person, id, friend, favorite)
and their corresponding values (Fred, 77, "", tea) are separate strings.

If the first argument to Regex Match() is a variable and a third argument specifies the
replacement value, the matched text is replaced in the variable.

Comparing Regex and Regex Match

Regex() and Regex Match() match a pattern in a given string but return different results. To
transforms your string into another string, use Regex(). To identify the substrings that match
specific parts of the pattern, use Regex Match().

This example shows the efficiency of Regex Match() compared to Regex(). The sourceis a
list of six strings. The goal is to extract portions of those six strings into the subject, verb, and
object columns of a data table.

Figure 6.4 Final Data Table

subject verb  object
cat ate chicken
dog chased cat
ralph like mary
girl pets dog

L R o B

cat chased dog
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source = {"the cat ate the chicken", "the dog chased the cat", "did ralph 1like
mary", "the girl pets the dog",
"these words are strange", '"the cat was chased by the dog"};

dt = New Table( "English 101", // create the data table
New Column( "subject", character ),
New Column( "verb", character ),
New Column( "object", character )

J;

// iterate through the strings in the Tist

For( i =1, i <= N Items( source ), i++,

// assign the result of each match to matchList
matchList = Regex Match(
sourcel[i],

/* scan each string, match zero or more characters
and one item in each group */

".*?(cat|dog|ralph|girl).*?(ate|chased|Tike|pets).*?(chicken|cat|mary|dog)

)

/* If matchList has zero items (string 5), don’t add a row
to the table. Put each matched string in separate
data table cells. */
If( N Items( matchList ) > 0,
dt << Add Rows( 1 );
dt:subject = matchList[2]; // match the first open parenthesis
dt:verb = matchList[3]; // match the second open parenthesis
dt:object = matchList[4]; // match the third open parenthesis
);
s
Regex Match() returns {"the cat was chased by the dog", "cat", "chased", "dog"}
in a single try with each answer in a separate string. Compare this example to a similar one
using Regex() , which returns one answer at a time and builds the final string using
backreferences.

For( i = 1, i <= N Items( source ), i++,
s = Regex( source[i],
".*?(cat|dog|ralph|girl).*?(ate|chased|1ike|pets).*?(chicken|cat|mary]|dog)
", "\1" ); // match an item in the first group
v = Regex( source[i],
".*?(cat|dog|ralph|girl).*?(ate|chased|1ike|pets).*?(chicken|cat|mary]|dog)
", "™\2" ); // match an item in the second group
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o = Regex( sourcel[i],
".*?(cat|dog|ralph|girl).*?(ate|chased|Tike|pets).*?(chicken|cat|mary|dog)
", "\3" ); // match an item in the third group
If( 'Is Missing( s ) & !Is Missing( v ) & !Is Missing( o ),

dt << Add Rows( 1 );

dt:subject = s; // return the match for \1

dt:verb = v; // return the match for \2

dt:object = o; // return the match for \3

);
);

Backreferences are discussed in “Backreferences and Capturing Groups”.

Special Characters in Regular Expressions

Special characters are commonly used in regular expressions. The period is a special character
that matches one instance of the specified character. It must be escaped with a backslash to be
interpreted as a period. In the following expression, the period is replaced with an
exclamation point.

Regex( "Bicycling makes traveling to work fun.", "\.", "!", GLOBALREPLACE );
"Bicycling makes traveling to work fun!"

Table 6.9 describes the special characters and provides examples.

Table 6.9 Special Characters in Regular Expressions

\ e Precedes a literal character.
<\/a> interprets the forward slash literally in the end HTML anchor tag.
* Precedes an escape sequence.

\h matches a newline character.
A Matches the beginning of a string, not including the newline character.
Aapple matches “apple” at the beginning of a string.
$ Matches the end of a string, not including the newline character.
apple$ matches “apple” at the end of a string.
Matches any single character including a newline character.
.apple matches any single character and then “apple”.
Represents a logical OR to separate alternative values.

i

(apple|orange|banana) matches “apple”, “orange”, or “banana”.
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Table 6.9 Special Characters in Regular Expressions (Continued)

?

)

[]

{3

Matches zero or one instance.

apple (pie)? matches one or more instances of “pie”.
Matches zero or more instances.

Matches one or more instances.

Encloses a sub-expression.

(apple|orange|banana) matches “apple”, “orange”, or “banana”.

A(\w+) matches the beginning of a line and then one or more word
characters.

Encloses an expression that matches set of characters.

[\s] matches a whitespace character or a digit.

[a-z0-9] matches “a” through “z” and numbers “0” through “9”.
Encloses an expression that represents repetition.

apple{3} repeats three times.

apple{3,} repeats at least three times as many times as possible.
apple{3, 10} repeats three times but no more than 10 times.

Append a question mark to indicate repeating as few times as possible. For
example, apple{3, }? repeats at least three times as few times as possible.

Escaped Characters in Regular Expressions

The backslash in a regular expression precedes a literal character. You also escape certain
letters that represent common character classes, such as \w for a word character or \s for a
space. The following example matches word characters (alphanumeric and underscores) and

spaces.

Regex(

"Are you there, Alice?, asked Jerry.", // source
"(here|there) .+(\w+) .+(said|asked) (\s) A\w+)\." ); // regular expression
"there, Alice?, asked Jerry."

(here|there) .+ Matches “there”, a comma, and a space.

Aw+)

Matches “Alice”.
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.+

(said|asked) (\s)

AwH)\.

Matches “?, “.

Chapter 6
Scripting Guide

Matches “asked” followed by a space. Without the space, the
match would end here; “asked” is followed by a space in the

source string.

Matches “Jerry” and a period.

Table 6.10 describes the escaped characters supported in JMP. \C, \G, \X, and \z are not

supported.

Table 6.10 Escaped Characters

\\
\A
\b

\B
\cX
\d
\D
\E
\1
\L
\Q
\r
\s
\S
\u
\U
\w
\W

single backslash

start of a string

word boundary. The zero-length string between \w and \W or \W

and \w.

not at a word boundary

ASCII control character

single digit [0-9]

single character that is NOT a digit [A0-9]
stop processing escaped characters

match a single lowercase letter [a-z]

single character that is not lowercase [Aa-z]
ignore escaped characters until \ E is found
carriage return

single whitespace character

single character that is NOT white space
single uppercase character [A-Z]

single character that is not uppercase [AA-Z]

word character [a-zA-Z0-9_]

single character that is NOT a word character [Aa-zA-Z0-9_]
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Table 6.10 Escaped Characters (Continued)

\x00-\xFF hexadecimal character
\x{0000}-\x{FFFF}  Unicode code point

\Z end of a string before the line break

Greedy and Reluctant Regular Expressions

The ?, *, and + operators are greedy by default. They match as many of the preceding

181

character as possible. The ? operator makes them reluctant; ?? matches 0, then 1 if needed; +?

matches 1 and then additional characters; *? matches 0 and then additional characters.

The following example starts at the letter n and compares it to the first \d (digits) in the

pattern. No digit matches. Because the pattern does not begin with A (start of line), the

matcher advances to u. The process repeats until the 3 matches the first \d and the 2 matches

the second \d.
Regex( "number=32.5", "\d\d" );
"32”

Change the pattern to use the greedy + (match one or more).

Regex( "number=324.5", "\d+" );
"324"

The preceding example begins much the same, but as soon as the 3 is found and the \d

matches, the + greedily matches the 2 and the 4.

Usually, the greedy behavior makes pattern matching faster because the string is consumed
sooner. Sometimes a reluctant behavior is better. Adding the ? after the * or + changes them

from greedy to reluctant.

Regex( "number=324.5", "\d+?" );
"3"

Here, + requires at least one match of a digit character, but ? changes it from “as many as
possible” to “as few as possible”. It stopped after the 3 because the pattern was satisfied.

Compare the following results.
Greedy:

Regex( "number=324.5", "(\d+) \d\.", "first=\1 second=\2" );
"first=32 second=4"

Reluctant:

Regex( "number=324.5", "(\d+?) (\d+?)\.", "first=\1 second=\2" );
"first=3 second=24"
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In the greedy example above, the matcher greedily matched 3, 2, and 4 for the first \d+. The
matcher then had to give back the 4 so that the second \d+ could match something. The
reluctant example followed a different path to get a different answer. Initially, the second
value was 2, but the pattern could not match the period to the 4, so the second \d+?
reluctantly matched the 4 as well.

Use the Reluctant Match for Speed

The greedy and reluctant matches usually produce the same result but not always. See the
previous section. One reason you might need the reluctant match is for speed. Suppose that
you have a million-character string that begins “The quick fox...” and you want to find the
word before “fox”. You might write the following expression and expect \1 to contain
“quick”.

The (.+) fox

\1 might contain “quick” eventually, after the .+ grabs the million characters to the end of the
string and then gives them up, one at a time, until “fox” is found. If there is more than one
“fox”, it will be the last fox, not this one. To speed it up and make sure we get the first fox, add
the ? operator.

The (.+?) fox

The ? advances one character at a time to get past “quick” and find the first “fox”. This
method is much faster than going too far.

Typically, the + or * operator is applied to a more restrictive expression such as \d* to match a
run of digits, and greedy is faster than reluctant.

Aside from the multiple fox possibility, greedy and reluctant eventually get the same answer.
Using the right operator speeds up the match. The right one might be greedy, or it might be
reluctant. It depends on what is being matched.

The greedy . * finds the last fox after backing up.

Regex(
"The quick fox saw another fox eating grapes",
"The (.*) fox",
ll\lll

)3

"quick fox saw another"

The reluctant . *? stops on the first fox.

Regex (
"The quick fox saw another fox eating grapes",
"The (.*?) fox",
ll\lll

J;

"qu_ick "
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The greedy . * has to back up a lot. There is no second fox.

Regex(
"The quick fox saw another animal eating grapes",
"The (.*) fox",
ll\lll
)3
"quick"

The greedy word character match is an even better choice for this problem.

Regex (
"The quick fox saw another fox eating grapes",
"The (\w*) fox",
ll\lll

J;

"qu_ick "

Backreferences and Capturing Groups

A regular expression can consist of patterns grouped in parentheses, also known as capturing
groups. In ([a-zA-Z])\s([0-9]), ([a-zA-Z]) is the first capturing group; ([0-9]) is the
second capturing group.

Use a backreference to replace the pattern matched by a capturing group. In Perl, these groups
are represented by the special variables $1, $2, $3, and so on. ($1 indicates text matched by the
first parenthetical group.) In JMP, use a backslash followed by the group number (\1, \2, \3).

The following example includes a third argument that specifies the replacement text and
backreferences.

Regex (

" Are you there, Alice?, asked Jerry.", // source

" (here|there).+ (\w+).+(said|asked) (\w+)\.", // regular expression
" I am \1, \4, replied \2." ); // optional format argument

" I am there, Jerry, replied Alice."

"I am \1, Creates the text “I am”, a space, and then the first matched
pattern, “there”.

\4, Creates the text “Jerry” with the fourth matched pattern
Aw).
replied \2." Creates the text “replied” and a space. Matches “Alice.” with

the second matched pattern (\w+).
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Lookaround Assertions

Lookaround assertions check for a pattern but do not return that pattern in the results.
Lookaheads look forward for a pattern. Lookbehinds look back for a pattern.

Negative Lookahead Example

Negative lookaheads check for the absence of a pattern before a specific pattern. 7! indicates a
negative lookahead. The following expression matches a comma not followed by a number or
space and replaces the pattern with a comma and space:

Regex( "one,two 1,234 cat,dog,duck fish, and chips, to go",
"L (?INd|\s)", ", ", GLOBALREPLACE );
"one, two 1,234 cat, dog, duck fish, and chips, to go"

Positive Lookahead Example

Positive lookaheads check for the presence of a pattern before a specific pattern. ?=indicates a
positive lookahead. The following expression has the same result as the preceding negative
lookahead but matches a comma followed by any lowercase character:

Regex( "one,two 1,234 cat,dog,duck fish, and chips, to go",
", (?=[a-z])", ", ",GLOBALREPLACE );
"one, two 1,234 cat, dog, duck fish, and chips, to go"

Positive Lookbehind Example

In this example, the positive lookbehind regular expression matches the “ssn=" or “salary="
keywords without including the keyword in the matched text. The matched text is the string
of characters that consists of zero or more dollar signs, digits, and hyphens.

data = "name=bil1l salary=$5 ssn=123-45-6789 age=13,name=mary salary=$6
ssn=987-65-4321 age=14";

redacted = Regex(data, "(?<=(ssn=)|(salary=))[$\d-]1*", "###", GLOBALREPLACE);
"name=bi11 salary=### ssn=### age=13,name=mary salary=### ssn=### age=14"

Here is another way to get the same result using a backreference substitution.
((ssn=) | (salary=)) is the capturing group. "\1" is the backreference to that group.

data = "name=bil1l salary=$5 ssn=123-45-6789 age=13,name=mary salary=$6
ssn=987-65-4321 age=14";

redacted = Regex(data, "((ssn=)|(salary=))[$\d-1*", "\1###", GLOBALREPLACE);
"name=bi11 salary=### ssn=### age=13,name=mary salary=### ssn=### age=14"

Backreferences are discussed in “Backreferences and Capturing Groups”.
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Pattern Matching

Pattern matching in JSL is a flexible method for searching and manipulating strings.
You define and use pattern variables just like any JMP variable:

= 3; // a numeric variable
"Ralph"; // a character variable
textbox("Madge"); // a display box variable
( "this" | "that" ) + patSpan(" ")

+ ( "car" | "bus" ); // a pattern variable

T t v -
o

When the above statement executes, p is assigned a pattern value. The pattern value can be
used either to construct another pattern or to perform a pattern match. The patSpan function
returns a pattern that matches a span of characters specified in the argument;
patSpan("0123456789") matches runs of digits.

p2 = "Take " + p + ; // using p to build another pattern
If( Pat Match( "Take this bus.", p2 ), // performing a match
Print( "matches" ),
Print( "no match" )

)

Sometime all you need to know is that the pattern matched the source text, as above. Other
times, you might want to know what matched; for example, was it a bus or a car?

p = ("this" | "that") + Pat Span( " " ) + ("car" | "bus™) >?
vehicleType; // conditional assignment ONLY if pattern matches
If( Pat Match( "Take this bus.", p ),

// do not use vehicleType in the ELSE because it is not set

Show( vehicleType ),

Print( "no match" )

);

You could pre-load vehicleType with a default value if you do not want to check the outcome
of the match with an if. The >? conditional assignment operator has two arguments, the first
being a pattern and the second a JSL variable. >? constructs a pattern that matches the pattern
(first argument) and stores the result of the match in the JSL variable (second argument) after
the pattern succeeds. Similarly, >> does not wait for the pattern to succeed. As soon (and as
often) as the >> pattern matches, the assignment is performed.

findDelimString = Pat Len( 3 ) >> beginDelim + Pat Arb() >? middlePart
+Expr( beginDelim );

testString = "SomeoneSawTheQuickBrownFoxJumpOverThelLazyDog'sBack";

rc = Pat Match( testString, findDelimString, "<<<" || middlePart || ">>>" );
Show( rc, beginDelim, middlePart, testString );
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The above example shows a third argument in the patMatch function: the replacement string.
In this case, the replacement is formed from a concatenation (| | operator) of three strings. One
of the three strings, middTePart, was extracted from the testString by >? because the
replacement cannot occur unless the pattern match succeeds (rc == 1).

Look at the pattern assigned to findDelimString. It is a concatenation of 3 patterns. The first
is a >> operator that matches 3 characters and assigns them to beginDel1im. The second is a >?
operator that matches an arbitrary number of characters and, when the entire match succeeds,
assigns them to middTePart. The last is an unevaluated expression, consisting of whatever
string is in beginDelim at the time the pattern is executing, not at the time the pattern is built.
Just like expr (), the evaluation of its argument is postponed. That makes the pattern hunt for
two identical three letter delimiters of the middle part.

Other pattern functions might be faster and represent the problem that you are trying to solve
better than writing a lot of alternatives; for example, "a" |"b" [ "c" is the same as Pat

Any("abc™). The equivalent example for Pat Not Any("abc™) is much harder. Similar to Pat
Span (above), Pat Break("0123456789") matches up to, but not including, the first number.

Here is a pattern that matches numbers with decimals and exponents and signs. It also
matches some degenerate cases with no digits; look at the pattern assigned to digits.

digits = Pat Span( "0123456789" ) | "";

number = (Pat Any( "+-" ) | "") >? signPart + (digits) >? wholePart + ("."
+digits | "") >? fractionPart + (Pat Any( "eEdD" ) + (Pat Any( "+-" ) | "™)
+ digits | "") >? exponentPart;

If( Pat Match( "-123.456e-78", number ),
Show( signPart, wholePart, fractionPart, exponentPart )

);

Parsing Strings in Fixed Fields

Sometimes data is in fixed fields. The Pat Tab(), Pat R Tab(), Pat Len(), Pat Pos(), and
Pat R Pos() functions make it easy to split out the fields in a fixed field string. Pat Tab()
and Pat R Tab() work from the left and right end of the string and take a number as their
argument. They succeed by matching forward to the specified tab position. For example:

p = Pat Pos(10) + Pat Tab(15);

Pat Pos(10) matches the null string if it is in position 10. So at match time, the matcher works
its way forward to position 10, then Pat Tab(15) matches text from the current position (10)
forward to position 15. This pattern is equivalent to Pat Pos(10)+patLen(5). Another
example:

p = Pat Pos(0) + Pat R Tab(0);
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This example matches the entire string, from 0 characters from the start to 0 characters from
the end. the Pat Rem() function takes no argument and is shorthand for Pat R Tab(0); it
means the remainder of the string. Pattern matching can also be anchored to the beginning of
the string like this:

Pat Match( "now is the time", Pat Len(15) + Pat R Pos(0), NULL, ANCHOR );

The above pattern uses NULL rather than a replacement value, and ANCHOR as an option. Both
are uppercase, as shown. NULL means that no replacement is done. ANCHOR means that the
match is anchored to the beginning of the string. The default value is UNANCHORED.

Patterns can be built up like this, but this is not recursive:

= "a" | "b"; // matches one character

p + p; // two characters

= p + p; // four characters

at Match( "babb", Pat Pos(0) + p + Pat R Pos(0) );

T T T O

A recursive pattern refers to its current definition using ExprQ):

p = "<" + Expr(p) + + Expr(p) + ">" | "x";
Pat Match( "<<x*<x*x>>*x>", Pat Pos(0) + p + Pat R Pos(0) );

myn

Remember, expr() is the procrastination function; when the pattern is assigned to the
variable p, expr () delays evaluating its argument (p) until later. In the next statement,
patMatch performs the pattern match operation, and each time it encounters expr(), it looks
for the current value of the argument. In this example, the value does not change during the
match). So, if p is defined in terms of itself, how can this possibly work?

p consists of two alternatives. The right hand choice is easy: a single letter x. The left side is
harder: <p*p>. Each p could be a single letter X, since that is one of the choices p could match,
or it could be <p*p>. The last few example have used patPos(0) + ... + patRPos(0) to
make sure the pattern matches the entire source text. Sometimes this is what you want, and
sometimes you would rather the pattern match a subtext. If you are experimenting with these
examples by changing the source text, you probably want to match the entire string to easily
tell what was matched. The result from Pat Matchis 0 or 1.

This example uses “Left” recursion:
x = Expr(x) + "a" | "b"; // + binds tighter than |

If the pattern is used in FULLSCAN mode, it eventually uses up all memory as it expands. By
default, the patMatch function does not use FULLSCAN, and makes some assumptions that
allow the recursion to stop and the match to succeed. The pattern matches either a “b”, or

"

anything the pattern matches followed by an “a”.

rc = Pat Match( "baaaaa", x );
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Patterns and Case

Unlike regular expressions, pattern matching is case insensitive. To force case sensitivity, you
can add the named argument MATCHCASE to either Pat Match() or Regex Match(). For
example:

string = "abcABC";

result = Regex Match( string, Pat Regex( "[aBc]+" ) );
Show( string, result );

/ *returns string = "abcABC"
result = {"abcABC"}*/

result = Regex Match( string, Pat Regex( "[cba]l+" ), NULL, MATCHCASE );
Show( string, result );

/* returns string = "abcABC"
result = {"abc"}*/

Troubleshooting Patterns

When a pattern isn’t working the way you expect, use Log() to send pieces of the match to the
JMP log. The following example shows how to debug pattern matching and rewrite a script to
account for the white space between words in the phrase “the quick brown fox”.

// greedy match for one or more characters except for white space
word = Pat Repeat( Pat Not Any( " " ) );

Pat Match(
"the quick brown fox",
word >> a +
word >> b +
word >> c +

word >> d
s
Show( a, b, c, d);
a = "qu”,
b = ”7'"’
C = ,,C”;
d = "k";

The output is probably not what you want, given the name of the pattern word. None of the
words in the pattern were matched.

The Show( a, b, c, d ) expressionis a good first step. If it doesn’t tell you how JMP got that
answer, try inserting Log():

word = Pat Repeat( Pat Not Any( " " ) );
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Pat Match(
"the quick brown fox",
(word >> a) >> Log( "a"
(word >> b) >> Log( "b"

(word >> ) >> Log( "c
(word >> d) >> Log( "d"

+ + +

A A

);

Show( a, b, ¢, d );
0(a) the (the number 0 is the position of the match)

0(a) th (the “a” is an aribtrary identifier you supplied to the log)

2(b) e

zlll(é) quick
4(a) quic

With this extra information, you can now see into the workings of the match, how the word
pattern does, in fact, match a word, at least initially. But then it backs up and tries a smaller
amount of the word so that the next word pattern can match some non-whitespace characters.
However, there’s no provision in this pattern to match the white space between words. And
that’s exactly what it did (find four consecutive words of one or more non-whitespace
characters). Maybe the following script is what you need:

word = Pat Repeat( Pat Not Any( " " ) );
gap = Pat Repeat( Pat Any( " " ), 1, 999, GREEDY );

Pat Match(
"the quick brown fox",
word >> a + gap +
word >> b + gap +
word >> c + gap +

word >> d
s
Show( a, b, c, d);
a = "the";
b = "quick";
c = "brown";
d = "fox";
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Chapter 7

Data Structures
Working with Collections of Data

JSL provides these basic data structures that can hold a variety of data in a single variable:

* A list holds a number of other values, including nested lists and expressions.

* A matrix is a row-by-column table of numbers.

* An associative array maps keys to values, which can be almost any other type of data.
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Lists

Lists are containers to store items, such as the following:

e numbers

e variables

® character strings

* expressions (for example, assignments or function calls)
® matrices

* nested lists

Create a list in one of the following ways:

e use the List function

e use { } curly braces

Examples
Use the List() function or curly braces to create a list that includes numbers and variables:

List(1l, 2, b);
{1, 2, b};

X
X

A list can contain text strings, nested lists, and function calls:
{"Red", "Green", "Blue", {1, "true"}, sqrt( 2 )};
You can place a variable into a list and assign it a value at the same time:

x={a=1, b =2};

Evaluate Lists

When you run a script that contains a list, a copy of the list is returned. The items inside the
list are not evaluated.

b=7;
x = {1, 2, b, Sqrt( 3 )};
Show( x );

X = {11 21 bl Sqf't(3)};
To evaluate items in a list, use the Eval List() function.
b=7;
x ={1, 2, b, Sqrt( 3 )};

c Eval List( x );
{1, 2, 7, 1.73205080756888}
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When using a list of variables that reference lists, you will need to use an Eval() function.

Consider the following example, where you have a variable called fullMonth that is a list of 12
items.

::fullMonth = {January, February, March, April, May, June, July, August,
September, October, November, December};

::abbrevMonth = {Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec};

::dow = {Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday};

::levels = {Very Low, Low, Medium Low, Medium, Medium High, High, Very High};

::feel = {Strongly Disagree, Disagree, Neutral, Indifferent, Agree, Strongly
Agree};

::rating = {Failing, Unacceptable, Very Poor, Poor, Bad, Acceptable, Average,
Good, Better, Very Good Excellent, Best},

::mlist = {::fullMonth, ::abbrevMonth, ::dow, ::levels, ::feel, ::rating};

N Items(::fullMonth); // returns 12 because fu11Month has 12 items.

N Items(::mlist[1]); /* returns this message: "N Items() argument must be a
Tist" because ::mlist[1l] is a variable (fullMonth) and fullMonth is a
Tist.*/

When you add the Eval() function:

N Items( Eval( ::mlist[1] ) );

12
/* returns 12 because::mlist[1] holds ::fullMonth, and evaluating it

returns ::fullMonth's Tist.*/

In a loop, you need the Eval () function in the nested loop to evaluate the variable’s contents.
For example:

For(C g = 1, g <= N Items( ::mlist ), g++,
For( i =1, i <= N Items(::mlist[g]), i++,
Show( ::mlist[g][i] )
)
J;

// returns the message "N Items() argument must be a Tist."
To fix the problem, add the Eval() function:

::mlist = {::fullMonth, ::abbrevMonth, ::dow, ::levels, ::feel, ::rating};
ForC g = 1, g <= N Items( ::mlist ), g++,
For( i =1, i <= N Items( Eval( ::mlist[g] ) ), i++,
Show( ::mlist[g][i] )
)
J;
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Assignments with Lists
Create a list to assign values to variables.

Examples

{a, b, ¢} = {1, 2, 3}; // assign 1 to a, 2 to b, and 3 to c

{a, b, c}--; // decrement a, b, and c

{{a}, {b, c}}++; // increment a, b, and c by 1

mylist = {1, Tog( 2 ), eQApi(), height[40]}; // store the expressions

Perform Operations in Lists

In lists, you can perform operations.

a = {{1, 23}, 3, {4, 5}};
b = {{10, 20}, 30, {40, 503}};
c=a+ b;

c = {{11, 22}, 33, {44, 55}}

Find the Number of Items in a List

To determine the number of items in a list, use the N Items() function.

x = {1, 2, y, Sqrt( 3 ), {a, b, 3}};

N =N Items( x );

Show( n );
n=2>5;
Subscripts

Data Structures
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Subscripts extract specified items from a list. Use a list as a subscript to return multiple items

from a list.

Note: JSL starts counting from 1, so the first element in a list is [1], not [0] as in some other

languages.

Examples

List a contains four items.

a = {"bob", 4, [1, 2, 31, {x, y, z}};

Show( a[1l] );
al1] = "bob";
Show( al[{1, 33}] );
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a[{1, 3}] = {"bob", [1, 2, 3]};
af[2] = 5; // assign 5 to the second list item

You can also use subscripts to select or change items in a list:

Show( a );
a = {"bob", 5, [1, 2, 31, {x, y, z}};

c={1, 2, 3}

c[{1, 231 = {4, 4};
// c[{1, 2}] = 4 produces the same result

Show( c );
c=14, 4, 3};
When you have assignments or functions in a list, you can use a quoted name for the subscript

to extract the value.
x={sqrt( 4 ), Tog( 3 )};
xx={a =1, b =3, c =5};
X["Sqrt"] ;
4
XX [nbn] ;
3
The name must be in quotation marks, or else JMP tries to evaluate it and use its value. The

following example shows the values of the second item in the list, rather than the value of a in

the list.

a=2;
Show( xx[a] );
xx[a] = b = 3;

Notes:
Multiple left-side subscripts (for example, a[i][j] = value where a contains a list of

things that are subscriptable) are allowed in the following circumstances:
— Each level except the outermost level must be a list. So, in the example above, a must be

a list but a[i] can be anything subscriptable.
— Each subscript except the last must be a number. So, in the example above, i must be a

number, but j could be a matrix or list of indices.

Subscripting can be done to any level of nesting, such as the following:

L]
alil[31CkI (1T [m][n] = 99;
Note: To get a value in the matrix of an expression column, use double subscripts, as in

:Discrim Data Matrix[row(Q)][i].
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Locate Items in a List

Use the Loc() function or the Contains () function to find values in a list:

Loc( Tist, value );
Contains( 1ist, value );

Loc() and Contains () return the positions of the values. Loc() returns the results in a
matrix, and Contains () returns the results as a number.

Notes:

¢ The Loc function returns each occurrence of a repeated value. Contains() returns only
the first occurrence of a repeated value.

e If the value is not found, the Loc function returns an empty matrix and Contains()
returns a zero.

e To assess whether an item is in a list, use Loc () and Contains() with >0. A returned value
of zero means that the item is not in the list. A returned value of 1 means that the item is in
the list at least once.

Note: For more information about matrix manipulation and a description of the equivalent
Loc() command for matrices, see “Matrices”.

Examples

namelList = {"Katie", "Louise", "Jane", "Jane"};
numList = {2, 4, 6, 8, 8};

Search for the value "Katie" in the nameList:

Loc( nameList, "Katie" );

[1]

Contains( nameList, "Katie" );
1

Search for the value "Erin" in the namelList:

Loc( nameList, "Erin" );

[1

Contains( nameList, "Erin" );
0

Search for the number 8 in the numList:

Loc( numList, 8 );
[4, 51

Contains( numList, 8 );
4

Find out if the number 5 exists in the numList:
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NRow( Loc( numList, 5 ) ) > 0;
0

Contains( numList, 5 ) > 0;
0

List Operators and Functions

Table 7.1 describes the list operators and their syntax.

Table 7.1 List Operators

Operator and Function Syntax Explanation

As List(Q As List(matrix) Returns the matrix as a list. A matrix
with multiple columns is returned as
a list of lists, one list per row.

= Assign() {list} = {1ist} If the target of an assignment
+=  Add ToQ) { 77:5 T} += va?ue operator is a list and the value to be
= SubtractToQ) {list} = {Iist} assigned is a list, then it assigns item
- MultiplyTo(Q e by item. The ultimate values in the
. 21' V:I'cdeTO O left list must be L-values (in other
os

- words, names capable of being

Increment() assigned values).
Post
Decrement() Notes:
e If you want to test equality of
lists, use ==, not =.
* JMP does not have pre-increment
or pre-decrement operators.
Instead, use the Add To(Q)
operator, which is (+=), or the
Subtract To() operator, which
is (-=).
|l= Concat To() Concat To(listl, Inserts the second and subsequent
Tist2, ... lists at the end of the first list.
[ Concat() Concat(1istl, 1ist2, Returns a copy of the first list with
Sk any additional lists inserted at after

it.
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Table 7.1 List Operators (Continued)

Operator and Function Syntax
Eval List(Q) Eval List(1ist)
Insert Into() Insert Into(]ist, X,
<7>)
Insert() 1ist = Insert(list,
X, <1>)
Is List(Q) Is List(arg
{1} List List(a, b, ©
{a, b, &t
N Items N Items(1ist)
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Explanation

Returns a list of the evaluated
expressions inside list. See “Evaluate
Lists”.

Inserts a new item (X) into the 17st
at the given position (7). If 7is not
given, the item is added to the end of
the list. This function does change
the original list.

Returns a copy of the 17st witha
new item (X) inserted into the 17st
at the given position (7). If 7is not
given, the item is added to the end of
the list. This function does not
change the original list.

Returns true (1) if argis a classical
list (in other words, one that would
result from the construction by
List(items) or {items}) and
returns false (0) otherwise. An empty
list is still a list, so IsList({ })
returns true. If miss=., then
IsList(miss) returns false, not
missing.

Constructs a list from a set of items.
An item can be any expression,
including other lists. Items must be
separated by commas. Text should
either be enclosed in double
quotation marks (" ") orstoredina
variable and called as that variable.

Returns the number of elements in
the 17st specified. Can be assigned
to a variable.
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Table 7.1 List Operators (Continued)

Operator and Function

Remove From()

Remove ()

Reverse Into()

Reverse()

Shift Into()

ShiftQ

Sort Ascending()

Syntax

Remove From(]ist,
<>, <m>)

Remove(17st, <i>,
<n>)

Reverse Into(]ist)

Reverse(1ist)

Shift Into(1ist, <n>)

Shift(1ist, <n>)

Sort Ascending(1ist)

Chapter 7
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Explanation

Deletes nitems from the 17st,
starting from the indicated position
(7). If nis omitted, the item at 7 is
deleted. If nand 7 are omitted, the
item at the end is removed. This
function does change the original list.

Returns a copy of the 17st with the
nitems deleted, starting from the
indicated position (7). If nis omitted,
the item at 7 is deleted. If nand 7 are
omitted, the item at the end is
removed. This function does not
change the original list.

Reverses the order of the items in the
11st. This function does change the
original list.

Returns a copy of the 17st with the
items in reverse order. This function
does not change the original list.

Shifts nitems from the front of the
1istto the end of the 1ist. If nis
omitted, the first item is moved to the
end of the list. This function does
change the original list.

Returns a copy of the 17st with n
items shifted from the front of the list
to the end of the 17st. If nis omitted,
the first item is moved to the end of
the list. This function does not
change the original list.

Returns a copy of the 17st sorted in
ascending order. This function does
not change the original list.
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Table 7.1 List Operators (Continued)

Operator and Function Syntax Explanation
Sort Sort Descending(17st) Returns a copy of the TSt sorted in
Descending()

descending order. This function does
not change the original list.

Sort List Into() Sort List Into(17st)  Sortsthe 77stin ascending order.
This function does change the
original list.

Sort List() Sort List(11st) Returns a copy of the 17st sorted in
ascending order. This function does
not change the original list.

[ 1 SubscriptQ Tistlil Subscripts for lists extract the 7!
x = T1st[7] item from the 717st. Subscripts can in

Tist[i] = value turn be lists or matrices.
arb, cl

Subscript(a, b, ©

Substitute() Substitute(T7st, Returns a copy of a string, list, or
pattExpril, expression, replacing instances of
replExprl, ...) ; .
each pattern expression with the
corresponding replacement
expression. See “Substitute and
Substitute Into”.

Substitute Substitute Into(717st, Changes a string, list, or expression,
IntoQ pattExpril, replacing instances of each pattern
replExprl, ...) . . .

expression with the corresponding
replacement expression. Note: The
17st or expression must be a
variable. See “Substitute and
Substitute Into”.

Iterate through a List

Iterate through a list to do something with each value or look for a particular value. The
following script looks at each item in the list. If the item in the list is less than or equal to 10, it
is replaced with its square.

x = {2, 12, 8, 5, 18, 25};
n =N Items( x );
ForCi =1, i <= n, i++,
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If( x[i] <= 10,
x[i] = x[i] A 2
)
s
Show( x );
x = {4, 12, 64, 25, 18, 25};

You can use Loc () to locate the items in the new list that are equal to 25:

Loc( x, 25 );
[4, 6] // The fourth and sixth items in the list are equal to 25.

Concatenate Lists

Join two or more lists into one list using Concat() or the | | operator. The original lists are not

changed.

The following example uses Concat () to join lists a and b:
a=1{1, 2};
b=4{7, 8, 9};

Concat( a, b );
{l’ 2’ 7’ 8’ 9}

The following example joins the same lists using the | | operator:

{1, 23 11 {7, 8, 9}
{1, 2, 7, 8, 9}

Lists of different types can be concatenated (for example, lists that contain character strings
and numbers).

d = {"apples", "bananas"};
e = {"oranges", "grapes"};
f={1, 2, 3};
Concat( d, e, f);
{"apples", "bananas", "oranges", "grapes", 1, 2, 3}

Join two or more lists and replace the first list with the combined list using Concat to() or
the | | = operator. The following example performs concatenation in place using Concat to():

d = {"apples", "bananas"};
e = {"peaches", "pears"};
Concat to(d,e);
Show( d );
d = {"apples", "bananas'", "peaches", '"pears'}

The following example joins the same lists using the | |= operator:

d = {"apples", "bananas"};
e = {"peaches", "pears"};
dl [=e;
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Show( d );
d = {"apples", "bananas'", "peaches", '"pears'}

Insert a Nested List in an Existing List

To insert a nested list in an existing list, specify the placement of the list:
'I_istz = {{llall, llbll}’ {IICII’ lldll}};
Tist2[3] = {"apple", "banana"}; // specify a list as the third item
Show( 1ist2 );
77'St2 = {{”a”’ "b"}’ {”C”’ ”d” , {"app7e", "banana”}};
If you do not know the number of items in a list, use N Items (). In this example, an empty list
is inserted at the end of the list.
'I_istl = {Ilall’ llbll};
Tistl[N Items( Tistl ) + 1] = {};
Show( Tistl );
listl = {"a", "b", {}};

Index into a List with Another List

Indexing into a a list with another list is a powerful technique for making scripts fast and
small. See “Indexing into a Matrix or List with Another Matrix or List”.

Send Messages to Lists

You can send a single message to a list instead of having to send individual messages.
Suppose that you want to create a Bivariate report with a By variable. The script returns a list
of the bivariate objects, one for each level of the By variable. Send a single Fit Line message
to the list to fit a line to all of the Bivariate reports.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

/* return a list of bivariate objects:

{Bivariate[], Bivariate[], Bivariate[], Bivariate[], Bivariate[],
Bivariate[]}; */

biv = dt << Bivariate( X( dt:weight ), Y( dt:height ), By( dt:age ) );

biv << Fit Line; /* send the Fit Line message to
each Bivariate object in the 1list */
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Troubleshooting Messages Sent to a List

Any message that is sent to a list is sent to each object in the list. If the message saves a file, it’s
performing the save for each object in the list to the same file. This means that only the last
object is actually saved in a file.

Suppose that you have a list of three control charts and you send a message (such as Save
Interactive HTML) to the list. The message is sent to each member of the list in turn. First, it
saves an HTML page with the first control chart; then it saves a second HTML page with the
same name that contains the second control chart; and then it saves a third HTML page with
the same name that contains only the third control chart. You end up with a page that contains
only the third control chart.

The solution is to send the message to a single container higher up the tree that contains all
control charts. To do this, rewrite the following line of code:

obj << Save Interactive HTML( "Control Charts.html" );
Top Parent treats the first object as the single container:

tp = obj[1] << Top Parent();
tp << Save Interactive HTML( "Control Charts.html" );

Matrices

A matrix is a rectangular array of numbers that are arranged in rows and columns. Use
matrices to store numbers and perform calculations on those numbers using matrix algebra.

Note the following for this section:

¢ Matrices are represented with an uppercase bold variable (for example, A).

* A matrix with one row or one column is a vector (or more specifically, a row vector or a
column vector respectively).

e For clarity, we represent matrices that are vectors with lowercase bold letters (such as x).

e A scalar is a numeric value that is not in a matrix.

Construct Matrices

Note the following when creating matrices:

® Place matrix literals in square brackets. [...]

® Matrix values can contain decimal points, can be positive or negative, and can be in
scientific notation.
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® Separate items across a column with blank spaces. You can use any number of blank
spaces.

® Separate rows with a comma.

For constructing more advanced matrices, see “Special Matrices”.

Examples

Create matrix A with 3 rows and 2 columns:
A=1[12, 34,5 6];

R is a row vector and C is a column vector:

R = [10 12 14];
C = [11, 13, 15];

B is a 1-by-1 matrix, or a matrix with one row and one column:
B = [20];
E is an empty matrix:
E=1[1;
The following examples show two ways of creating empty matrices:

3C 0,4 );
[1¢0,4

[1C5,0)
[1¢5,0)
Specifying the number of rows and columns in an empty matrix is optional. JMP creates the
matrix as necessary. For example, the following script defines an empty matrix, iterates over
each row in the data table, and returns the heights and weights in a matrix.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
data = []JC 0, 2 );
For Each Row( data |/= Matrix( {{dt:height, dt:weight}} ) );
Show( data );
data = [59 95, 61 123, 55 74,...]

A script can return an empty matrix. In Big Class.jmp, the following expression looks for rows
in which age equals 8, finds none, and returns an empty matrix:

a = dt << Get Rows Where( age == 8 );
Show( a );
a=[]00,1D;
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Construct Matrices from Lists

If you want to convert lists into a matrix, use the Matrix() function. A single list is converted
into a column vector. Two or more lists are converted into rows.

Create a column vector from a single list:

A = Matrix( {1, 2, 3} );
[1,2,3]

Create a matrix from a list of lists. Each list is a row in the matrix.

A = Matrix( {{1, 2, 3}, {4, 5, 6}, {7, 8, 9}} );
[12 3,

456,
789
Construct Matrices from Expressions

To construct matrices from expressions, use Matrix(). Elements must be expressions that
resolve to numbers.

A = Matrix( {4 * 5, 8 A2, Sqrt( 9 )} );
[20, 64, 3]

Subscripts

Use the subscript operator ([ ]) to pick out elements or submatrices from matrices. The
Subscript() function is usually written as a bracket notation after the matrix to be
subscripted, with arguments for rows and columns.

Single Element

The expression A[1i,j] extracts the element in row 1, column j, returning a scalar number.
The equivalent functional form is Subscript(A,i,J).

P=[123, 456, 78 9];
P[2, 3]1; // returns 6
Subscript( P, 2, 3 ); // returns 6

Assign the value that is in the third row and the first column in the matrix A (which is 5) to the
variable test.

A=1[12, 34,56];
test = A[3, 1];
Show( test );

test = 5;
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Matrix or List Subscripts

To extract a sub-matrix, use matrix or list subscripts. The result is a matrix of the selected rows
and columns. The following expressions select the second and third rows with the first and
third columns.

P=[123,456, 7 8 9];
P[[2 31,[1 3]11; // matrix subscripts
P[{2, 33},{1, 3}]1; // 1list subscripts

Both of these methods provide the following output:
[4 6,
7 9]

Single Subscripts

A single subscript addresses matrices as if all the rows were connected end-to-end in a single
row. This makes the double subscript A[1, j] the same as the single subscript
ALGi-1*ncol(A)+]].

Examples

Q=1[246, 810 12, 14 16 18];

Q[8]; // same as Q[3,2]
16

The following examples all return the column vector [10, 14, 18]:

Q=1[246, 810 12, 14 16 18];

Qr{5, 7, 9}1;
QLL5 7 9115

ii =[5 7 9];
QLiil;

ii = {5, 7, 93};
QLiil;

Subscript( Q, ii );
This script returns the values 1 through 9 from the matrix P in order:

P=[123,456,789];
For( i =1, i <= 3, i++,
For( j =1, j <= 3, j++,
Show( P[i, j1)
)
J;
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Deleting rows and columns is accomplished by assigning an empty matrix to that row or

column.
Alk, 0] = [1;
A[0, k] = [1;

// deletes the kth row

// deletes the kth column

Select Whole Rows or Columns

A subscript argument of zero selects all rows or columns.

P=1[123,456, 728 9];

Select column 2:

P[O, 2];
[2, 5, 8]

Select columns 3 and 2:

PLO, [3, 211;

[32, 65 98]

Select row 3:

P[3, 01;
[7 8 9]

Select rows 2 and 3:

PL[2, 3], 0;

[4 56, 78 9]

Select all columns and rows (the whole matrix):

P[0, 0];

[123, 456, 7829]

Assignment through Subscripts

You can change values in matrices using subscripts. The subscripts can be single indices,
matrices or lists of indices, or the zero index representing all rows or columns. The number of
selected rows and columns for the insertion must either match the dimension of the inserted
argument, or the argument can be inserted repeatedly into the indexed positions.

Examples

Change the value in row 2, column 3 to 99:

P=1[123,456, 7 8 9];

P[2, 3] = 99;

Show( P );
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P=[123, 4599, 78 9]
Change the values in four locations:

P=[123,456, 7 8 9];
PL[1 2], [2 3]] = [66 77, 88 99];
Show( P );

P=[1 66 77, 4 88 99, 7 8 9]

Change three values in one column:

P=1[123, 456, 78 9];
P[O, 2] = [11, 22, 33];
Show( P );

P=[1 11 3, 4 22 6, 7 33 9]

Change three values in one row:

P=1[123,456, 78 9];
P[3, 0] = [100 102 104];
Show( P );
P=[12 3, 456, 100 102 104]

Change all the values in one row to the same value:

P=1[123,456, 78 9];
P[2, 0] = 99;
Show( P );

P=[12 3, 99 99 99, 7 8 9]

Operator Assignment

You can use operator assignments (such as +=) on matrices or subscripts of matrices. For

Data Structures
Matrices

example, the following statement adds 1 to the i - jth element of the matrix:

P=1[123, 456, 78 9];
P[1, 1] += 1;
Show( P );
pP=[2 2 3,
456,
7 8 9];
P[1, 1] += 1;
Show( P );
P=[3 2 3,
4 56,7 8 9];

Ranges of Rows or Columns

If you are working with a range of subscripts, use the Index() function or : : to create

matrices of ranges.

209
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T1 =

=

11 3; // create the vector [1 2 3]
T2 = : 6; // create the vector [4 5 6]
T3 = : 9; // create the vector [7 8 9]
T=T1 |/ T2 |/ T3; // concatenate the vectors into a single matrix
T[1 :: 3, 2 :: 3]; // refer to rows 1 through 3, columns 2 and 3
[2 3, 56, 8 9]
T[Index( 1, 3 ), Index( 2, 3 )]; // equivalent Index function
[2 3, 56, 8 9]

N B

Inquiry Functions

The NCo1() and NRow() functions return the number of columns and rows in a matrix (or data
table), respectively:

NCol( [1 2 3, 4
NRow( [1 2 3, 4

); // returns 3 (for 3 columns)

5 6]
5 6] ); // returns 2 (for 2 rows)

To determine whether a value is a matrix, use the Is Matrix() function, which returns a 1 if
the argument evaluates to a matrix.

A = [20, 64, 3];
B = {20, 64, 3};
Is Matrix( A ); // returns 1 for yes
Is Matrix( B ); // returns 0 for no

Comparisons, Range Checks, and Logical Operators

JMP’s comparison, range check, and logical operators work with matrices and produce
matrices of elementwise Boolean results. You can compare conformable matrices.

A < B; // Tless than

A <= B; // less or equal

A > B; // greater than

A >= B; // greater or equal

A == B; // equal to

A != B; // not equal to

A < B < C; // continued comparison (range check)
A | B; // logical OR

A & B; // Togical AND

(A& I!B) | ('A&B); // exlusive OR
ICA&B) & (CA | B); // exlusive OR

You can use the Any () or A11() functions to summarize matrix comparison results. Any Q)
returns a 1 if any element is nonzero. A11() returns a 1 if all elements are nonzero.

[2 2] == [1 2]; // returns [0 1], therefore:
ATTC [2 2] == [1 2] ); // returns O
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Any( [2 2] == [1 2] ); // returns 1

Min() or Max() return the minimum or maximum element from the matrix or matrices given
as arguments.

A=1[123,456,7
B=[012,210,0
MinC A ); // returns 1
Max( A ); // returns 12
Min(C A, B ); // returns O

Numeric Operations

You can perform numeric operations (such as subtraction, addition, and multiplication) on
matrices. Most statistical methods are expressed in compact matrix notation and can be
implemented in JSL.

For example, the following expression uses matrix multiplication and inversion to illustrate
least squares regression:

b=(XX)"'Xy
Implement this equation through the following JSL expression:

b = Inv( X*X )*X*y;

Basic Arithmetic

You can perform the following basic arithmetic on matrices:
* addition

* subtraction

e multiplication

¢ division (multiplying by the inverse)
Note: The standard multiply operator is a matrix multiplier, not an elementwise multiplier.

To perform matrix multiplication, use one of the following methods:
® ¥ operator

e Multiply(Q function

e Matrix Mult(Q) function

To perform matrix division, use one of the following methods:

e / operator
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e Divide() function
Note the following about matrix multiplication and division:

* Remember that while multiplication or division of scalars is commutative (ab = ba),
multiplication or division of matrices is not commutative.

*  When one of the two elements is a scalar, elementwise multiplication or division is
performed.

e To use elementwise multiplication, use :* or the EMult () function.

¢ To use elementwise division, use :/, or the equivalent EDiv() function.

Examples

A=1[1
B =
cC=1[1
D=[01
Matrix addition:

R =A + B;
[135,
6 66,
7 9 10,
12 11 12]

Matrix subtraction:

Matrix multiplication (inner product of rows of A with columns of C):

R=A%*C;
[911 79,
24 29 22 27,
39 47 37 45,
54 65 52 63]

Matrix division (equivalent to A*Inverse(D)):

R=A/D;
[1.5 0.5 0,
320,

4.5 3.5 0,
6 5 0]

Matrix elementwise multiplication:

R=A:* B;
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Matrix scalar multiplication:

R=C*%*2;
[2 468,
8642,
020 2]

Matrix scalar division:

R=C/ 2;
[0.511.5 2,
21.510.5,
00.500.5]
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Matrix elementwise division (division by zero results in missing values):

R=A:/B;

Numeric (Scalar) Functions on Matrices

Numeric functions work elementwise on matrices. Most of the pure numeric functions can be
applied to matrices, resulting in a matrix of results. You can mix conformable matrix and

scalar arguments.

Examples of numeric functions include the following:

e Sqgrt(), Root(), Log(), Exp(), A Power(), Logl0()
e Abs(), Mod(), Floor(), Ceiling(), Round(), ModuTlo()

e Sine, (), Cosine(), Tangent(), ArcSine(), and other trigonometry functions.

e Normal Distribution(), and other probability functions.

Example

A=[123,456, 7809, 10 11 12];
B = Sqrt( A ); // elementwise square root
[1 1.414213562373095 1.732050807568877,
2 2.23606797749979 2.449489742783178,
2.645751311064591 2.82842712474619 3,
3.16227766016838 3.3166247903554 3.464101615137754]
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Concatenation

The Concat () function combines two matrices side by side to form a larger matrix. The
number of rows must agree. A double vertical bar ( | | ) is the infix operator, equivalent for
horizontal concatenation.

Identity( 2 ) || JC2, 3, 4);
[10444, 01444]

B = [1; 1];
B || Concat( Identity( 2 ), J( 2, 3, 4));
[110444, 101444]

The VConcat () function stacks two matrices on top of each other to form a larger matrix. The
number of columns must agree. A vertical-bar-slash ( |/ ) is the infix operator, equivalent for
vertical concatenation.

Identity( 2 ) |/ J(C 3, 2, 1);
// or VConcat( Identity( 2 ),J( 3, 2, 1) )J;
[10, 01, 11, 11, 1 1]

Both Concat() and VConcat() support concatenating to empty matrices, scalars, and lists.

a=[1;

a || [11; // returns [1]

a || {2}; // returns [2]

a || [345]; // returns [3 4 5]

There are two in place concatenation operators: | |=and |/=. They are equivalent to the
Concat To(Q) and V Concat To() functions, respectively.
* a || = bisequivalenttoa = a || b

* a |/ = bisequivalenttoa = a | /b

Transpose

The Transpose () function transposes the rows and columns of a matrix. A back-quote ( ") is
the postfix operator, equivalent to Transpose (). In matrix notation, Transpose() is
expressed as the common prime or superscript-T notation (A’ or AT).

A=[123,456, 7809, 10 11 12];
A

[1 4 7 10,

258 11,

369 12]
Transpose( [1 2, 3 4] );

[13, 24]
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Indexing into a Matrix or List with Another Matrix or List

Indexing into a matrix (or a list) with another matrix (or list) is a powerful technique for
making scripts fast and small. JMP 13 and later handles one edge case differently.

Consider the following example of using a matrix as an index into a data column.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

tall rows = Loc( :height << Get Values() >= 67 ); // [25, 27, 30, 37, 39, 40]
:height[tall rows]; // [68, 69, 67, 68, 68, 70]

N Rows( :height[tall rows] ); // 6

The second line is the key. :height << Get Values() returns the values of the height column
as a matrix. The comparison >= 67 returns a matrix of Os and 1s corresponding to where the
expression is false (0) or true (1). The Loc() function returns the locations of the 1s within the
previous matrix.

In this case, you get [25, 27, 30, 37, 39, 40] as the row numbers where the height column is
greater than or equal to 67. That's pretty handy by itself, but the real power comes from being
able to use that matrix as the index into a column or other matrix as in the third and fourth
lines.

The alternative to this technique is to write a For () loop to iterate through every row
explicitly. JMP still loops through the rows in either case, but the looping is much faster if
done internally rather than in JSL. And the JSL is more compact without the explicit loop.

You can do the same thing with a matrix variable instead of a data column reference:

m = :height << Get Values();

tall rows = Loc( m >= 67 ); // [25, 27, 30, 37, 39, 40]
m[tall rows]; // [68, 69, 67, 68, 68, 70]

N Rows( m[tall rows] ); // 6

Consider the same examples with a different height cutoff (70 instead of 67):

tall rows = Loc( :height << Get Values() >= 70 ); // [40]
theight[tall rows]; // [70]
N Rows( :height[tall rows] ); // 1

m = :height << Get Values(Q);

tall rows = Loc( m >= 70 ); // [40]

m[tall rows]; // [70]

N Rows( m[tall rows] ); /* error in IMP 12 and prior versions
otherwise, returns 1 */

Notice that m[tall rows] returned 70 instead of [70]. In many cases, a 1x1 matrix and a
number are treated the same way, but not always. The N Rows () function is one example
where it makes a difference. The indexing is too aggressively simplifying the 1x1 matrix into a
number.
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One work-around is to call Is Matrix() before using N Rows(). An alternative is to
concatenate an empty matrix to the result, which creates a matrix whether the source is a
number or a matrix:

m=m]|/ []

In JMP 13 and later, the 1x1 matrix is maintained so that the result of the index operation is a
matrix whenever the index itself is a matrix. The same principle applies to list indexing. Data
table column indexing has always followed this principle.

Matrices and Data Tables

You can move information between a matrix and a JMP data table. You can use matrix algebra
to perform calculations on numbers that are stored in JMP data tables, and you can save the
results back to JMP data tables.

Move Data into a Matrix from a Data Table

These sections describe how to move data from a data table into a matrix.

Move All Numeric Values

The Get As Matrix() function generates a matrix containing all of the numeric values in a
data table or column:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
A = dt << Get As Matrix;

[12 59 95,

12 61 123,

12 55 74, ...
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
col = Column( "Height" );
A = col << Get As Matrix;

[59, 61, 55, 66, 52, ...]

Move All Numeric Values and Character Columns

The Get A1l Columns As Matrix() function returns the values from all columns of the data
table in a matrix, including character columns. Character columns are numbered according to
the alphanumeric order, starting at 1.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
A = dt << Get A1l Columns As Matrix;

[21 12 1 59 95,
28 12 1 61 123, ...]
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Move Only Certain Columns

To get certain columns of a data table, use column list arguments (names or characters).

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
x = dt << Get As Matrix( {"height", "weight"} );

or

x = dt << Get As Matrix( {height, weight} );
[59 95, 61 123, 55 74, ...]
Currently Selected Rows
To get a matrix of the currently selected row numbers in the data table:

dt << Get Selected Rows;

Note: If no rows are selected, the output is an empty matrix.

Find Rows Where
To see a matrix of row numbers where the expression is true:
dt << Get Rows Where( expression );
For example, the following script returns the row numbers where the sex is male (M):

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
A = dt << Get Rows Where( Sex == "M" );
[6, 7, 8, 12, 13, 14, ...]

Move Data into a Data Table from a Matrix

This section describes how to move data from a matrix into a data table.

Move a Column Vector

The Set Values() function copies values from a column vector into an existing data table
column:

col << Set Values( x );
col is a reference to the data table column, and x is a column vector.

For example, the following script creates a new column called test and copies the values of
vector x into the test column:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
dt << New Column( "test" );

col = Column( "test" );

X = 1::40;



218

Data Structures Chapter 7
Matrices Scripting Guide

col << Set Values( x );

Move All Matrix Values

The Set Matrix() function copies values from a matrix into an existing data table, making
new rows and new columns as needed to store the values of the matrix. The new columns are
named Col1, Col2, and so on.

dt = New Table( "B" );
dt << Set Matrix([1 2 345, 6 7 8 9 10]);

This script creates a new data table called B containing two rows and five columns.

To create a new data table from a matrix argument, use the As Table(matrix) command. The
columns are named Col1, Col2, and so on. For example, the following script creates a new data
table containing the values of A:

A=[123,456, 789, 10 11 12];
dt = As Table( A );

Matrices and Reports

You can extract matrices of values from reports. First, you need to locate the items that you
want to extract. This information is in the tree structure of the report.

Run the following script to create a table of parameter estimates in a Bivariate report:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" ) ;
biv = dt << Bivariate( X( height ), Y( weight ), Fit Line );

Now, open the tree structure to identify which item contains the parameter estimates:

e Right-click a gray disclosure icon and select Edit > Show Tree Structure.
The parameter estimates are contained in NumberCo1Box (13). Continue with the script:

colBox = Report( biv )[Number Col Box( 13 )];
beta = colBox << Get As Matrix;
[-127.145248610915, 3.711354893859555]

Notes:

¢  When a variable contains a reference to a table box, Get As Matrix() creates a matrix A
that contains the values from all numeric columns in the table:
A = tableBox << Get As Matrix;

* When a variable contains a reference to a numeric column in a report table, Get As
Matrix() creates a matrix A as a column vector of values from that column.

A = colBox << Get As Matrix;
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Loc Functions

Loc

The Loc(), Loc Nonmissing(), Loc Min(), Loc Max(), and Loc Sorted() functions all return
matrices that show positions of certain values in a matrix.

The Loc () function creates a matrix of positions that locate where A is true (nonzero and
nonmissing).

A=1[01.
B=[200

The following example returns the indices for the values of A that are nonmissing and
nonzero.

I =Loc( A);
[2, 4, 5]

The following example returns the indices for the values of A that are less than the
corresponding values of B. Note that the two matrices must have the same number of rows
and columns.

I =LocC A<B);
[1, 5, 6]
The following script replaces all values less than 4 in A with 0.
A=1[010340];
AlLoc( A < 4 )] = 0;
Show( A );
A=1[000040];

The following script returns an empty matrix:

Loc( [23456] >7);
[i¢, 1

Loc Nonmissing

The Loc Nonmissing() function returns a vector of row numbers in a matrix that do not
contain any missing values. For example,

A=[123,4.6,78., 87 6];
Loc Nonmissing( A );

[1, 4]
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Loc Min and Loc Max

The Loc Min() and Loc Max() functions return the position of the first occurrence of the
minimum and maximum elements of a matrix. Elements of a matrix are numbered
consecutively, starting in the first row, first column, and proceeding left to right.

A=T[122,244,111];
B = [6, 12, 9];
Show( Loc Max( A
Show( Loc Min( B
=5
=1

) );
) s

H

Loc Max(A)
Loc Min(B)

H

Loc Sorted

The Loc Sorted() function is mainly used to identify the interval that a number lies within.
The function returns the position of the highest value in A that is less than or equal to the
value in B. The resulting vector contains an item for each element in B.

A = [10 20 30 40];

B = [35];

Loc Sorted( A, B );
[3]

A = [10 20 40];

B = [35 5 45 20];
Loc Sorted( A, B );
2, 1, 3, 2]

Here’s an example that defines a list of strings. Loc Sorted() identifies the string at the
seventh interval and puts it in a list.

{"No Fat", "Some Fat", "Low Fat", "Normal Fat", "Medium Fat", "High Fat"}
[Loc Sorted( [0, 1, 5, 10, 20, 251, 7)]
{"Low Fat"}

To convert the returned value to a string, include the subscript [1] at the end of the expression:

{"No Fat", "Some Fat", "Low Fat", "Normal Fat", "Medium Fat", "High Fat"}
[Loc Sorted( [0, 1, 5, 10, 20, 25], 7)][1]
"Low Fat"

Notes:

* A must be sorted in ascending order.

¢ The returned values are always 1 or greater. If the element in B is smaller than all of the
elements in A, then the function returns a value of 1. If the element in B is greater than all
of the elements in A, then the function returns n, where nis the number of elements in A.
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Ranking and Sorting

The Rank () function returns the positions of the numbers in a vector or list, as if the numbers
were sorted from lowest to highest.
E=[1-23-405128-7];
R = Rank( E );
[9, 4, 2, 5, 7, 1, 3, 6, 8]
If E were sorted from lowest to highest, the first number would be -7. The position of -7 in E is
9.

The original matrix E can then be sorted using the matrix R as subscripts to E.

sortedE = E[R];
[_71_ 45 _21 05 ll 15 31 51 8]
The Ranking Tie() function returns ranks for the values in a vector or list, with ranks for ties
averaged. Similarly, Ranking() returns ranks for the values in a vector or list, but the ties are
ranked arbitrarily.

E=[1-23-40518-7];
Ranking Tie( E );
[5.5, 3, 7, 2, 4, 8, 5.5, 9, 1]

E=[1-23-405128-7];
Ranking( E );
[5, 3, 7, 2, 4, 8, 6, 9, 1]

The Sort Ascending() and Sort Descending() functions sort vectors.

E=[1-23-40518-7];
Sort Ascending( E );
[-7 -4 -2 01135 8]

E=[1-23-405128-7];
Sort Descending( E );
[853110-2-4-7]

If the argument is not a vector or list, an error message is generated.

Special Matrices

Construct an Identity Matrix

The Identity() function constructs an identity matrix of the dimension that you specify. An
identity matrix is a square matrix of zeros except for a diagonal of ones. The only argument
specifies the dimension.

Identity( 3 );
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[100,
010,
00 1]

Construct a Matrix with Specific Values

The J ) function constructs a matrix with the number of rows and columns that you specify
as the first two arguments, whose elements are all the third argument, for example:

3C3, 4, 5);

55
55557
J(C 3, 4, Random Normal(Q) ); // your results will differ

[0.407709113182904 1.67359154091978 1.00412665221308 0.240885679837327,

-0.557848036549455 -0.620833861982722 0.877166783247633 1.50413740148892,

-2.09920574748608 -0.154797501010655 0.0463943433032137 0.064041826393316]

Create a Diagonal Matrix

The Diag() function creates a diagonal matrix from a square matrix (having an equal number
of rows and columns) or a vector. A diagonal matrix is a square matrix whose nondiagonal

elements are zero.

D=1[1-11];
Diag( D );
[10 0,
0 -10,
00 1]
Diag([1, 2, 3, 41);
[1000,

’

QOO
SQON
WO
AOO

[1 2,3 4];

f = [5];

= Diag( A, f );
[120

340

00 5]

In the third example, at first glance, not all of the nondiagonal elements are zero. Using matrix
notation, the matrix can be expressed as follows:

>
I

o
I

[A O,
0" f]

Where A and f are the matrices from the example, and 0 is a column vector of zeros.
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Create a Column Vector from Diagonal Elements

The VecDiag() function creates a column vector from the diagonal elements of a matrix.

v = Vec Diag(
[1001,5371,9988,1543]);
[1, 3, 8, 3]

Calculate Diagonal Quadratic Forms

The Vec Quadratic(Q) function calculates the hats in regression that go into the standard
errors of prediction or the Mahalanobis or T2 statistics for outlier distances. Vec
Quadratic(Sym, X) is equivalent to calculating Vec Diag(X*Sym*X").The first argument is
a symmetric matrix, usually an inverse covariance matrix. The second argument is a
rectangular matrix with the same number of columns as the symmetric matrix argument.

Return the Sum of Diagonal Elements

The Trace() function returns the sum of the diagonal elements for a square matrix.

D=[012, 210, 120];
Trace( D ); // returns 1

Generate a Row Vector of Integers

The Index() function generates a row vector of integers from the first argument to the last
argument. A double colon : : is the equivalent infix operator.

6::10;
[6 7 8 9 10]
Index( 1, 5 );
[12 345]

The optional 7increment argument changes the default increment of +1.

Index( 0.1, 0.4, 0.1 );
[0.1, 0.2, 0.3, 0.4]

The increment can also be negative.

Index( 6, 0, -2 );
[6, 4, 2, 0]

The default value of the increment is 1, or -1 if the first argument is higher than the second.
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Reshape a Matrix

The Shape ) function reshapes an existing matrix across rows to be the specified dimensions.
The following example changes the 3x4 matrix a into a 12x1 matrix:

a=1[111,222,333,444];
Shape( a, 12, 1 );
(i, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4]

Summarize Columns of a Matrix

There are several functions that return a row vector based on summary values for each
column in a matrix.

mymatrix = [11 22, 33 44, 55 66];
V Max( mymatrix ); // returns the maximum of each column

[55 66]
V Min( mymatrix ); // returns the minimum of each column
[11 22]
V Mean( mymatrix ); // returns the mean of each column
[33 44]
V Median( mymatrix ); // returns the median of each column
[33 44]
V Quantile( mymatrix, 0.75 ); // returns the 0.75 quantile of each column
[55 66]
V Sum( mymatrix ); // returns the sum of each column
[99 132]
V Std( mymatrix ); // returns the standard deviations of each column
[22 22]

Create Design Matrices

The Design() function creates a matrix of design columns for a vector or list. There is one
column for each unique value in the vector or list. The design columns have the elements 0
and 1. For example, x below has values 1, 2, and 3, then the design matrix has a column for 1s,
a column for 2s, and a column for 3s. Each row of the matrix has a 1 in the column
representing that row’s value. So, the first row (1) has a 1 in the 1s column (the first column)
and 0s elsewhere; the second row (2) has a 1 in the 2’s column and Os elsewhere; and so on.

x=[1, 2, 3, 2, 1];

Design( x );

[10 0,

y

-

S
OROR
SoORD
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A variation is the Design Nom() or Design F() function, which removes the last column and
subtracts it from the others. Therefore, the elements of Design Nom() or Design F() matrices
are 0, 1, and —1. And the Design Nom() or Design F() matrix has one less column than the
vector or list has unique values. This function makes full-rank versions of design matrices for
effects.

x = [1, 2, 3, 2, 1];
Design Nom( x );
[10, 01, -1 -1, 0 1, 1 0]
Design Nom() is further demonstrated in the “ANOVA Example”.

To facilitate ordinal factor coding, use the Design Ord() function. This function produces a
full-rank coding with one less column than the number of unique values in the vector or list.
The row for the lowest value in the vector or list is all zeros. Each succeeding value adds an
additional 1 to the row of the design matrix.

X = [1’ 2, 3! 4’ 51 6];
Design Ord( x );
[000O0O,

’
’

7
Design(), Design Nom(), and Design Ord() support a second argument that specifies the

levels to be looked up and their order. This feature allows design matrices to be created one
row at a time.

1
1
1
1
1

mNRRRO
RNRROO
~NROOO
~NOOOoO

* Design( values, levels ) creates a design matrix of indicator columns.

* DesignNom( values, Tevels ) creates a full-rank design matrix of indicator columns.
Notes:

e The values argument can be a single element or a matrix or list of elements.

e The Tevels argument can be a list or matrix of levels to be looked up.

* The result has the same number of rows as there are elements in the values argument.

* The result always has the same number of columns as there are items in the /evels
argument. In the case of Design Nom() and Design Ord(), there is one less column than
the number of items in the Tevels argument.

e If a value is not found, the whole row is zero.

Examples

Design( 20, [10 20 30] );

[0 1 0]
Design( 30, [10 20 30] );
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[0 0 1]
Design Nom( 20, [10 20 30] );
[0 1]
Design Nom( 30, [10 20 30] );
[-1 -1]
Design Ord( 20, [10 20 30] );
[1 0]
Design( [20, 10, 30, 20], [10 20 30] );
[0 10,
100,
001,
01 0]
Design({"b", "a", "c", "b"}, {"a", "b", "c"D);
[0 10,
100,
001,
010

Find the Direct Product

The Direct Product() function finds the direct product (or Kronecker product) of two
square matrices. The direct product of a m x mmatrix and a n x nmatrix is the mn x mn matrix
whose elements are the products of numbers, one from A and one from B.

H=1[23,57];
Direct Product( G, H );

[2 3406,
57 10 14,
6 9 10 15,
15 21 25 35]

The H Direct Product() function finds the row-by-row direct product of two matrices with
the same number of rows.

H Direct Product( G, H );
[2 346, 15 21 25 35]

HDirect Product() is useful for constructing the design matrix columns for interactions.

XA = Design Nom( A );

XB = Design Nom( B );

XAB = HDirect Product( XA, XB );

X =JCNRow(C A), 1) || XA || XB || XAB;

Inverse Matrices and Linear Systems

JMP has the following functions for computing inverse matrices: Inverse(), GInverse(),
and Sweep(). The Solve() function is used for solving linear systems of equations.
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Inverse or Inv

The Inverse() function returns the matrix inverse for the square, nonsingular matrix
argument. Inverse() can be abbreviated Inv. For a matrix A, the matrix product of A and
Inverse(A) (often denoted A(A'l)) returns the identity matrix.

A=1[56, 7 8];
AInv = Inv( A );
A*A Inv;

[1 0,0 1]

A=1[12, 34];
AInv = Inverse( A );
A*AlInv;

[1 1.110223025e-16,0 1]

Note: There can be small discrepancies in the results due to floating point limitations, as
illustrated in the second example.
Ginverse

The (Moore-Penrose) generalized inverse of a matrix A is any matrix G that satisfies the
following conditions:

AGA=A
GAG=G

(AG) = AG
(GA)' = GA

The GInverse() function accepts any matrix, including non-square ones, and uses
singular-value decomposition to calculate the Moore-Penrose generalized inverse. The
generalized inverse can be useful when inverting a matrix that is not full rank. Consider the
following system of equations:

x+2y+2z =6
2x+4y+4z = 12
x+ty+tz=1

Find the solution to this system using the following script:

A=1[122,244,111];

B =[6, 12, 1];

Show( GInverse( A ) * B );
GInverse(A) * B = [-4, 2.5, 2.5];
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The Solve() function solves a system of linear equations. Solve() finds the vector x so that
x = A”lb where A equals a square, nonsingular matrix and b is a vector. The matrix A and the
vector b must have the same number of rows. SoTve(A,b) is the same as Inverse(A)*b.

A [1-42,332,04-1];

b=1[1, 2, 11;

x = Solve( A, b );

[-16.9999999999999, 4.99999999999998, 18.9999999999999]

A%*x;
[1, 2, 0.999999999999997]

Note: There can be small discrepancies in the results due to floating point limitations, as
illustrated in the example.

The Sweep() function inverts parts (or pivots) of a square matrix. If you sequence through all
of the pivots, you are left with the matrix inverse. Normally the matrix must be positive
definite (or negative definite) so that the diagonal pivots never go to zero. Sweep () does not
check whether the matrix is positive definite. If the matrix is not positive definite, then it still
works, as long as no zero pivot diagonals are encountered. If zero (or near-zero) diagonal
pivots are encountered on a full sweep, then the result is a g2 generalized inverse if the zero
pivot row and column are zeroed.

About the Sweep Function

Suppose matrix E consists of smaller matrix partitions, A, B, C, and D:

A B
CD

E =

The syntax for Sweep () appears as follows:
Sweep( E, [...]);
[...] indicates partition A.

This produces the matrix result equivalent to the following;:

Al AlB
1 1
cAa! p-ca'B
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¢ The submatrix in the A position becomes the inverse.
® The submatrix in the B position becomes the solution to Ax = B.

* The submatrix in the C position becomes the solution to xA = C.

Use of the Sweep Function
Sweep () is sequential and reversible:

e A = Sweep( A, {i,j} )isthesameasA = Sweep( Sweep( A, i ), j ).Itis
sequential.

e A = Sweep( Sweep( A, i ), 1 ) restores A to its original values. It is reversible.

If you have a cross-product matrix partitioned as follows:

c - [xax:xvi
yX y'y

Then after sweeping through the indices of X'X, the result appears as follows:

XX XX Xy
YXXX) T YY-yXXX) Xy
The partitions are recognizable to statisticians as follows:
¢ the least squares estimates for the model Y = Xb + e in the upper right

® the sum of squared errors in the lower right

® amatrix proportional to the covariance of the estimates in the upper left

The Sweep function is useful in computing the partial solutions needed for stepwise
regression.
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The ndex argument is a vector that lists the rows (or equivalently the columns) on which you
want to sweep the matrix. For example, if E is a 4x4 matrix, to sweep on all four rows to get E!

requires these commands:

E=[5411,4511, 1142, 112 4];
Sweep( E, [1, 2, 3, 4] );
[0.56 -0.44 -0.02 -0.02,
-0.44 0.56 -0.02 -0.02,
-0.02 -0.02 0.34 -0.16,
-0.02 -0.02 -0.16 0.34]
Inverse( E ); // notice that these results are the same
[0.56 -0.44 -0.02 -0.02,
-0.44 0.56 -0.02 -0.02,
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-0.02 -0.02 0.34 -0.16,
-0.02 -0.02 -0.16 0.34]

Note: For a tutorial on Sweep (), and its relation to the Gauss-Jordan method of matrix
inversion, see Goodnight, ].H. (1979) “A tutorial on the SWEEP operator.” The American
Statistician, August 1979, Vol. 33, No. 3. pp. 149-58.

Sweep() is further demonstrated in the “ANOVA Example”.

Determinant

The Det () function returns the determinant of a square matrix. The determinant of a 2 x 2
matrix is the difference of the diagonal products, as demonstrated below. Determinants for
n x nmatrices are defined recursively as a weighted sum of determinants for (1 - 1) x (1 - 1)
matrices. For a matrix to have an inverse, the determinant must be nonzero.

12/ - 1.5-(3.2) = 1

F=1[12, 35];
Det( F );
-1

Decompositions and Normalizations

This section contains functions that calculate eigenvalues and eigenvectors and functions that
decompose matrices.

Eigenvalues

The Eigen() function performs eigenvalue decomposition of a symmetric matrix. Eigenvalue
decompositions are used in many statistical techniques, most notably in principal components
and canonical correlation, where the transformation associated with the largest eigenvalues
are transformations that maximize variances.

Eigen() returns a list of matrices. The first matrix in the returned list is a column vector of
eigenvalues; the second matrix contains eigenvectors as the columns.

A=[5411,4511,1142, 112 4];
Eigen( A );

{[10, 5, 2, 1][0.632455532033676 - 0.316227766016838 - 2.77555756156289%¢e-16
-0.707106781186547, 0.632455532033676 - 0.316227766016837 -
1.66533453693773e-16 0.707106781186547, 0.316227766016838
0.632455532033676 0.707106781186548 0, 0.316227766016837
0.632455532033676 - 0.707106781186547 0]}
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Since the function returns a list of matrices, you might want to assign it to a list of two global
variables. That way, the column vector of eigenvalues is assigned to one variable, and the
matrix of eigenvectors is assigned to another variable:

{evals, evecs} = Eigen( A );

For some n x nmatrix A, eigenvalue decomposition finds all A (lambda) and vectors x, so that
the equation Ax = Ax has a nonzero solution x. The A’s are called eigenvalues, and the
corresponding x vectors are called eigenvectors. This is equivalent to solving (A - AI)x =0. You
can reconstruct A from eigenvalues and eigenvectors by a statement like the following:

newA = evecs * Diag( evals ) * evecs';
[5.00000000000001 4 1 1,
4511,
1142,
1124]

Note the following about eigenvalues and eigenvectors:

* The eigenvector matrices are orthonormal, such that the inverse is the transpose:
E'E=EE =1 .

e Eigenvectors are uniquely determined only if the eigenvalues are unique.
® Zero eigenvalues correspond to singular matrices.

* Inverses can be obtained by inverting the eigenvalues and reconstituting with the
eigenvectors. Moore-Penrose generalized inverses can be formed by inverting the nonzero
eigenvalues and reconstituting. (See “Glnverse”.)

Note: You must decide whether a very small eigenvalue is effectively zero.

¢ The eigenvalue decomposition enables you to view any square-matrix multiplication as
the following:

— arotation (multiplication by an orthonormal matrix)

a scaling (multiplication by a diagonal matrix)

a reverse rotation (multiplication by the orthonormal inverse, which is the transpose),
or in notation:

A*x=E *Diag(M) * E * x;

E rotates, Diag( M ) scales, and E " reverse-rotates.

Cholesky Decomposition

The Cholesky () function performs Cholesky decomposition. A positive semi-definite matrix

A is re-expressed as the product of a nonsingular, lower-triangular matrix L and its transpose:
L*L'=A.

E=[5411,4511,1142,1124];
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L = Cholesky( E );

[2.23606797749979 0 0 O,

1.788854381999832 1.341640786499874 0 0,

0.447213595499958 0.149071198499986 1.9436506316151 O,
0.447213595499958 0.149071198499986 0.914659120760047 1.71498585142509]

To verify the results, enter the following:

About Cholesky Decomposition

Cholesky () is useful for reconstituting expressions into a more manageable form. For
example, eigenvalues are available only for symmetric matrices in JMP, so the eigenvalues of
the product AB could not be obtained directly. (Although A and B can be symmetric, the
product is not symmetric.) However, you can usually rephrase the problem in terms of
eigenvalues of L'BL where L is the Cholesky root of A, which has the same eigenvalues.

Another use of Cholesky() is in reordering matrices within Trace() expressions.
Expressions such as Trace (A*B*A") might involve huge operations counts if A has many
rows. However, if B is small and can be factored into LL' by Cholesky, then it can be
reformulated to Trace (A*L*L"*A"). The resulting matrix is equal to Trace(L A" *AL). This
expression involves a much smaller number of operations, because it consists of only the sum
of squares of the AL elements.

Use the function Chol Update() to update a Cholesky decomposition. If L is the Cholesky
root of a n x n matrix A, then after using cholUpdate(L, C, V), L will be replaced with the
Cholesky root of A+V*C*V'. Cis an m x msymmetric matrix and Vis an n x mmatrix.

Examples

Manually update the Cholesky decomposition, as follows:

exS=[161011-112,111-11-11,0-112-110,111-111-19, -1 -1
1-19-1, 12109 -1 12];
exAchol = Cholesky( exS ); // conducts the Cholesky decomposition

// add two column vectors to the design matrix
exW=[11, 00,01, 00, 00, 01];

/* The first column vector is added to one of the rows in the design matrix.

The second column vector is subtracted from one of the rows in the design
matrix. */

exC=[10, 0 -17;

exAnew = exS + exV * exC * exV';
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// update the Cholesky decomposition manually
exAcholnew = Cholesky( exAnew );

Instead of manual updating, use Chol Update() to update the Cholesky decomposition, as
follows:

// update the Cholesky decomposition more efficiently
exAcholnew_test = Chol Update( exAchol, exV, exC );
Show( exAcholnew_test );

exAcholnew_test =
[ 400000,
0.25 3.30718913883074 0 0 0 0, ...]

// results are the same as the manual process
Show( exAcholnew );

exAcholnew=
[ 400000,
0.25 3.30718913883074 0 0 0 0, ...]

Singular Value Decomposition

The SVD() function finds the singular value decomposition of a matrix. That is, for a matrix A,
SVD() returns a list of three matrices U, M, and V, so that U*diag(M) *V " =A.

Notes:

*  When A is taller than it is wide, M is more compact, without extra zero diagonals.
¢ Singular value decomposition re-expresses A in the form USV’, where:

— Uand V are matrices that contain orthogonal column vectors (perpendicular,
statistically independent vectors)

— Sisan x ndiagonal matrix containing the nonnegative square roots of the eigenvalues
of A'A, the singular values of A.

* Singular value decomposition is the basis of correspondence analysis.

Example

A=[1210,2301,1015,0151];

{U, M, V} = SVD( A );

newA = U * Diag( M) * V';
[1 2 0.999999999999997 -2.99456640040496e-15,
2 3 -1.17505831453979e-15 1,

0.999999999999997 -2.16851276518826e-15 0.999999999999999 5,
2.22586706011274e-15 1 5 0.999999999999997]
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Orthonormalization

The Ortho() function orthogonalizes the columns and then divides the vectors by their
magnitudes to normalize them. This function uses the Gram-Schmidt method. The column
vectors of orthogonal matrices are unit-length and are mutually perpendicular (their dot
products are zero).

B = Ortho( [1 -1, 1 0, 0 1] );
[0.408248290463863 -0.707106781186548, 0.408248290463863 0.707106781186548,
-0.816496580927726 3.14018491736755e-16]
To verify that these vectors are orthogonal, multiply B by its transpose, which should yield the
identity matrix.

C=B" * B;
[1 -3.119061760824e-16, -3.119061760824e-16 1]
By default, vectors are normalized, meaning that they are divided by their magnitudes, which
scales them to have length 1. Include the option Scaled(0) to turn scaling off:

Ortho( [1 -1, 1 0, 0 1], Scaled( 0 ) );
[0.408248290463863 -0.353553390593274, 0.408248290463863 0.353553390593274,
-0.816496580927726 1.57009245868377e-16]
To create vectors whose elements sum to zero, include the Centered (1) option. This option is
useful when constructing a matrix of contrasts.

result = Ortho( [1 -1, 1 0, 0 1], Centered( 1) );
[0.408248290463863 -0.707106781186548, 0.408248290463863 0.707106781186548,
-0.816496580927726 3.14018491736755e-16]
To verify that the elements of each column sum to zero, premultiply by a vector of ones to sum
the columns.

J(1, 3) * result;
[1.11022302462516e-16 2.02996189274239¢e-16]

Orthogonal Polynomials

The Ortho Poly() function returns orthogonal polynomials for a vector of indices. The
polynomial order is specified as a function argument. Orthogonal polynomials can be useful
for fitting polynomial models where some regression coefficients might be highly correlated.

Ortho Poly(C [1 2 3], 2 );
[-0.707106781186548 0.408248290463862, 0 -0.816496580927726,
0.707106781186548 0.408248290463864]
The polynomial order must be less than the dimension of the vector. Use the Scaled(1)
option to produce vectors of unit length, as described in “Orthonormalization”.
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QR Decomposition
QRO factorization is useful for numerically stable matrix work. QR() returns a list of two
matrices. Here is an example:
{Q, R} = QR(C [11 22, 33 44] );

Q and R hold the results. For a m x nmatrix, QR() creates an orthogonal m x mmatrix Q and an
upper triangular m x nmatrix R, so that X = Q*R.

Update Inverse Matrices

To add or drop one or more rows in an inverse of an M'M matrix, use the Inv Update(S, X,
w) function. Updating inverse matrices is helpful in drop-1 influence diagnostics and also in
candidate design evaluation.

Notes:

* The first argument, S, is the matrix to be updated.

® The second argument, X, is the matrix of rows to be added or dropped.

® The third argument, w, is either 1 to add or -1 to delete the row or rows.

® Multiple rows can be added or deleted.

Using the Inv Update(S, X, w) function is equivalent to calculating the following;:
S-w*S*X *Inv(I+wH*X*S#*X )*X*S

Where I is an identity matrix and Inv(A) is an inverse matrix of A.

Build Your Own Matrix Functions

You can store your own operations in macros. See “Maximize and Minimize”. Similarly, you
can create custom matrix functions. For example, you can make your own matrix operation
called Mag() to find the magnitude of a vector:

mag = Function( {x},
Sgrt( x° * x )
s

Similarly, you could create a function called Normalize to divide a vector by its magnitude:

normalize = Function( {x},
x / Sqrt( x° * x )
s
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Statistical Examples

This section contains statistical examples of using matrices.

Regression Example

Suppose that you want to implement your own regression calculation, rather than use the
facilities built into JMP. Because of the compact matrix notation, it might require only a few
lines of code:

Y = [98, 112.5, 84, 102.5, 102.5, 50.5, 90, 77, 112, 150, 128, 133, 85, 112];

X = [65.3, 69, 56.5, 62.8, 63.5, 51.3, 64.3, 56.3, 66.5, 72, 64.8, 67, 57.5,
66.5];

X =JCNRow( X)), 1) || X; // put in an intercept column of 1s

beta = Inv( X* * X ) * X* *Y; // the least square estimates

resid =Y - X * beta; // the residuals, Y - predicted

sse = resid’ * resid; // sum of squared errors

Show( beta, sse );

This could be expanded into a script that gets its data from a data table, calculates additional
results, and shows the results in a report window:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

// get data into matrices

X = (Column( "Age" ) << Get Values ) || (Column( "Height" ) << Get Values);
X =JINRow( x ), 1, 1D || x;
y = Column( "Weight" ) << Get Values;

// regression calculations

xpxi = Inv( X~ * x );

beta = xpxi * x° * y; // parameter estimates

resid =y - x * beta; // residuals

sse = resid’ * resid; // sum of squared errors

dfe = N Row( x ) - N Col( x ); // degrees of freedom

mse = sse / dfe; // mean square error, error variance estimate

// additional calculations on estimates

stdb = Sqrt( Vec Diag( xpxi ) * mse ); // standard errors of estimates
alpha = .05;

gt = Students t Quantile( 1 - alpha / 2, dfe );

betau95 = beta + qt * stdb; // upper 95% confidence Timits

betal95 = beta - qt * stdb; // lower 95% confidence Timits

tratio = beta :/ stdb; // Student's T ratios

probt = ( 1 - TDistribution( Abs( tratio ), dfe ) ) * 2; // p-values
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// present results
New Window( "Big Class Regression",
Table Box(

String
Number
Number
Number
Number
Number
Number

ANOVA Example

Col
Col
Col
Col
Col
Col
Col

Box (
Box (
Box (
Box (
Box (
Box (
Box (

Data Structures
Matrices

"Term",{"Intercept", "Age", "Height"} ),
"Estimate", beta ),

"Std Error", stdb ),

"TRatio", tratio ),

"Prob>|t|", probt ),

"Lower95%", betal95 ),

"Upper95%", betau9d5 ) ) );
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You can implement your own one-way ANOVA. This example presents a problem involving a

three-level factor indicating Low, Medium, and High doses and a response measurement.

Therefore, this example solves the general linear model, as follows:

Y=a+bX+e

Where:

Y is a vector of responses

ais the intercept term

b is a vector of coefficients

X is a design matrix for the factor

eis an error term

factor = [1, 2, 3, 1, 2, 3, 1, 2, 3];
y = [1! 2’ 3’ 4; 3) 2; 5; 4) 3];

First, build a design matrix for the factor:

Next, add a column of 1s to the design matrix for the intercept term. You can do this by

Design Nom( factor );

(10,01, -1-1, 10,01, -1-1, 10, 01, -1 -1]

concatenating J and Design Nom():

x=731C9, 1, 1) || Design Nom( factor );

110,

NRkRRRRRRRN
ORI ORI O
= =
HQIHQIH
= =

[}
=~
1
~
—
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Now, to solve the normal equation, you need to construct a matrix M with partitions:
X y'y
You can construct matrix M in one step by concatenating the pieces:

=(x *x || x *y)
I

Cy’ y *y);
[9

mWNX\

|
7,

2,

1,

SO o
WG\Q =

2721 93]

Now, sweep M over all the columns in X'X for the full fit model, and over the first column
only for the intercept-only model:

FullFit = Sweep( M, [1, 2, 3] ); // full fit model
InterceptOnly = Sweep( M, [1] ); // model with intercept only

Recall that some of the standard ANOVA results are calculated by comparing the results of
these two models. This example focuses on the full fit model, which produces this swept
matrix:

[0.111111111111111 O O 3,

0 0.222222222222222 -0.11111111117117 0.333333333333333,
0 -0.11111111111717 0.222222222222222 0,

-3 -0.33333333333333 0 11.33333333333333]

Examine the model coefficients from the upper right partition of the matrix. The lower left
partition is the same, except that the signs are reversed: 3, 0.333, 0. The results can be
interpreted as follows:

* The coefficient for the intercept term is 3.
e The coefficient for the first level of the factor is 0.333.
e The coefficient for the second level is 0.

* Because of the use of Design Nom(), the coefficient for the third level is the difference, —
0.333.

e The lower right partition of the matrix holds the sum of squares, 11.333.

You could modify this into a generalized ANOVA script by replacing some of the explicit
values in the script with arguments. These results match those from the Fit Model platform.
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Figure 7.1 ANOVA Report Within Fit Model

4 |~|Responsey

4 Whole Model 4 = |factor
[* Effect Summary |* Least Squares Means Table
4 Summary of Fit
RSquare 0.055556
RSquare Adj -0.25926
Root Mean Square Error 1.374360
Mean of Response 3
Observations (or Sum Waots) 9

4 Analysis of Variance

Sum of
“UE Y Mean Square  F Ratio

Source DF

Maodel bl 0.666667 033333 0.1765
Error ] 11333333 1.88880 Prob>F
C. Total ] 12.000000 0.8424
< Parameter Estimates

Term =058 Std Error  t Ratio Probz|t]
Intercept E] 0458123 €55 0.0006*
factor[1] BUEEEEREEY 0.647884 051 0.6253
factor[2] ] 0.647884  0.00 1.0000

[ Effect Tests

Here is how to construct the report in Figure 7.1:

1. Build a data table (described in “Data Tables”):

dt = New Table( "Data" );
dt << New Column( "y", Set Values( [1, 2, 3, 4, 3, 2,
dt << New Column( "factor", "Nominal", Values( [1, 2
);
2. Run a model (described in “Launch the Analysis and Save the Script to a Window”):

obj = Fit Model(
YC iy ),
Effects( :factor ),
Personality( "Standard Least Squares" ),
Run(
y << {Plot Actual by Predicted( 0 ), Plot Residual by Predicted( 0 ),
Plot Effect Leverage( 0 )}

5, 4, 31 ) )3
,3,1,2,3,1, 2, 3]1)

)
)

3. Use JSL techniques for navigating displays (described in “Display Box Object
References”):

ranova = obj << Report;

ranova[Outline Box( 6 )] << Close( 0 );

ranova[Outline Box( 7 )] << Close( 1 );

ranova[Outline Box( 9 )] << Close( 1 );

ranova[Outline Box( 5 ), Number Col Box( 2 )] << Select;
ranova[Outline Box( 6 ), Number Col Box( 1 )] << Select;
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The result is shown in Figure 7.1.

Associative Arrays

An associative array maps unique keys to values that can be non-unique. An associative array
is also called a dictionary, a map, a hash map, or a hash table.

Note the following about keys:

¢ Keys are placed in quotes.

* The value associated with a key can be a number, date, matrix, list, and so on.
¢ Akey cannot be a floating point number. Only integers are supported.

* You can use matrices as both keys and values, or lists as both keys and values, but you
cannot mix the two. In other words, you cannot use a matrix as a key and a list as a value,
or the other way around.

¢ Though associative arrays are not usually ordered, in JMP, keys are returned in
alphanumeric order for the purpose of iteration and serialization.

For very large lists, using an associative array is more efficient and faster.

Create Associative Arrays

To create an empty associative array, use the Associative Array() function or [=>].

cary = Associative Array(Q);
cary = [=> 1;
Associative array( 0 elements ) assigned.

Keys and values can be any JSL objects. Items can be added and changed with subscripting:

cary = Associative Array(Q;
cary["state"] = "NC";
cary["population"] = 116234;

cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";

cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};



Chapter 7 Data Structures 241
Scripting Guide Associative Arrays

Default Values

A default value determines the value of a key that does not exist in an associative array. If you
try to access a key that does not exist in an associative array, an error results. If you define a
default value for your associative array, accessing a key that does not exist results in the
following:

® adds the key to the associative array
* assigns the default value to the new key

* returns the new key’s (default) value instead of an error

If you construct an associative array from a list of strings without assigning values to the keys,
then the keys are assigned values of 1. The default value for the associative array is set to 0.

To set the default value:

cary = Associative Array(Q);
cary << Set Default Value( "Cary, NC" );

To determine whether there is a default value set for an associative array, use the <<Get
Default Value message.

cary << Get Default Value;
"Cary, NC"

If there is no default value, Empty () is returned.

Besides the Set Default Value message, a default value can be set in the literal constructor
using =>value without a key.

counts = ["a" => 10,
"b" = 3,
=> 0]; // default value of 0O
counts["c"] 4= 1;
Show( counts );
counts = ["a" => 10, "b" = 3, "c" = 1, = 0];
In the first line, the default value is set to 0. In the second line, the key "c" does not exist in

counts. In the output, the key "c" is created with the default value of 0 and then incremented
by 1.

Note: If a key’s value is the default value, then the key is dropped because any key will return
the default value.

Associative Array Constructors
Create an empty associative array:

map = [=>];
map = Associative Array();
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Create an empty associative array with a default value:

[=>0];
Associative Array( 0 );

map
map

Create an associative array with specific values:
map = ["yes" => 0, "no" => 1];
Create an associative array with specific values with a default value:
map = ["yes" => 0, "no" = 1, => 2];
Create an associative array with specific values that contains an associative array:
map = ["yes" = 0, "no" => 1, "alt" = ["a" => "1", "b" = "2"]];
Create an associative array from a list that contains two lists of a key-value pair:
map = Associative Array( {{"yes", 0}, {"no", 1}} );

Create an associative array from a list that contains two lists of a key-value pair with a default
value:

map = Associative Array( {{"yes", 0}, {"no", 1}}, 2 );

Create an associative array from a list of keys and a list of values:
map = Associative Array( {"yes", "no"}, {0, 1} );

Create an associative array from a list of keys and a list of values with a default value:
map = Associative Array( {"yes", "no"}, {0, 1}, 2 );

Create an associative array from two column references. The first column contains the keys
and the second contains the values.

map = Associative Array( :name, :height );
Create an associative array from two column references with a default value:
map = Associative Array(:name, :height, .);

Create an associative array from a single list of keys or a single column reference of keys with
a default value of 0:

set
set

Associative Array( {"yes", "no"} );
Associative Array( :name );
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Work with Associative Arrays

Find the Number of Keys

To determine the number of keys that an associative array contains, use the N ITtems()
function.

cary = Associative Array(Q;
cary["state"] = "NC";
cary["population"] = 116234;

cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";

cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
N Items( cary );
4

Add and Delete Keys and Values

To add or delete key-value pairs from an associative array, use the following functions:

Insert(Q)
Insert Into()
Remove ()
Remove From()

Notes:

Insert() and Remove() return a named copy of the given associative array with the
key-value pair added or removed.

Insert Into() and Remove From() add or remove the key-value pairs directly from the
given associative array.

Insert() and Insert Into() take three arguments: the associative array, a key, and a
value.

Remove () and Remove From() take two arguments: the associative array and a key.

If you insert a key with no value provided, the key is assigned a value of 1.

Examples

The following examples illustrate Insert() and Insert Into(Q):

cary = Associative Array(Q);
cary["state"] = "NC";
cary["population"] = 116234;
cary["weather"] = "cloudy";
cary["population"] += 10;
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cary["weather"] = "sunny";
cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
newcary = Insert( cary, "time zone", "Eastern" );

Show( cary, newcary );

cary = ["high schools" => {"Cary", '"Green Hope", '"Panther Creek'},
"population" => 116244, '"state" => "NC", "weather" => '"sunny"];

newcary = ["high schools" => {"Cary", "Green Hope'", "Panther Creek'},
"population" => 116244, "state" => "NC", "time zone" => "Eastern",
"weather" => "sunny"];

cary = Associative ArrayQ;
cary["state"] = "NC";
cary["population"] = 116234;

cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";

cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
Insert Into(cary, "county", "Wake");
Show( cary );

cary = ["county" => "Wake", "high schools" => {"Cary", "Green Hope", "Panther
Creek"}, "population" => 116244, "state" => "NC", "weather" => "sunny'];

Note that cary <<Insertis a message sent to an associative array that does the same thing as
the function Insert Into(). For example, these two statements are equivalent:

cary << Insert( "county", "Wake" );
Insert Into( cary, "county", "Wake" );

The following examples illustrate Remove () and Remove From():

cary = Associative ArrayQ;
cary["state"] = "NC";
cary["population"] = 116234;

cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";

cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
newcary = Remove( cary, "high schools" );
Show( cary, newcary );
cary = ["high schools" => {"Cary", "Green Hope", "Panther Creek"},
"population” => 116244, "state" => "NC", "weather" => "sunny"];
newcary = ["population" => 116244, "state" => "NC", "weather'" => "sunny"];
Remove From( cary, "weather" );
Show( cary );
cary = ["high schools" => {"Cary", "Green Hope", "Panther Creek"},
"population” => 116244, '"state" => "NC", "weather" => "sunny"];
newcary = ["population" => 116244, "state" => "NC", "weather'" => "sunny"];
cary = ["high schools" => {"Cary", "Green Hope", "Panther Creek"},
"population" => 116244, "state" => "NC"];
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Note that aa << Remove is a message sent to an associative array that does the same thing as
the function Remove From(). For example, these two statements are equivalent:

cary << Remove( "weather" );
Remove From( cary, "weather" );

Find Keys or Values in an Associative Array

To determine whether a certain key is contained within an associative array, use the
Contains() function.

cary = Associative ArrayQ);
cary["state"] = "NC";
cary["population"] = 116234;

cary["weather"] = "cloudy";
cary["population"] += 10;
cary["weather"] = "sunny";

cary["high schools"] = {"Cary", "Green Hope", "Panther Creek"};
Contains(cary, "high schools™);

1
Contains(cary, "lakes");

0

To obtain a list of all keys contained in an associative array, use the << Get Keys message.

cary << Get Keys;
{"high schools", "population", "state", "weather'}

To obtain a list of all values contained in an associative array, use the <<Get Values message.

cary << Get Values;
{{"Cary", "Green Hope", "Panther Creek'}, 116244, "NC", "sunny"}

If you want to see only the values for certain keys, you can specify them as arguments. The
keys must be given as a list.

cary << Get Values({"state", "population"});
{"NC", 116244}

To see a value for a single key, use the <<Get Value message. Specify only one key and do not
place it in a list.

cary << Get Value("weather");
"sunny"

To obtain a list of all key-value pairs in an associative array, use the <<Get Contents message.

cary << Get Contents;
{{"high schools", {"Cary", "Green Hope'", '"Panther Creek'}},
{"population", 116244},
{"state"”, "NC"},
{"weather", "sunny'"}}
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Note: Using the <<Get Contents message, the returned list does not include the default
value. Keys are listed alphabetically.

lterate through an Associative Array

To iterate through as associative array, use the <<First and <<Next messages. <<First
returns the first key in the associative array. <<Next (key) returns the key that follows the key
that is given as the argument.

The following example removes all key-value pairs from the associative array cary, leaving an
empty associative array:

currentkey = cary << First;

total = N Items( cary );

For( i =1, i <= total, i++,
nextkey = cary << Next( currentkey );
Remove From( cary, currentkey );
currentkey = nextkey;

);

Show( cary );
cary = [=>];

Applications for Associative Arrays

You can use associative arrays to quickly and efficiently perform other tasks.
Get the Unique Values from a Data Table Column

Note: The strategy described here is not useful for columns with floating point numbers. Use
Summarize instead. See “Store Summary Statistics in Global Variables”.

A key can exist only once in an associative array, so putting a column’s values into one
automatically results in the unique values. For example, the Big Class.jmp sample data table
contains 40 rows. To see how many unique values are in the column height, run this script:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
unique heights = Associative Array( dt:height );
nitems( unique heights );

17

There are only 17 unique values for height. You can use those unique values by getting the
keys:

unique heights << Get Keys;
{51, 52, 55, 56, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70}
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Note: This is possible because you can use any JMP data type as keys in an associative array,
not only strings.

Using an associative array to discover unique values in a column is efficient and fast. The
following script takes some time to create a data table with 100,000 rows. Finding the 39
unique values takes very little time.

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
nms = dt:name << Get Values;
dtbig = New Table( "Really Big Class",
New Column( "name",
Character,
Set Values( nms[J( 100000, 1, Random Integer( N Items( nms ) ) )] )
)
J;
Wait( 0 );
tl = Tick Seconds(Q);
Write(
"\IN# names from Really Big Class = ",
N Items( Associative Array( dtbig:name ) ),
", elapsed time=",
Tick Seconds() - tl1
J;
# names from Really Big Class = 39, elapsed time=0.116666666639503

Sort a Column’s Values in Lexicographic Order

Because keys are ordered lexicographically, putting the values into an associative array also
sorts them. For example, the <<Get Keys message returns the keys (unique values of the
names column) in ascending order:

dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
unique names = Associative Array( dt:name );
unique names << Get Keys;

{"ALFRED", "ALICE", "AMY", "BARBARA", "CAROL", "CHRIS", "CLAY", "DANNY",
"DAVID", "EDWARD", "ELIZABETH", "FREDERICK", "HENRY", "JACLYN", "JAMES",
"JANE", "JEFFREY'", "JOE", "JOHN", "JUDY", "KATIE", "KIRK", "LAWRENCE",
"LESLIE", "LEWIS", "LILLIE"™, "LINDA", "LOUISE", "MARION", "MARK",
"MARTHA", "MARY", "MICHAEL", "PATTY", "PHILLIP", "ROBERT", "SUSAN",
"TIM", "WILLIAM"}

Compare Columns in Two Different Data Tables

Using associative arrays, determining which values in one column are not in another column
(or determining which values are in both columns) is fast. For example, given two data tables
with information about countries, which countries are in both data tables?

Place the columns of each data table that contain country names into associative arrays:
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dtl

Open( "$SAMPLE_DATA/B1irthDeathYear.jmp" );

dt2 = Open( "$SAMPLE_DATA/World Demographics.jmp" );
aal = Associative Array( dtl:Country );
aa2 = Associative Array( dt2:Territory );

Use N Items() to see how many countries appear in each data table:

N Items(aal);

23
N Items(aa2);

239
Use the <<Intersect message to find the common values:

aal = Associative Array( dtl:Country );
aal << Intersect( aa2 );

Look at the results:

Show(N Items(aal), aal << Get Keys);
N Items(aal) = 21;

aal << get keys = {"Australia", "Austria", "Belgium", "France", "Greece",
"Treland", "Israel", "Italy'", "Japan", "Mauritius", "Netherlands", "New
Zealand", "Norway", "Panama", "Poland", "Portugal", "Romania",

"Switzerland"”, "Tunisia", "United Kingdom", "United States"};

This example uses a set operation called intersection. For more examples of using set
operations with associative arrays to compare values, see “Associative Arrays in Set
Operations”.

Associative Arrays in Graph Theory

You can use associative arrays for graph theory data structures, such as the following directed
graph example:

g = Associative Array(Q);

g[1] = Associative Array({1, 2, 4});
g[2] = Associative Array({1, 3});
g[3] = Associative Array({4, 5});
g[4] = Associative Array({4, 5});
g[5] = Associative Array({1, 2});

This is a two-level associative array. The associative array g contains five associative arrays (1,
2, 3,4, and 5). In the containing array g, both the keys (1-5) and the values (the arrays that
define the map) are important. In the inner associative arrays, the values do not matter. Only
the keys are important.

The associative array represents the graph shown in Figure 7.2:

e node 1isincident onnodes 1,2, and 4

e node 2 isincident on nodes 1 and 3
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e node 3 is incident on nodes 4 and 5

e node4isincident on nodes 4 and 5

e node5isincident on nodes 1 and 2

Figure 7.2 Example of a Directed Graph

The following depth-first search function can be used to traverse this graph, or any other
directed graph represented as an associative array:

dfs = Function( {ref, node, visited},

)

Notes:

{chnode, tmp},
Write( "\!NNode: ", node, ", ", ref[node] << Get Keys );
visited[node] = 1;
tmp = ref[node];
chnode = tmp << first;
While( !'Is Missing( chnode ),

If(C !visited[chnode],

visited = Recurse( ref, chnode, visited )

s

chnode = tmp << Next( chnode );
s
visited;

¢ The first argument is the associative array that contains the map structure.

® The second argument is the node that you want to use as the starting point.

® The third argument is a vector that the function uses to keep track of nodes visited.

To see how the preceding example works, add the following expression to the end of the

script:

dfsC g, 2, JC N Items( g << Get Keys ), 1, 0) );

249
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Here is the output:

Node 2: {1, 3}

Node 1: {1, 2, 4}

Node 4: {4, 5}

Node 5: {1, 2}

Node 3: {4, 5}

(1, 1, 1, 1, 1]
The first five output lines show that starting from node 2, you can reach all the other nodes in
the order in which they are listed. Each node also lists the nodes it is incident on (the keys).
The value for each key is 1. The final line is a matrix that shows that you can reach each node
from 2. If there were nodes that could not be reached from node 2, their values in the matrix
would be 0.

Here is how to read the traversal of the nodes:

1. Start at node 2 and go to node 1.
2. From node 1, go to node 4.

3. From node 4, go to node 5.
4

From node 5, go back to node 2, and then to node 3.

Map Script
Here is the script that produced the map shown in Figure 7.2.

New Window( "Directed Graph",
Graph Box(
Frame Size( 300, 300 ),
X Scale( -1.5, 1.5 ),
Y Scale( -1.5, 1.5 ),
Local( {n = N Items( g ), k=2 * PiQQ / n, r, i, pt, from, to,
edge, v, d},
Fi11 Color( "green" );
Pen Size( 3 );
r=1/( + 2);
For( i =1, i <= n, i++,
pt = Eval List( {CosC k * i ), SinC k * 1 )} );
edges = g[il;
For( edge = edges << First, !Is Empty( edge ),
edge = edges << Next( edge ),
to = Eval List( {Cos( k * edge ), Sin( k * edge )} );

If( i == edge,
Circle( Eval List( 1.2 * pt ), 0.9 * r ), // else
vV = pt - to;

d = Sqrt( SumC v * v ) );
{from, to} = Eval List(
fpt*d-r)/d+to*r/d, pt*r/d+to*
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d-r)/d}
);
Arrow( from, to );
K
K
Circle(C pt, r, "fil11" );
Text( Center Justified, pt - {0, 0.05}, Char(C i ) );

Associative Arrays in Set Operations

You can also use associative arrays to perform set operations. The following examples show
how to take a union of two sets, a difference of two sets, and an intersection of two sets.

First, create three sets and view them in the log:

set_y = Associative Array( {"chair", "person", "relay", "snake", "tripod"} );
set_z = Associative Array( {"person", "snake"} );
set_w = Associative Array( {"apple", "orange"} );

// write the sets to the Tlog
Write(
"\INExample:\!N\!tset_y = ",
set_y << Get Keys,
"\IN\!tset_z = ",
set_z << Get Keys,
"\IN\!tset_w =",
set_w << Get Keys
s
Example:
set_y

set z
set_w

{"chair", "person", "relay", "snake", "tripod"}
{"person", "snake'}
{uapp7e"’ ”Ol"ange"}

Union Operation
To find the union of two sets, insert one set into the other:

set_z << Insert( set_w );
Write( "\!N\!NUnion operation (set_w, set_z):,\!N\!tset_z = ", set_z << Get
Keys );
Union operation (set_w, set_z):,
set_z = {"apple", "orange", "person", "snake'}
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Difference Operation
To find the difference of two sets, remove one set from the other:

set_y << Remove( set_z );
Write( "\!N\!NDifference operation (set_z from set_y):\!N\!tset_y = ", set_y
<< Get Keys );

Difference operation (set_z from set_y):
set_y = {"chair", "relay", "tripod"}

Intersect Operation

To find the intersection of two sets, use the aa << Intersect message.

set_w << Intersect( set_z );
Write( "\!N\!NIntersect operation (set_w, set_z):\!N\!tset_w =

1]

, set_w << Get

Keys );
Intersect operation (set_w, set_z):
set_w = {"apple"”, "orange"}

Example of Using Set Operations

Given a list of names, which of them are not contained in Big Class.jmp? You can find the
answer by taking the difference of the two sets of names.
1. Get the list of names and open the data table:

names list = {"ROBERT", "JEFF", "CHRIS", "HARRY"};
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );

2. Put the list of names into an associative array:
names = Associative Array( names 1list );

3. Perform a difference operation by removing the column values from your list:
names << Remove( Associative Array( dt:name ) );

4. Look at the result:

Write( "\!Nwhich of {ROBERT, JEFF, CHRIS, HARRY}, 1is not in Big Class = ",
names << Get Keys );
Which of {ROBERT, JEFF, CHRIS, HARRY}, is not in Big Class = {"HARRY", "JEFF"}



Chapter 8

Programming Methods
Complex Scripting Techniques and Additional Functions

This chapter includes advanced techniques, such as throwing and catching exceptions,
encrypting scripts, and using complex expressions.
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Lists and Expressions

Expressions

This section delves into JSL expressions and introduces several JSL functions that can be used
to manipulate JSL expressions. These functions provide JSL programmers with a rich,
powerful, meta programming toolkit. One of the benefits of such a toolkit is that it provides
JSL programmers with a powerful macro system capability that is similar in functionality to
macro systems available in other modern programming languages.

In order to understand JSL expressions, it is useful to keep in mind that everything that
happens in JSL is a result of a function call. Function calls come in three varieties:

prefix The function name comes before its arguments (for example, Foo( m, n ) ). Most
function calls in JSL are of this form.

infix The function name is between its arguments (for example, m + n). This form is common
for mathematical operators.

special Functionslike [ ] (the subscript operator) fall into this category. Since there are only
a handful of special functions, they are not discussed further in this section.

Although function calls come in three forms, all function calls can be written in prefix form. It
turns out that JMP actually uses the prefix form internally and so, in general, it is very useful
to think of JSL expressions in this way.

To illustrate this idea, begin by examining the syntactic structure of JSL expressions a bit more
closely. All JSL expressions must conform to a very simple syntactic structure. Each expression
consists of a head expression and a sequence of zero or more argument expressions. Consider
the following JSL expressions, written first in infix form and then in prefix form, to see how
this syntactic structure applies:

x = 100.1
mé&n
1l <=2z <= 20

Using the prefix form, these expressions are written equivalently:

Assign( x, 100.1 )
And( m, n)
Less or Equal( 1, z, 20 )
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The head of the first example is Assign and its arguments are x and 100.1. For the second
example, the head is And and its arguments are m and n, whereas for the third example, the
head is Less or Equal and its arguments are 1, z, and 20. For these examples, the “=", “&”,
and “<=" operators are just human friendly ways of representing Assign, And, and Less or
Equal.

Examine a few additional simple examples.

Assign( 100.1, x )
And( )
Less or Equal( z )

These examples also conform to the required syntactic structure, but they differ from the
previous examples in that they all produce an error message when they are evaluated. This
point leads to an important distinction that you should make when thinking about JSL
expressions. That is, you should separate the idea of the syntactic structure of a JSL expression
from what happens when the expression is evaluated.

Consider the following examples that present both the human friendly form and the prefix
form in each case:

x = 100.1 + Log( z ) // human friendly form
Assign( x, Add( 100.1, Log( z ) ) ) // prefix form

This example illustrates that the arguments of a head expression can also be expressions.

// human friendly form
x = 0.8;
X ||= Random Uniform( 0.2, 0.6 );

// prefix form
Glue(

Assign( x, 0.8 ),

Concat To( x, Random Uniform( 0.2, 0.6 ) )
)

This example would typically be referred to as a JSL script, but it is just another case of a JSL
expression. Here, the head expression is Glue, which has two arguments: the expressions
Assign( x, 0.8 ) and Concat To( x, Random Uniform( 0.2, 0.6 ) ).This example
illustrates two important points:

1. The “;” symbol is another instance of a human friendly operator. In this case, it is for the
Glue function.

2. There is no distinction between what are typically referred to as a JSL script and a JSL
expression.
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The remainder of this section covers how to assign an expression to a variable and then how to
manipulate, or execute, that expression when needed. For information about how JMP
resolves names when evaluating JSL expressions, see the section “Rules for Name
Resolution”.

Quoting and Unquoting Expressions

The operators to control when expressions are evaluated are Expr and Eval, which you
should think of as the procrastination and eager operators. Expr just copies its argument as an
expression, rather than evaluating it. Eval does the opposite: it evaluates its argument, and
then takes that result and evaluates it again.

Expr and Eval can be thought of as quoting and unquoting operators, telling JMP when you
mean the expression itself, and when you mean the result of evaluating the expression.

The following examples all assume these two assignments:

x =1; y= 20;
If you assign the expression x+y to a, quoting it as an expression with Expr, then whenever a is
evaluated, it evaluates the expression using the current values of x and y and returns the

result. (Exceptions are the utilities Show, Wri te, and Print, which do not evaluate expressions
for pure name arguments.)

x=1; y = 20;
a=Expr(x+vy);
a;

21

If you want the expression that is stored in the name, rather than the result of evaluating the
expression, use the NameExpr function. See “Retrieve a Stored Expression Rather than its
Result”.
x=1; y = 20;
Show( Name Expr( a ) );
NameExpr(a) = x + y

If you assign an extra level of expression-quoting, then when a is evaluated, it unpacks one
layer and the result is the expression x+y.

x=1; y = 20;
a = Expr( Expr( x +y ) );
Show( a );

a = Expr(x + y)
If you want the value of the expression, then use Eval to unpack all layers:

x=1; y = 20;
Show( Eval( a ) );
Eval(a) = 21
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You can do this to any level, for example:

x=1; y = 20;
a = Expr( Expr( Expr( Expr( x +y ) ) ) );
b =a;

Expr( Expr( x +y ) )
c = Eval( a );

Expr( x +y )

d = Eval( Eval(C a ) );
X+y

e = Eval( Eval( EvalC a ) ) );
21

For more information about expression handling, see Morgan (2010).

Quote an expression as a string

The IJSL Quote() function returns the contents of an expression as a quoted string.
Comments and white space in the string are preserved.

The following expression is an example:

x = JSL Quote( /* Begin quote. */
For (i =1, i <=5, i++,

// Print the value of 1.

Print( i );

s

// End expression.

s

Show( x );

In the output, the contents of the JSL Quote() function are enclosed in quotes.

x =" /* Begin quote. */
For (i =1, 1 <= 5, i++,

// Print the value of 1.
Print(i);

' // End expression.

H

"

Quoting Expressions

A common use of the Expr () function is to store an expression in a JSL variable. This could be
considered as a macro. Consider the following script:

dist = Expr( Distribution( Column( height ) ) );
To execute the above expression, just use the following;:

dist;
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You can use expressions in a loop to execute it:
For(i =0, 1i<3,1=1+1, dist );
This loop results in three Distribution platform reports for height.
Use Eval () to evaluate an expression explicitly:

Eval( dist );
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Note, however, that in column formulas, Eval () only works if it is outermost in the formula.

So, for example,
Formula( Log( Eval( Column Name( i ) ) ) );

would generate an error. Instead, use:

Formula( Eval( Substitute( Expr( Log( xxx ) ), Expr( xxx ), Column Name( i ) )

) )
As another example,
FormuTa( Eval( Column Name( i ) ) + 10 );
generates an error, since Eval () is actually under the Add function. Instead, use:

FormuTla(Eval(Substitute(Expr(xxx+10), Expr(xxx), column name(i))))

Retrieve a Stored Expression Rather than its Result

What if you wanted the symbolic value of a variable (such as the expression

Distribution(Column(height)) stored in dist above), rather than the evaluation of it (the

actual launched platform)? The Name Expr function does this. Name Expr retrieves its
argument as an expression without evaluating it.

Expr returns its argument exactly, whereas Name Expr looks up the expression stored in its

argument. Name Expr “unpacks” just one layer to get the expression, but does not keep

unpacking to get the result.

For example, you would need to use this if you had an expression stored in a name and you

wanted to edit the expression:

popVar = Expr( Summation( i = 1, N Row(), (y[i] - Col Mean(y )) A 2 / N Row()

) );
Summation( i = 1, N Row(), (y[i] - Col Mean(C y )) A 2 / N Row() )

unbiasedPopVar = Substitute( Name Expr( popVar ), Expr( Wild(/N Row() ),

Expr( (y[i] - Col MeanCy D)) A2/ CNRow(Q - 1) ) );

Summation( i = 1, N Row(), (y[i] - Col Mean( y )) A2 / (N Row(Q - 1) )

Compare x, Expr(x), NameExpr(x), and Eval(x) after submitting this script:

a=1; b=2; c=3;
Xx =ExprCa+b+c);
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Table 8.1 Compare Eval, Name Expr, and Expr

Command and result Explanation
X; Evaluates x to the expression a+b+c, and then evaluates the
6 expression, returning the result, 6 (unpacks all layers).
Eval( x ); Equivalent to simply calling x.
6

Evaluates x to the expression a+b+c, and then evaluates the
expression, returning the result, 6 (unpacks all layers).

NameExpr( x ); Returns the expression that was stored in x, which is a+b+c
a+b+c (unpacks the outside layer).

Expr( x J; Returns the expression x (packs one layer).
X

JSL also supports functions to access and traverse expressions, all of them either a name or a
literal expression as an argument. In the following, expressionArgis either a single name or
a compound expression to be taken literally.

NArg(expressionArg) finds the number of arguments in expressionArg.

The expressionArg can be a name holding an expression, an expression evaluated to an
expression, or a literal expression quoted by Expr(Q).

NArg(name) obtains the expression held in name (it is not evaluated) and returns the number
of arguments

NArg(expression) evaluates expression and returns the number of arguments
NArg(Expr(expression)) returns the number of arguments to literal expression.
For example, if aExpr = {a+b,c,d,e+f+g};

e NArg(aExpr) results in 4.

e NArg(Arg(akExpr,4)) results in 3.
e NArg(Expr({1,2,3,4})) results in 4.
Head(expressionArg) returns the head of the expression without any arguments. If the

expression is an infix, prefix, or postfix special character operator, then it is returned as the
functional equivalent.

The expressionArg can be a name holding an expression, an expression evaluated to an
expression, or a literal expression quoted by Expr ().
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For example, if aExpr = expr(a+b);

e r = Head(aExpr) results in Add().
e r = Head (Expr(sqrt(r))) resultsin Sqrt().
e r = Head({1,2,3}) resultsin {} .

Arg(expressionArg, indexArg) extracts the specified argument of the symbolic expression,
resulting in an expression.

For example, Arg(expressionArg,i) extracts the jth argument of expressionArg.

The expressionArg can be a name holding an expression, an expression evaluated to an
expression, or a literal expression quoted by Expr(Q).

* Arg(name,i) obtains the expression held in name (it is not evaluated) and finds the jth
argument.

e Arg(expression,i) evaluates expression and finds the jth argument.

e Arg(Expr(expression),i) finds the ith argument of express ion.

As another example, if aExpr = Expr(12+13*sqrt(14-15));

e Arg(aExpr,1) yields 12.

e Arg(aExpr,2) yields 13*sqrt(14-15).

* Arg(Expr(12+13*sqrt(14-15)),2) yields 13*sqrt(14-15).

To extract an argument of an argument inside an expression, you can nest Arg commands:

e Arg(Arg(aExpr,2),1) yields the first argument within the second argument of aExpr, or
13.

e Arg(Arg(aExpr,2),2) yields Sqrt(14-15).

e Arg(Arg(Arg(aExpr,2),2),1) yields 14-15.

e Arg(Arg(Arg(aExpr,2),2),3) yields Empty O

Here is a description of how the last example line unwraps itself:

1. The inner Arg statement is evaluated.
Arg(aExpr,2)
13 * Sqrt( 14 - 15 )
2. Then the next one is evaluated.
Arg(Arg(aExpr,2),2)
// this 1is equivalent to Arg(Expr (13 * Sqrt( 14 - 15 ) ), 2
Sqrt( 14 - 15 )

3. Finally, the outer Arg is evaluated.

Arg(Arg(Arg(akxpr,2),2),3)
// this is equivalent to Arg (Expr (Sqrt( 14 - 15 ) ), 3)
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Empty O
There is only one element to the Sqrt expression, so a request for the third argument yields
Empty (). To access the two arguments inside the Sqrt expression, try this:
Arg(Arg(Arg(Arg(akxpr,2),2),1),2);
15

HeadName (expressionArg) returns the name of the head of the expression as a string. If the
expression is an infix, prefix, postfix, or other special character operator, then it is returned as
the functional equivalent.

The expressionArg can be a name holding an expression, an expression evaluated to an
expression, or a literal expression quoted by Expr(Q).

For example, if aExpr = expr(a+b);

e r = HeadName (aExpr) resultsin "Add".
e r = HeadName (Expr(sqrt(r))) resultsin "Sqrt".
e r = HeadName ({1,2,3}) resultsin "List".

In previous versions of JMP, other versions of Arg, Narg, Head, and HeadName were
implemented, called ArgExpr, NArgExpr, HeadExpr, and HeadNameExpr, respectively. These
did the same thing, but did not evaluate their argument. These forms are now deprecated and
will not be documented in future versions.

Making Substitutions

Eval Insertis for the situation where you want to make substitutions, by evaluating
expressions inside a character string.

With Eval Insert, you specify characters that delimit the start and end of an expression, and
everything in between is evaluated and expanded.

There are two functions, one to return the result, the other to do it in-place.

resultString = Evallnsert( string with embedded
expressions,startDelimiter,endDelimiter )

EvalInsertInto( string T-value with embedded
expressions,startDelimiter,endDelimiter )

The delimiter is optional. The default start delimiter is "A". The default end delimiter is the
start delimiter.

xstring = "def";
r = Eval Insert( "abcAxstringAghi" ); // returns "abcdefghi';

r = "abcAxstringAghi"; // in-place evaluation
Eval Insert Into( r ); // r now has "abcdefghi";
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// with specified delimiter
r = Eval Insert( "abc%xstring%ghi","%" ); // returns "abcdefghi;

// with different start and end delimiters

r = Eval Insert( "abc[xstringlghi”,"[","]1" ); // returns "abcdefghi";

When a numeric value contains locale-specific formatting, include the <<Use Locale(1)
option. The following example substitutes a comma for the decimal point based on the
computer’s locale setting.

Eval Insert( "Al.2A", <<Use Locale( 1) );
1,2

Evaluate expressions inside lists

Eval List evaluates expressions inside a list and returns a list with the results:

x={1+2,3+413,;
y = Eval List( x ); // returns y is {3,7}

Eval Listis useful for loading the list of user choices returned by Column Dialog or New
Window with the Modal argument.

Evaluate expressions inside expressions

Eval Expr() evaluates only the inner expressions and returns an expression that contains the
results of the evaluation. By comparison, Eval evaluates the inner expressions, takes the
results, and then evaluates it again.

Suppose that a data table contains a column named X3. Here is an example of using Eval
Expr(Q) to evaluate the inner expression first:

x = Expr( Distribution( Column( Expr("X"[|CharC i ) ) ) ) );
i=3;
y = Eval Expr( x ); // returns Distribution( Column( "X3" ) )

To evaluate further, you need to either call the result in a subsequent step, or else put Eval()
around the Eval Expr(Q). The following examples create a Distribution report.

// two-step method

x = Expr( Distribution( Column( Expr( "X" || CharC i) ) ) ) );
i=3;

y = Eval Expr( x );

Y;

// one-step method

x = Expr( Distribution( Column( Expr( "X" || Char(C i) ) ) ) );
i=3;

Eval( Eval Expr( x ) );
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See Table 8.3 to learn what would happen if you tried to use Eval directly on x without first
doing Eval Expr.

Parsing Strings into Expressions, and Vice Versa

Parsing is the syntactic scanning of character strings into language expressions. Suppose that
you have read in a valid JSL expression into a character string, and now want to evaluate it.
The Parse function returns the expression. To evaluate it, use the Eval function.

x = Parse( "a=1" ) ; // x now has the expression a=1
Eval( Parse( "a=1" ) ); // a now has the value 1

To go in the reverse, use the Char function, which converts an expression into a character
string. Usually the argument to a Char function is an Expr function (or a NameExpr of a
variable), since Char evaluates its argument before deparsing it.

y = Char( Expr( a =1 ) ); // results in y having the character value "a=1"
z = Char( 42 ); // returns "42"

The Char function allows arguments for field width and decimal places if the argument is a
number. The default is 18 for width and 99 for decimal (Best format).

Char( 42, 5, 2 ); // returns the character value "42.00"

To preserve locale-specific formatting in the numeric value, include the <<Use Locale(1)
option as shown in the following example:

Char( 42, 5, 2, <<Use Locale(l) ); // returns the character value "42,00" 1in
the French locale

The reverse of Char is not quite as simple. To convert a character string into an expression, you
use Parse, but to convert a character string into a number value, you use Num.

Parse( y );
Num( z );

Table 8.2 Functions to Store or Evaluate Expressions

Function Syntax Explanation
Char Char(Expr(expression))  Converts an expression into a character string.
Char (name) The expression must be quoted with Expr;

otherwise its evaluation is converted to a string.

string = char(number, Converts a number into its character

width, decimal) representation. Width and decimal are optional
arguments to specify formatting; the defaultis 18
for width and 99 for decimal.
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Table 8.2 Functions to Store or Evaluate Expressions (Continued)

Function Syntax Explanation

Eval Eval(x) Evaluates x, and then evaluates the result of x
(unquoting).

Eval Expr  Eval Expr(x) Returns an expression with all the expressions

inside x evaluated.

Eval List  Eval List(list) Returns a list of the evaluated expressions inside
list.

Expr Expr(x) Returns the argument unevaluated
(expression-quoting).

NameExpr NameExpr(x) Returns the unevaluated expression of x rather
than the evaluation of x. NameExpr is like Expr
except that if x is a name, NameExpr returns the
unevaluated expression stored in the name
rather than the unevaluated name x.

Num Num("string") Converts a character string into a number.
Parse Parse("string") Converts a character string into a JSL expression.
Summary

Table 8.3 compares various ways that you can use the evaluation-control functions with x.
Assume that a data table contains a column named X3, and x and 7 have been assigned:

Expr( Distribution(Column( Expr("X"[|Char(C i ) ) ) ) );
3;

X
i

Table 8.3 Functions for Controlling Evaluation

Commands and results Explanation

x; // or Eval(x) and simply calling x are equivalent.
Eval(x); . . .

Not Found in access or evaluation of Evaluates the expression distribution(
'distribution' , Bad Argument( {"X" || column( expr( "X" [| Char(C i ) ) ) ).
Char( 1 )} ) This results in errors. The column name is

recognized as "X" | |Char (i) because it is
packed by the Expr () function.

Expr(x); Returns the expression x (packs an additional
X layer).
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Table 8.3 Functions for Controlling Evaluation (Continued)

Commands and results

Name Expr(x);
Distribution(Column(Expr("X" [/
Char(i))))

y=Eval Expr(x);
Distribution(Column("X3"))

y; //or
Eval(Eval Expr(x));
Distribution[]

z = Char(nameexpr(x));
"Distribution(Column(Expr (\!"X\!" []
Char(i))))"

Parse(z);
Distribution(Column(Expr("X" [/
Char(i))))

a = Parse(Char( NameExpr(x)));
Eval(EvalExpr(a));
Distribution[]

Explanation

Returns the expression stored in x exactly as
is: Distribution(Column(Expr("X" ||
Char(i)))).

Evaluates the inner expression but leaves the
outer expression unevaluated, so that y is
Distribution(Column("X3")).

Eval(eval expr(x)) and simply calling y
are equivalent.

Evaluates Distribution(Column("X3")) to
launch the platform.

Quotes the entire expression as a text string,
adding \!" escape characters as needed.

Note that Char(x) would first attempt to
evaluate x, producing an error and ultimately
returning a quoted missing value: "."

Unquotes the text string and returns an
expression.

Evaluation control taken to its logical extreme.

Note that you must break this into at least two
steps as shown. Combining it into one giant
step produces different results because the
Eval Expr layer causes the Parse layer to be
copied literally, not executed.

Eval(
EvalExpr(
Parse(
Char(
NameExpr(x)))));
Distribution(Column(Expr("X" |[]
Char(i))))
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Macros

Stored expressions can serve as a macro feature. You can store a generalized action as an
expression in a JSL variable, and then call that variable wherever you need that action to be
performed. This example has four macros as the arguments to If:

TastStdzdThickness=expr(

(thickness[nrow()]-col mean(thickness)) / col std dev(thickness));
continue=expr(...<script to read in more data>...);
Tog=expr(print("In control at "||char( long date(today()))));
break=expr(...<script to shut down process>...); Timitvalue=1;

if(lastStdzdThickness<limitvalue,log;continue,break);

Storing the expression with Expr delays its evaluation until the variable is evaluated. Any
variables, data points, or expressions included in that expression are evaluated on the fly
when the expression is evaluated. See “Expressions” for detailed rules for storing expressions
and later evaluating them.

Manipulating Lists

The following functions manipulate lists. They can also be used to manipulate expressions, as
shown in the next section, “Manipulating Expressions”. A summary of commands with
explanations is in Table 8.4.

Most of the functions have two variants, one that produces a new value, and one that works
in-place directly on its arguments. Here are some examples:

// In-place example

A=1{2, 3, 4, 2,1, 2, 1};

A = Remove( A, 3 ); // delete the third item in the list A, storing result in A
Remove From( A, 3 ); // delete the third item in the Tist A, in place

Show( A ); // A= {2, 3, 2, 1, 2, 1};

// New value example

B=4{2, 3, 4, 2, 1, 2, 1};

onetwo = Insert( {1}, 2 ); // {1, 2}

Insert Into( B, {1, 2}, 4 ); // put 1, 2 before the current 4th item
Show( B ); // B = {2, 3, 4, 1, 2, 2, 1, 2, 1};

Note: If the position is omitted in the Insert Into command, items are placed at the end
of the list.

a = Shift( {1,2,3,4}, 1 ); // store the 1ist {2,3,4,1} in a
Shift Into( a, -1 );
Show( a ); // a = {1, 2, 3, 4};
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b = Reverse( a ); // b is now {4,3,2,1}
Reverse Into( a ); // a is now {4,3,2,1}
Show( a ); // a = {4, 3, 2, 1};

s = Sort List( {1,4,2,5, -7.2, Pi(), -11, cat, apple, cake} );
Show( s ); // s = {-11, -7.2, 1, 2, 4, 5, apple, cake, cat, Pi(Q};

Cc = {5! p-ie! 2) P1()! _2};
Sort List Into( c );
Show( ¢ ); // ¢ ={-2, 2, 5, Pi(Q), pie};

In-place functions

In-place functions are those that operate on lists or expressions directly. They have Fromor Into
in their names (for example, Remove Fromand Insert Into). They do not return a result; you
have to show the list to see the result. The first argument for an in-place function must be an
L-value. An L-value is an entity such as a variable whose value can be set.

myList = {a, b, c, d};
Insert Into( myList, 2, 3 );
Show( myList );

myList = {a, b, 2, c, d}

These examples show how to use Insert Intoand Remove Fromwith nested lists:

a = {{1, 2, 3}, {"A", "B", "C"}};
Show( a );
a=1{{1, 2, 3}, {"A", "B", "C"}}

Insert Into( a[l], 99, 1 );
Show( a );
a = {{99, 1’ 2’ 3}’ {"A"’ ”B", ”C”}}

Remove From( af[l], 1 );
Show( a );
a = {{1, 2, 3}, {"A", "B", "C"}}

Not in-place functions

For the not-in-place functions, you must either state the list directly or else quote a name that
evaluates to a list. Such functions do not have From or Into in their names. They return
manipulated lists or expressions without changing the original list or expression given in the
first argument.

myNewList = Insert( {a, b, c, d}, 2, 3 );
{a, b, 2, ¢, d}

oldList
newlList

{a, b, c, d};
Insert( oldList, 2, 3 );
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{a, b, 2, ¢, d}

Substituting

Substitute() and Substitute Into() merit further discussion. Both functions find all
matches to a pattern in a list (or expression) and replace them with another expression. Each
pattern must be a name. The arguments are evaluated before they are applied, so most of the
time you must quote them with an Expr() function.

Substitute( {a,b,c}, Expr( a ), 23); // returns {23,b,c}
Substitute( Expr( Sine( x ) ), Expr( x ), ExprCy ) ); // returns Sine(y)

To delay evaluating an argument, use NameExpr instead of Expr:

a = {quick, brown, fox, jumped, over, Tlazy, dogs};

b = Substitute( a, Expr( dogs ), Expr( cat ) );

canine = Expr( dogs );

equine = Expr( horse );

c = Substitute( a, Name Expr( canine ), Name Expr( equine ) );
Show( a, b, c );

a = {quick,brown, fox, jumped,over, lazy,dogs}
b = {quick,brown, fox, jumped,over, lazy, cat}
c = {quick,brown, fox, jumped,over, lazy,horse}

Substitute Into does the same work, in place:

Substitute Into( a, Expr( dogs ), Expr( horse ) );
You can list multiple pattern and replacement arguments to do more than one replacement in
a single step:

d = Substitute( a,
Name Expr( quick ), Name Expr( fast ),
Name Expr( brown ), Name Expr( black ),
Name Expr( fox ), Name Expr( wolf )

J;
{fast,black,wolf, jumped,over, lazy, dogs}

Note that substitutions are done repeatedly over multiple instances of the expression pattern.
For example:

Substitute( Expr( a + a ), Expr( a ), Expr( aaa ) );
results in:

aaa + aaa
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Manipulating Expressions

The functions for manipulating lists can also operate on most expressions. Be sure to quote the
expression with Expr(). For example:

esults in the expression A + C + D

Remove( ExprC A+ B + C+ D), 2); // r
2 2), 2, 3); /* returns the expression

b = Substitute( Expr( Log( 2 ) A2/
Log( 3 ) A3/ 3%/

As with lists, remember that the first argument for in-place functions must be an L-value. An
L-value is an entity such as a variable whose value can be set. In-place functions are those that
operate on lists or expressions directly. They have From or Into in their names (for example,
Remove Fromand Insert Into). They do not return a result; you have to show the expression
to see the result.

c)
3),1);

polynomial = Expr( a * x A 2 + b * x
Insert Into( polynomial, Expr( d * x
Show( polynomial );

o

polynomial = d *

> +

XA3+a*xA2+b*x+cC

For the not-in-place functions, you must either state the expression directly or else quote a
name that evaluates to an expression using NameExpr. Such functions do not have From or
Into in their names. They return manipulated lists or expressions without changing the
original list or expression given in the first argument.

cubic = Insert( Expr(a * x A2 +b * x+c), ExprCd * x A 3), 1);
d*xA3+a*xA2+b*x+cC

quadratic = Expr(a * x A2 + b * x + c );

cubic = Insert( Name Expr( quadratic ), Expr( d * x A 3 ), 1);
d*xA3+a*xA2+b*x+cC

Substituting

Substituting is extremely powerful; please review the earlier discussion “Substituting”. Here
are a few notes regarding substituting for expressions.

Substitute(pattern, name, replacement) substitutes for names in expressions
NameExpr () looks through the name but copies instead of evaluates:

a = Expr(
Distribution( Column( x ), Normal Quantile Plot )
s
Show( Name Expr( a ) );
Name Expr(a) = Distribution(Column(x), Normal Quantile Plot);

Substitute() evaluates all its arguments, so they must be quoted correctly:

b = Substitute( Name Expr( a ), Expr( x ), Expr( :weight ) );
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Show( Name Expr( b ) );
Name Expr(b) = Distribution(Column(:weight), Normal Quantile Plot);

SubstituteInto() needs an L-value, so the first argument is not quoted:

Substitute Into( a, Expr( x ), Expr( :weight ) );
Show( Name Expr( a ) );
Name Expr(a) = Distribution(Column(:weight), Normal Quantile Plot);

Substitute() is useful for changing parts of expressions, such as in the following example
that tests the Is functions:

data = {1, {1, 2, 3}, [1 2 3], "abc", x, xCy )};
ops = {is number, is 1list, is matrix, is string, is name, is expr};
m= J(N Items( data ), N Items(C ops ), 0 );
test = Expr(
mlr, c] = _op( data[r] )
s
ForC r =1, r <= N Items( data ), r++,
For( c = 1, c <= N Items( ops ), C++,
Eval( Substitute( Name Expr( test ), Expr( _op ), ops[c] ) )
)
s
Show( m );
m =
[100000,

s
y

’

QOO
SO O R
SO RO
OO O
NOOO
ROoOR

00000 1],

You can use SubstituteInto() to have JMP solve quadratic equations. The following
example solves 4x? - 9 = 0:

/* FIND THE ROOTS FOR THE EQUATION:
a*xA2 + b*x + c =0
The quadratic formula is x=(-b + - sqrt(bA2 - 4ac))/2a.
Use a 1list to store both the + and - results of the +- operation */

x = {Expr(
(-b+Sart(bA2-4*a*c)) /Q*a
), Expr(
(-b - Sqre(b A2 -4 *a*c))/@*a
)}

Substitute Into( x, Expr( a ), 4, Expr( b ), 0, Expr( c ), -9 );

// plug in the coefficients
Show( x ); // see the result of substitution
Show( Eval Expr( x ) ); // see the solution
X = {Expr(((-0) + Sqrt(0 A 2 - 4 * 4 * -9)) / (2 * 4)), Expr(((-0) - Sqrt(0
A2 -4%4%-9)/ @24}k
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Eval Expr(x) = {1.5, -1.5};
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The functions for manipulating lists and expressions are discussed in the previous section,
“Manipulating Lists”, and summarized in Table 8.4.

Table 8.4 Functions for Manipulating Lists or Expressions

Function

Remove

Remove From

Insert

Insert Into

Shift

Syntax

X =
Remove(Tist|expr)
X =
Remove(Tist|expr,
position)

X =
Remove(Tist|expr,
{positions})

X =
Remove(Tist|expr,
position, n)

Remove
From(T1ist|expr,
position)
Remove
From(Tist|expr)
Remove
From(list|expr,
position, n)

X =
Insert(]ist|expr,
item, position)
X =
Insert(list|expr,
item)

Insert
Into(list|expr,
item, position)
Insert
Into(list|expr,
item)

x = Shift(Tist|expr)
x=Shift(Tist|expr,
n

Explanation

Copies the list or expression, deleting the item(s)
at the indicated position. If position is omitted,
items are deleted from the end. Position can be a
list of positions. An extra argument, 1, deletes n
items instead of just 1.

Remove items in place. The function returns the
removed item(s), but you do not have to assign
them to anything. The first argument must be an
L-value.

Inserts a new item into the list or expression at the
given position. If position is not given, it is
inserted at the end.

Same as Insert, but does it in place. List or
expression must be an L-value.

Shift an item or # items from the front to the back
of the list or expression. Shift items from back to
front if n is negative.
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Table 8.4 Functions for Manipulating Lists or Expressions (Continued)

Function

Shift Into

Reverse

Reverse Into

Sort List

Sort List
Into

Sort
Ascending

Sort
Descending

Loc Sorted

Substitute

Syntax

Shift
Into(T1ist|expr)
Shift
Into(list|expr, n)

x=Reverse(T1ist|expr

)

Reverse
Into(T1ist|expr)

x=Sort
List(Tist|expr)

Sort List
Into(T1ist|expr)

Sort
Ascending(Tist|matr
ix)

Sort

Descending(T1ist|mat
rix)

Loc Sorted(A, B)

R =
Substitute(Tist|exp
r, Expr(pattern),
Expr(replacement),

.

Explanation

Shift items in place.

Reverse the order of elements of a list or terms of
an expression.

Reverse the order of elements of a [ist or terms of
an expression in place.

Sort the elements of a list or the terms of an
expression. Numbers sort low, followed by the
name value of names, strings, or operators. For
example 1+2 is lower than 1-2 because the name
value Add sorts lower than the name value
Subtract. {1,2} sorts lower than {1,3}, which sorts
lower than {1,3,0}. {1000} sorts lower than {“a”},
but {a} and {“a”} sort as equal.

Sort the elements of a list or terms of an expression
in place.

Returns a copy of a list or matrix with the items in
ascending order.

Returns a copy of a list or matrix with the items in
descending order.

Creates a matrix of subscript positions where the
values in matrix A match the values in matrix B.
A must be a matrix sorted in ascending order.

Finds all matches to the pattern in the list or
expression, and replaces them with the
replacement expression. Each pattern must be a
name. The second and third arguments are
evaluated before they are applied, so most of the
time you must quote them with an Expr function.
To delay evaluating an argument, use Name Expr
instead of Expr. You can list multiple
pattern-replacement pairs for multiple
substitutions in one statement.
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Table 8.4 Functions for Manipulating Lists or Expressions (Continued)

Function Syntax Explanation
Substitute Substitute Substitute in place.
Into Into(Tist|expr,
Expr(pattern),
Expr(replacement),
L)

Advanced Scoping and Namespaces

Scripts that are used in production environments need to use more advanced scoping
techniques to avoid collisions between scripts. JMP provides three progressively more
advanced techniques:

e The Names Default To Here() function. If you have simple scripting needs, this single
command might be sufficient. See “Names Default To Here”.

® Scopes that are pre-defined by JMP. See “Scoped Names”.

* Namespaces that you can create for your scripts. See “Namespaces”.

Names Default To Here

If you write production scripts, you need to insulate the script from the current user
environment. Otherwise, the variables that you use might interact with variables used by the
user and by other scripts. The way to do this is to keep your names in a local environment,
which you can do by setting an execution mode with the statement:

Names Default To Here( 1 );

Unqualified names in a script with the Names Default To Here mode turned on are private to
that script. However, the names persist as long as the script persists, or as long as objects
created by or holding the script are still active. It is recommend that all production scripts start
with Names Default To Here(1l) unless there is a specific reason not to do so. When the
script uses an unqualified name in this mode, that name is resolved in the local namespace.

To refer to global variables, scope the name specifically as a global variable (for example,
: :global_name). To refer to columns in a data table, scope with name specifically as a data
table column (for example, : column_name).

Note: Names Default To Here( 1 ) defines a mode for a particular script. It is not a global
function. One script can have this mode turned on, while another script can have it turned off.
The default setting is off.
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In JMP 8 and earlier, the only method to the insulate scripts was to use lengthy names that
were less likely to collide with names in other scripts. Using Names Default To Here(1)
makes this technique unnecessary.

If you have simple scripting needs, Names Default To Here(1) might be sufficient.

Local()

Local () creates local scopes only in specific contexts within a script and cannot enclose a
longer script with interacting functions, while Names Default To Here(1) creates a local
scope for an entire script. In Local (), you list the variables that are local to the local block.
Anything not explicitly listed is not local to that block.

Local Here()

Local Here() provides a namespace block with Names Default to Here(1). Use Local
Here() to prevent name collisions when multiple scripts are executed from the same root
namespace (for example, when a script executes two button scripts that have the same
variables or an included script is run from the main script).

Local () does not always work due to the lifetime of the local block, but Local Here() is
persistent across the call.

Here’s an example that runs an included script from a main script. The scripts define x and y
variables as different values. Variables in the included script are in the Local Here namespace.

Main.jsl:

Names Default To Here( 1 );

X = 5;

y = 0;

Print( "Main, Before: x=" || Char( x ) || ", y=" || Char(Cy ) );

Include( "Incl.js1" );

Print( "Main, After: x=" || CharC x ) || ", y=" || CharCy ) );
Inc1.jsl:

Names Default To Here( 1 );

Local Here( // variables are local to this script

x = 100;
y = 100;
Print( "Incl: x=" || CharC x ) || ", y=" || Char(Cy ) );

)
Print( "Incl outside: x=" || Char( x ) || ", y=" || CharCy ) );
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Return:

"Main, Before: x=5, y=0" // defined in Main.js1, before running Incl.js]
"Incl: x=100, y=100" // defined in Incl.js]

"Incl outside: x=5, y=0" // from Incl.js1, referring to Main.js]1

"Main, After: x=5, y=0" // from Main.js1, after running Incl.js]

Notice that the x and y variables in inc1.jsl don’t change because they’re in the Local Here
namespace.

Handling Unqualified Named Variable References

The Names Default To Here() function determines how unqualified named variable
references are resolved. Explicitly scoping a variable using here:var_name always works,
whether Names Default To Here() is on or off. See “Scoped Names” for more information
about here and other scopes.

Enabling the Names Default To Here mode associates a scope called Here with an executing
script. The Here scope contains all of the unqualified named variables that are created when
they are the target of an assignment (as an L-value). In JMP 8 and earlier, these variables
normally would have been placed in the Global scope. Using a Here scope keeps variables in
multiple executing scripts separate from each other, avoiding name collisions and simplifying
the scripting and management of variable name collisions. You can still share information
using the Global scope.

Names Default To Here and Global Variables

Run this example script one line at a time to see how the Names Default To Here() function
changes the resolution of variable names.

Example Script

a=1;
Names Default To Here( 1 );
a = 5;
Show( global:a, a, here:a );
global:a = 1;
a=>5;
here:a = 5;

1. Run the first line to create a global variable named a that holds the value 1.
2. Run the second line to turn on the Names Default To Here mode.

3. Run the third line to create a new variable named 7 in the local space that holds the value
5. This